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PREFACE

Today in the Republic of Belarus the widest application of geographic 
information systems (GIS) is noted in the field of information support and 
automation of land surveying works, land cadastre and monitoring of land 
resources. GIS specialists have an important role in information support 
of decision-making on organisation of effective land use, its improvement 
and protection. They should be proficient in technologies of creating and 
filling geodatabases, using remote sensing data, geodetic surveys and global 
navigation satellite systems, vector and raster data in geoinformation 
mapping of land resources.

The coursebook on the discipline “GIS for Land Resource Management” 
is prepared in accordance with the curriculum for students of the Master's 
degree specialities “Geography”, “Land Management, Cadastres, Geodesy and 
Geomatics” and consists of 6 chapters.

The first chapter discusses of using of GIS in land resources mapping, 
provides information on the establishment and development of GIS methods 
in this area, software, and the specifics of this area in Belarus. The second 
chapter highlights the classification of remotely sensed data used for land 
resources management, and describes the methods and techniques of image 
interpretation. The third chapter reveals process of GIS-mapping of lands 
based on geodetic surveys and global navigation satellite systems. The 
fourth chapter considers the main stages of GIS-mapping of land resources 
on the basis of cartographic materials and gives examples of using these 
materials in Belarus. The fi th chapter outlines the peculiarities of design and 
symbolisation of land cadastral maps with the help of GIS and gives examples 
of using vector models. The sixth chapter contains practical tasks on GIS-
mapping of land resources.
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1. BASICS OF GIS FOR LAND RESOURCE 
MANAGEMENT

1.1. Geoinformation Mapping of Land Resources

Land resources are understood as land, plots of land, which are used or 
may be used in economic or other activities. Land resources play an important 
part in the development of human society. Land represents the basis of human 
life activity, and at the same time it is a natural resource, the bearer of fertility, 
the source of material goods, the territorial basis for placing structures and 
communications, a special commodity and an object of legal relations, etc. 
The appearance of land farms brought about the problems of demarcation, 
delimitation, allotment, redistribution of land resources, regulating the 
economic use and later the protection of land. Effective solution of these 
problems required precision spatial positioning of land and map-making.

For quite a long time the process of land mapping, which is understood 
as a complex of activities to create land-cadastral maps, was carried out by 
traditional methods of cartography based on field instrumental surveys. The 
appearance of aerial and space imagery simplified the process of map-making 
and made it much cheaper.

Modern cartographic materials are created in digital form basing on the 
geographic information systems (GIS), i.e. information systems which provide 
collection, storage, processing, access, display, and dissemination of spatially 
coordinated data.

Currently the approach to land mapping is undergoing certain changes, 
comparable perhaps with those, which accompanied the transition from 
hand-drawn maps to printed ones. The interaction of geoinformation systems 
and cartography has given birth to a new subject – geoinformation mapping, 
which is automated compilation and use of maps basing on geoinformation 
technologies and geographical (geological, environmental, social-economic, 
etc.) databases.

Within the scope of geoinformation mapping we can highlight a 
separate area, which is situated at the intersection of geoinformatics, land 
management, and land cadastre, as well as cartography – geoinformation 
mapping of land, which lies in automated compilation and use of maps of 
the land-cadastral system basing on geoinformation technologies and the 
land information geodatabases (GDB).

In many countries geoinformation mapping of land has almost completely 
replaced traditional methods of making and issuing maps in this area. 
Programme-managed mapping gives a new coverage to many traditional 
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problems, related to the choice of the mathematical basis and the layout, 
the introduction of new graphics, generalization, etc. We are now seeing the 
merger of the two major branches of cartography: the making and the use 
of maps. A lot of cartometric operations which earlier used to be considered 
laborious, such as image transformations or superimposition or overlapping 
of images, as well as a lot of others, have now become routine procedures. 
Today creating and using maps of the land-cadastral system is one single 
integrated process.

Geoinformation mapping of land in the Republic of Belarus must provide:
• keeping a register of administrative-territorial units (ATU) and 

territorial units (TU) of the Republic of Belarus;
• establishment and restoration of boundaries of land plots, servitudes, 

encumbrances, and limitations;
• registration of titles to land plots;
• cadastral assessment of land plots;
• compilation of cartographic attachments to legal documents;
• carrying out land management, taking decisions about monitoring land, 

land resources management, assessment and forecasting the condition of land;
• keeping the state accounting of land;
• compiling projects of organization of territory;
• supervising the use and the protection of land;
• preparation of reference data about using land for appropriate executive 

and administrative authorities;
• fulfil the functions of land-surveying documentation when urban 

planning and architectural bodies take decisions of territorial and spatial 
planning.

The major sources of data for the purposes of GIS-mapping of land 
resources are:

• data from remote sensing of Earth;
• results of land-surveying (geodesic, satellite positioning systems);
• cartographic materials (raster or paper);
• digital data in the vector, GRID- and TIN-formats.

1.2. Formation and Development of GIS-methods  
of Mapping of Land Resources

We can distinguish three major stages in the formation and development 
of GIS-methods of mapping of land resources:

• the pioneer period (1960s);
• the state initiatives period (1970s);
• the commercial development period (1980s – present).
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The pioneer period developed against the background successes 
of computer technology (the appearance of electronic computers, 
digitizers, plotters, graphic displays the other peripheral devices), with the 
simultaneous, and often independent, creation of software algorithms and 
procedures of graphic representation of information on displays and with 
the help of plotters, formal methods of tridimensional analysis, software 
means of databases management. The appearance and the rapid development 
of GIS was predetermined by the richest experience of topographic and 
especially thematic mapping, by the successful attempts to automate the 
mapping process, as well as by the revolutionary achievements in the areas 
of computer technology, computer science, and computer graphics.

The first major success of GIS-mapping of land was the development and 
creation of the GIS of Canada. The history of this large-scale GIS started in 
the 1960s, and it has been supported and developed up to the present day. 
The purpose of the GIS of Canada was to analyze digital data, accumulated 
by the Canadian service of land accounting, and to receive statistical data 
about land to be then used in developing land management maps of vast 
areas of predominantly agricultural purposes. This required the creation 
of land classification using the data on their agricultural, recreational, 
environmental, forestry suitability, to refle t the existing structure of land 
usage, including land-owners. The weak point of the project was the securing 
the effective input of initial cartographic and thematic data. To achieve this 
the developers of the GIS of Canada, having no experience in the internal 
organization of large arrays of spatial data, had to create a new technology, 
had not been used anywhere earlier, which allowed them to operate separate 
layers and carry out cartometric measurements. There was also developed 
a conceptual solution about attributive data tables. This allowed separating 
the files of spatial (geometric) geoinformation about the location of features 
and the files containing thematic (substantial) information about these 
features. They even designed and built a special scanning device to input 
large-size land maps.

The work of Swedish school of geoinforamtics was focused on the GIS of 
land-accounting specializations, particularly the Swedish Land Data Bank, 
which is intended for automation of land plots (land holdings) and real estate 
accounting. Maps were mostly built in the form of rough alphabetical-digital 
printouts – images consisting of letters and numbers, which created the 
primitive effect of halftone images by means of different density.

The second half of the 1960s is noted for the works of the Harvard 
Laboratory  for Computer Graphics and Spatial Analysis. The software 
created here has become a classic in the sphere of automated mapping. Due 
to these works the leading role in modern geoinformation systems was finall  
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assigned to cartographic data models, cartographic method of research, 
cartographic ways of presenting information.

In the period of state initiatives in the beginning of the 1970s GIS were 
aimed at purely utilitarian tasks of land resources inventory, land cadastre 
and accounting in order to improve the system of taxation. Those tasks 
were solved by means of automation of land-record documents circulation 
in the form of data banks of appropriate specialization. The first and the 
principal step to bring GIS out of the circle of general purpose databases was 
to introduce an indicator of space into the number of attributes of operating 
features (land plots, buildings, physical and legal persons, areas of land use, 
soils appraisal or forest inventory), no matter the form of location indicator 
(coordinates, administrative hierarchy, in terms of belonging to the cells of 
regular networks of territory division) in which it is expressed. Specifying 
coordinates of centroids of features was already revolutionary enough – a 
method actively used in Sweden.

During this period there formed the concept of spatial features, described 
by their positional and non-positional attributes. The two alternative lines of 
representation formed – raster and vector structures, including topological 
representations. There were put up and solved the tasks which form the core 
of geoinformation technologies: overlay of layers, buffer zones generation, 
Thiessen polygons, and other operations of spatial data manipulation, 
including determination of a point’s belonging to the polygon, computational 
geometry operations in general. There were found effective solutions of 
other geometric problems, algorithms of analytical operations and graph-
analytic constructions.

One of the examples of a land informational system (LIS) of this period 
is the LIS of the state of Minnesota. It was started as a joint project of 
The Center for Urban and Regional Affairs of the state of Minnesota, the 
Minnesota State University and the Planning Agency of the same state. 
At that time in many states there started the development of land GIS, 
which was driven by the desire to streamline land taxes collection. The LIS 
of the state of Minnesota had some special features, but the main thing was 
that for the first time the whole project was carried through to the end and 
proved effective. The system was raster, with large grain raster (slightly above 
0,16 km2), and nevertheless turned out to be quite effective.

The period of commercial development started in the 1980s, when certain 
software for data processing and maps preparation transformed into a system, 
capable of helping man take important decisions. At the same time there 
were created local and global computer networks, which made revolutionary 
changes to databases access. There was observed an extraordinary dynamism 
of GIS development. The development of commercial software of GIS, 
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connected in no small measure with the possibilities of mini- and macro-
configurations of computing facilities, and later of PCs as well, changed all 
geoinformation industry substantially, the appearance of which is related 
exactly to this period. The creation of GIS started to base not on unique 
software and hardware means of individual design, but on the adaptation of 
functional opportunities of quite operationally universal software of products 
with regard to the problems analyzed. It was this time that became the period 
of mass creating of GIS based on personal computers.

One of the bright examples of this period is the appearance of the 
most popular software in the world – ARC/INFO in Environmental Systems 
Research Institute (ESRI, Inc.), USA. Its creation was caused by joining the 
standard relational database management system (INFO) with the program 
(ARC). Today this software has grown into the program complex ArcGIS – a 
powerful means for GIS-mapping, including that of land resources.

This is the period of introduction of GIS into the sphere of mapping 
land resources in our country. The infrastructure of local, regional, and 
central LIS of the Republic of Belarus was formed. The GDB of local LIS are 
filled with spatial land-cadaster data. GIS were introduced in the process of 
registration of land plots, monitoring and protection of land fund. Server 
and web GIS began to develop.

1.3. The Market of Software for GIS-mapping  
of Land Resources

The rapid spreading of geoinformation technologies led to the fact 
that today on the Belarusian market there already function several dozen 
organizations and firms  which distribute GIS software, necessary for the 
purposes of GIS-mapping of land. One can point out several classes of 
software, which differ by their functional options and technological stages 
of geoinformation processing. However, it is necessary to distinguish the 
systems of free distribution, those distributed commercially, and special 
products, designed for individual projects and not possessing the necessary 
universality, support of development, printed documentation written in 
popular language, and a number of other properties, characteristic of market 
goods.

By their functional options the software for GIS-mapping of land can be 
divided into fi e main classes of usage.

The first class of software, most functionally full, is the instrumental GIS. 
They may fulfil most diverse tasks: organized input of information (both 
cartographic and attributive), its storage (including distributed storage 
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which supports network functioning), processing difficult information 
requests, solving spatial analytical tasks, building derivative maps, and, 
finall , preparing the output of cartographic production layouts. As a rule, 
instrumental GIS work both with raster and vector images, have a database 
as store of digital and attributive information. Local LIS in the Republic of 
Belarus are created in software products of the company ESRI, USA (the 
instrumental GIS ArcGIS). As examples of instrumental GIS we can point out 
MapInfo Pro (MapInfo Corp., USA), GIS Panorama (Panorama, Russia), etc.

The second important class is presented by so called GIS-viewers, i.e. 
software products providing the use GIS-projects created with the help of 
instrumental GIS. As a rule, GIS-viewers provide the user with extremely 
limited options to view an internal structure of GIS-projects. All GIS-viewers 
are supplied with tools to perform positioning and zooming operations 
of cartographic images. Naturally, viewers always come as a component 
of instrumental GIS; this allows saving expenses on creating the part of 
workplaces not endowed with rights to replenish GDBs. Most viewers make it 
possible to organize the output of GIS-project. The most widespread viewer 
product is ArcReader (ESRI, USA).

The third class consists of software for processing and classification 
of aerial and space imagery. This includes packages for processing images, 
equipped – depending on the price – with different mathematical apparatus, 
which allows carrying out operations of data processing (radiometric, 
topographic and atmospheric correction) and visual and automated image 
classification  Among these GIS products it should be noted ERDAS Imagine 
(Hexagon Geospatial, USA), ENVI (Visual Information Solutions, USA), 
PHOTOMOD (Rakurs, Russia), and others.

The fourth class is programmes-vectorizers. These GIS-packages 
specialize on scanning, joining and correcting paper cartographic materials 
with subsequent vectorization of their contents in an automatic or semi-
automatic mode. The examples of these software products are Easy Trace 
(Easy Trace Group, Russia), ArcScan for ArcGIS (ESRI, USA), and others.

The fi th class is the software for processing field geodesic surveys. 
These packages provide for the import of information from Global Navigation 
Satellite Systems (GNSS) receivers, electronic tachometres, levels and other 
automated geodesic equipment, processing and analysis of data, calculation 
of coordinates of land plots, as well as creating plans of land plots boundaries 
with their means, or for data export to instrumental GIS. In Belarus most 
often the processing of results of ground instrumental survey is carried 
out via aGeodesy Suite and tGeodesy Suite (Belgiprozem, Belarus), Trimble 
Geomatics Offi e (Trimble, USA), CREDO_DAT and CREDO TОPОPLAN (Kredo-
Dialog, Belarus), and others.
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1.4. GIS-mapping of Land Resources  
in the Republic of Belarus

1.4.1. Land Information System of the Republic of Belarus
One of the examples of geoinformation mapping of land resources which 

is most detailed and successfully implemented on the example of many ATU 
of the Republic of Belarus is the land information system (LIS), which is a 
complex of program-technical tools, databases of spatially-attributed data, 
information-sharing channels and other resources, providing automation 
of accumulation, processing, storage and providing information about the 
condition, distribution and usage of land resources in electronic form, 
including by means of geoinformation technologies.

The LIS of the Republic of Belarus is created and used for information 
supply and automation of land management works, monitoring land resources 
and is designed to solve the following major tasks:

1) forming state statistic reporting about the condition and usage of land 
resources;

2) carrying out mass primary state cadastral accounting of land plots and 
state registration of titles on them;

3) compilation of documents, certifying the right to use, the right of 
lifelong heritable ownership of a land plot, and the title to a land plot;

4) preparation of materials on preliminary approval of places for 
feature placement, withdrawal and allocation of land plots, their ownership 
transfer, inclusion of land plots into urban area, changing the boundaries of 
administrative-territorial units;

5) control over establishing (recovery) of land plots boundaries;
6) forming cadastral maps;
7) state continuous survey of land, etc.
The LIS of the Republic of Belarus has a three-level structure. It consists 

of Local LISs (created within district (settlement) boundaries of Belarus; 
run by land-management and geodesic service of the corresponding district 
(settlement) and one of the State Property Committee enterprises, which 
is authorized to carry out technical support of Local LISs), Regional LISs 
(created within the boundaries of the regions of the Republic of Belarus 
basing on the data provided by Local LISs; run by the Republican Unitary 
Enterprise “Project Development Institute Belgiprozem” and its subsidiary 
enterprises), and the Central LIS (is being created within the State boundary 
of the Republic of Belarus basing on the data provided by Local and Regional 
LISs; run by the Republican Unitary Enterprise “Project Development Institute 
Belgiprozem” and its subsidiary enterprises).
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The LIS of the Republic of Belarus is created in the conformal transverse-
cylindrical Gauss-Krüger map projection, calculated in three-degree zones 
according to the parameters of the Krasovsky ellipsoid in the 1963 coordinate 
system.

The spatial data of Local LISs of the districts of the Republic of Belarus 
are created with the accuracy of a topographic map of 1 : 10,000 scale. 
Medium errors in the spatial position of terrain features and clear outlines 
relative to the nearest points of geodesic basis should not exceed 5 m (0,5 mm 
in 1:10 000 scale).

The spatial data of Local LISs of settlements of the Republic of Belarus 
are created with the accuracy of a topographic map of 1 : 2,000 scale. Medium 
errors in the spatial position of terrain features and clear outlines relative 
to the nearest points of geodesic basis should not exceed 1 m (0,5 mm in 
1 : 2,000 scale). In areas of multi-level building errors in the mutual position 
of points of the nearest important outlines (capital facilities, buildings, etc.) 
should not exceed 0,8 m (0,4 mm in 1 : 2,000 scale).

The GDB of the LIS of the Republic of Belarus contains information 
about land plots, their boundaries and administrative-territorial properties, 
distribution of land by categories and classes, land owners and land users, 
types of land (land covering), and their reclamation condition, restrictions 
on land use, current changes in land composition and distribution, as well 
as elements of topographic content. The spatial layers of the GDB of the 
LIS of the Republic of Belarus are combined into a number of layer groups 
(table 1.1). The GDB also contains a number of information and reference 
tables.

Creating of GDB of a Local LIS includes several stages: 1) preparatory 
work; 2) processing the materials of high resolution aerial or space-based 
surveying; 3) creating the raster spatial basis; 4) creating a digital land 
cadastral plan (map); 5) forming the GDB of a Local LIS; 6) forming a 
computer cadastral map; 7) compilation of a technical report on the creation 
of the GDB of a Local LIS; 8) transfer of the GDB of a Local LIS to operation.

The subject of a LIS record is land resources of the Republic of Belarus, 
their condition and usage; the feature of a LIS record is land classes.

According to The Code of the Republic of Belarus about Land the land of 
the Republic of Belarus can be subdivided into 14 classes according to their 
natural-historical characteristics, condition and pattern of use.

The classes of land of the Republic of Belarus are: 1) arable land; 
2) fallow land; 3) land under permanent crops; 4) grassland; 5) woodland; 
6) scrubland; 7) swampland; 8) land under water objects; 9) land under roads 
and other transport communications; 10) land under streets and other public 
spaces; 11) building land; 12) disturbed land; 13) unused land; 14) other land.

https://context.reverso.net/%D0%BF%D0%B5%D1%80%D0%B5%D0%B2%D0%BE%D0%B4/%D0%B0%D0%BD%D0%B3%D0%BB%D0%B8%D0%B9%D1%81%D0%BA%D0%B8%D0%B9-%D1%80%D1%83%D1%81%D1%81%D0%BA%D0%B8%D0%B9/space-based
https://context.reverso.net/%D0%BF%D0%B5%D1%80%D0%B5%D0%B2%D0%BE%D0%B4/%D0%B0%D0%BD%D0%B3%D0%BB%D0%B8%D0%B9%D1%81%D0%BA%D0%B8%D0%B9-%D1%80%D1%83%D1%81%D1%81%D0%BA%D0%B8%D0%B9/surveying
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Table 1.1
Spatial layers of the GDB of the LIS  

of the Republic of Belarus

Groups
of layers Layers Types  

of layers Contents

Boundaries Administrative-
territorial units 
(Admi)

Polygonal Features of administrative-
territorial and territorial 
division

Turning points of 
the boundaries land 
plots (Lots1)

Point Turning points of the 
boundaries, the boundaries 
the actually land plots 
owners, owners, of users, 
tenantsThe boundaries land 

plots (Lots2)
Linear

Land plots (Lots3) Polygonal

Land use 
restrictions (Serv)

Polygonal Water protection zones, 
coastal strips, sanitary 
protection zones, water 
intakes, sanitary protection 
strips of water conduits, 
protected zones of 
telecommunication lines, 
protected zones of power 
lines, protected zones 
of pipelines, zones of 
radioactive contamination, 
land for recreational 
purposes, land for 
recreational purposes, land 
of historical and cultural 
purposes, land for nature 
protection purposes; 
land with restrictions on 
construction, landscaping, 
etc.; other zones 

Land Land (Land) Polygonal Land contours

Ameliorative 
condition of land 
(Melio)

Polygonal The contours of land 
reclamation types

Soil Polygonal Type, humidification  grain 
composition, underlayment, 
genesis of plots of soil 
varieties 
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Сontinuation of the table 1.1

Groups
of layers Layers Types  

of layers Contents

Intersections Intersection 
of contours of 
land holdings, 
restrictions, land 
and amelioration 
(CrosTab)

Polygonal Features formed by 
intersection of Lots, Serv, 
Land, and Melio layers 

Details Communications 
(Comm) 

Linear Communication objects

Fencing (Fence) Linear Fencing

Out-of- scale 
features and 
symbols (Obj)

Point Point features and symbols

Annotations (Text) Point Names and labels of features 
or groups of features 

Sheets of land-
cadastral map
(MapList) 

Polygonal Scheme of cutting sheets of 
the land-cadastral map of a 
LIS territory

Rasters Ortho10000 Image 
catalogues

Mosaic raster orthophoto map 
of a district (settlement)Ortho5000

Ortho2000

Topo10000 Image 
catalogues

Mosaic raster topographic 
maps (plans)Topo5000

Topo2000

Topo1000

Topo500

Zem10000 Image 
catalogues

Mosaic raster land-cadastral 
map of a district

Sady2000 Image 
catalogues

Raster plans of horticultural 
associations Sady1000

Sady500

Changes Project plots
(Lots New)

Polygonal Project land plots
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Groups
of layers Layers Types  

of layers Contents

Registered land 
plots
(LotsREG) 

Polygonal Contours of land plots 
registered in the Unified state
registry of real estate and 
transferred to the LIS to be 
entered in the Lots layer

Dot feature changes 
(PointsUp)

Point Areas of change in the 
content of point layers of the 
GDB of LIS

Line feature 
changes (LinesUp)

Linear Areas of change in the content 
of linear layers of the GDB of 
LIS

Polygonal feature 
changes (PolyUp)

Polygonal Areas of change in the 
content of polygonal layers of 
the GDB of LIS

According to the Technical Code of Established Practice the GDB of a 
Local LIS uses special attribute coding types on the “Land” layer to Identify 
types (LandType) and subtypes of land (LandSubtype). Note that there is no 
unequivocal association between the types and/or subtypes of land and the 
classes of land.

The class arable land includes agricultural land, systematically 
cultivated (ploughed up) and used for crops of agricultural cultures, including 
crops of perennial herbs with a term of use, stipulated by the scheme of 
crop rotation, as well as emergency fields  covered soil plots (hotbeds, 
greenhouses, and conservatories), and bare fallow. In the GDB of LIS this 
class applies to the type cultivated land (LandType code 101), subtype arable 
(LandSubtype code 3).

Agricultural land, which earlier were used as arable and remain uncropped 
for more than one year after harvesting and not are not prepared to be left 
fallow are related to the class fallow land. In the GDB of LIS this class applies 
to the type cultivated land (code 101), subtype fallow (code 4).

The class of land under permanent crops includes agricultural land 
occupied by artificially created tree and shrub vegetation (plantations) or 
plantations of herbaceous perennial plants intended for harvesting, food, 
technical and medicinal plant raw materials, as well as for landscaping. 
In the GDB of LIS this class of land refers to the permanent crops type 
(LandType code 102), subtypes orchards (LandSubtype code 6), berry fields
(7), plantations (8), fruit nurseries (9) and others (5). The orchards subtype 

End of the table 1.1
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includes land occupied by perennial, more often tree plantations (seed-
bearing, stone fruits), created to obtain fruit and berries; berry  field  – 
occupied by perennial shrubs, semi-shrubs and herbaceous plants, intended 
for obtaining berries; plantations – occupied by perennial plantations for 
cultivation of special technical, medicinal, ornamental crops; fruit nurseries – 
plots intended for growing planting material of fruit and berry crops.

The grassland class of land contains agricultural land used principally for 
cultivation of perennial grasses, land with artificial herbage or land undergone 
measures to improve natural grasses (improved), as well as land covered by 
natural meadow herbage (natural). In the GDB of LIS this class of land refers 
to the grassland type (LandType code 103).

According to the cultural and technical condition, grassland is divided 
into flooded  upland, waterlogged, clean, shrubby and improved. Flooded 
(subtypes 111–114) are meadow land located in the floodplains of rivers, 
lakes and lowland, flooded by hollow waters for a significant period (at least 
10 days), causing changes in the composition of vegetation; upland (subtypes 
121–124, 171–173) – located on elevated and well-drained landform elements, 
moistened mainly by atmospheric precipitation, as well as located in river 
floodplains  briefly and not systematically flooded by hollow waters (for a 
period of less than 10 days), which do not cause changes in the composition 
of vegetation; waterlogged (subtypes 131–132, 181–182) – located on low 
and poorly drained relief elements, in conditions of excessive moisture, 
determined by moisture-loving composition of herbaceous vegetation; clean 
(subtypes 111, 121, 131, 171, 181) – not covered with shrubs, stumps, trees, 
hummocks, stones, or when they evenly cover no more than 10 % of the area 
of the plot; shrubby (subtypes 112, 122, 132, 172, 182) – evenly overgrown with 
shrubs, occupying from 10 to 70 % of the plot area; improved (subtypes 113, 
123, 173) – land undergone measures to improve herbage, as well as occupied 
by sown perennial grasses, used for 7 or more years.

The class of woodland includes lands of the forest fund, covered with 
forests, as well as not covered with forests, but intended for its restoration 
(clearings, burnt areas, sparse areas, wasteland, clearings, dead forest stands, 
areas occupied by nurseries, plantations and unclosed forest crops, etc.), 
allotted for forestry. In the GDB of LIS this class of land refers to the following 
types: forests, tree plantings, coppice and other nonwooded areas.

Forests (LandType code 201) include lands whose area is covered with tree 
crowns by more than 20 %. According to the species composition, forests are 
divided into coniferous (subtypes 291–293) – forested, in which approximately 
75 % or more of all plantations are coniferous tree species; deciduous 
(subtypes 301–303) – forested, in which approximately 75 % or more of all 
stands are deciduous tree species; mixed (subtypes 311–313) – covered with 
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forest, in which coniferous and deciduous tree species are equally presented; 
those not rated as either coniferous or deciduous forests. In addition, there 
are forests without specifying of tree species composition (subtype 326).

The plantings type of land (LandType code 202) is divided into subtypes 
according to their species composition: coniferous (subtype 294), deciduous 
(304), mixed (314), and without specifying of tree species composition (327).

Similarly, there is coniferous (subtype 295), deciduous (305), mixed (315) 
and without specifying of tree species composition (328) coppice (LandType code 
203) – land plots with trees up to 4 m tall, the areas of which are covered with 
crowns by more than 20 %.

Among other nonwooded areas (LandType code 205), we can distinguish 
the following: cutting areas (subtype 324) – cutting areas or their parts, on 
which the stand has been cut down, and a new one has not yet closed; burnt 
areas (subtype 325) – forest areas damaged by fire to the point of growth 
cessation, as well as other areas (subtype 329).

The scrubland class of land includes land covered with tree and shrub 
vegetation (plantations) that is not included in the forest fund. In the GDB of 
LIS this class of land refers to other wooded areas type (LandType code 204). 
This type maps as tree-shrubbery vegetation (subtype code 321) and forest and 
scrub belts (subtype code 322).

The swampland class is excessively moistened lands covered with a layer 
of peat. In the GDB of LIS this class of land refers to the type swamp (LandType 
code 206). The subtypes are mapped as: lowland swamps (code 34) – located 
on low relief areas, moistened by ground or surface waters (according to the 
species composition, these swamps are sedge or reed-reed swamps); upland 
(code 35) – located on elevated areas of the relief, moistened by atmospheric 
precipitation (moss) and transitional (code 36) – occupying a middle position 
between upland and lowland, moistened by atmospheric precipitation, ground 
and surface waters (moss-sedge).

The land under water objects class of land includes lands occupied 
by the concentration of natural waters on the land surface (rivers, streams, 
springs, lakes, reservoirs, ponds, digging ponds, canals and other surface water 
bodies). In the GDB of LIS, this class of land refers to two types: watercourses 
(LandType code 301) and reservoirs (code 302). In the watercourses land type 
the subtypes of streams (subtype code 401), rivers (40), rivers and streams (400), 
canals and drains (43) are mapped separately, in the reservoirs type – lakes 
(subtype code 41), reservoirs and ponds (42), other water bodies (39).

The class under roads and other transport communications is formed 
by lands occupied by roads, clearings, runs, linear structures. In the GDB of 
LIS, this class of land refers to three types: roads, railways and communication 
elements.
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The roads type (LandType code 401) is divided into a number of subtypes 
according to the degree of technical perfection of the road surface. These 
are improved roads (carriageway (subtype code 446), roadsides (447), ditches 
(448), slopes (449), dividing lanes (450)) – motor roads having a solid base 
and a pavement of asphalt, concrete or cement concrete with the carriageway 
width of at least 7 meters; country roads (subtype code 445) – unprofiled  
unpaved, connecting settlements, foresters’ houses, etc., serve as an exit 
from settlements to improved roads; clearings (code 444) – narrow strips 
cut through a forest to mark the boundaries of quarters, for construction 
purposes, power lines, pipelines, etc.; fiel  and forest roads (code 441) – natural 
dirt roads with seasonal or sporadical traffic  mainly during field work, logging, 
peat extraction areas and cattle passes (code 704) – roads designed to drive 
livestock along them.

The railways type (LandType code 402) separately maps the following 
subtypes: bed (subtype code 701), ditches (702), slopes (703), and cargo and 
passenger platforms (705).

Communication elements (LandType code 403) include pipelines (subtype 
code 442); bridges and overpasses (443), as well as under other communication 
elements (440).

The class of land under streets and other public places includes land 
occupied by streets, avenues, squares, driveways, embankments, boulevards, 
squares, parks and other public places. In the GDB of LIS, lands of this class 
completely form the type of green spaces (LandType code 502), where they 
are represented by the following subtypes: boulevards (code 455), lawns 
and flo er-beds (456), parks, and squares (460). In addition, the majority of 
subtypes of squares (451), streets and driveways (452), carriageways of streets 
and driveways (453), sidewalks and footpaths (454)) – they are represented in 
the type square and street (LandType code 501) and in one subtype (other 
common areas, code 457) in the type yards (LandType code 503).

The building land class is made up of lands occupied by permanent 
structures (buildings, structures), as well as lands adjacent to these features 
and used for their maintenance. In the GDB of LIS, lands of this class 
completely form the type buildings (LandType code 504), which is divided 
into residential (codes 454–466) and non-residential (467–469), with the latter 
group including buildings for industrial, utility-storage and public purposes, 
as well as into subtypes fire-resistan  (464, 467), non-fire-resistan  (465, 468) 
and mixed-fire-resistant (466, 469). Fire-resistant buildings include buildings 
with walls and roofs made of refractory material: walls – brick, reinforced 
concrete, gas silicate or expanded clay concrete blocks; roofs – metal, tiled 
(ceramic, cement-sand, metal) and slate. Non-fire-resistant buildings include 
wooden buildings, and mixed buildings are those in which the lower floor is
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made of fire-resistant materials, and the upper and (or) roof is made of non-
fire-resistant materials, or the entire building is wooden, but with a thin fire
resistant cladding.

Building land also form most of the subtypes referring to the type 
constructions (LandType code 505). These are the subtypes light-type 
constructions (code 470), greenhouses (471), silo  pits (462), and other 
constructions (472). In the yards type (LandType code 503), utility yards 
(subtype code 461), open-air warehouses (463), paddocks (473), and estate land 
(67) are mapped. In the type squares and streets (LandType code 501) there 
are porches and blind areas of buildings (subtype code 458) and stairs (459).

Note that in the urban territories in the 1: 2,000 scale, all terrain 
features (residential and non-residential buildings, porches and blind areas 
of buildings, sidewalks and footpaths, orchards, etc.) are interpreted and 
digitized, but when creating the LIS of this territories in the 1: 10,000 scale, – 
only buildings, with the rest of the plot digitized and interpreted as estate 
land (subtype code 67).

The class disturbed land is lands that have lost their natural and 
historical features, condition and nature of use as a result of harmful 
anthropogenic impact and are in a state that precludes their effective use 
for the original intended purpose. In the GDB of LIS, lands of this class 
completely form the disturbed land type (LandType code 601). Among the 
subtypes, there are lands disturbed in the result of mining (code 49), disturbed 
in the result of peat and sapropel extractions (50), disturbed during construction 
works (51), other disturbed land (48).

The unused land class includes land that is not used in economic 
and other activities. In the GDB of the LIS of the Republic of Belarus, they 
constitute the type unused land (LandType code 602). This type is formed 
by sands devoid of vegetation (subtype code 54), ravines and gullies (55), 
ramparts (56), burnt peatland (58), former agricultural land contaminated 
with radionuclides (59), mounds (662), pits (663), soaks (664), other unused 
land (53).

The class other land includes lands that do not refer to any of the 
above types. In the GDB of LIS, these are the following types: improved land 
(LandType code 701, subtypes: under melioration construction (code 23); under 
fertility restoration (24)), mineral extraction and construction sites (LandType 
code 702, subtypes: peat and sapropel extraction sites (37); waste dumps 
and waste heaps (665); quarries (668); construction sites (669)), dump sites 
(LandType code 703, subtypes: household waste dump sites (63); industrial 
waste dump sites (64); contaminated by radionuclides dump sites (65); other 
dump sites (62)), burial places (LandType code 704, subtypes: cemeteries 
(60); cattle burial sites (61)), other land (LandType code 705, subtypes: under 
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brows (57); other land (666)), as well as two subtypes of the constructions 
type (LandType code 505, subtypes: dams (661); other slopes (667)).

The ameliorative state of land is mapped in the GDB of a Local LIS in 
the layer “Ameliorative condition of land” (Melio). The attribute table encodes 
the type and subtype of the ameliorative state (table 1.2).

Table 1.2
Types and subtypes of ameliorative conditions of land

Type 
(MelioType)

Subtype
(MelioCode) Name of ameliorative condition

1 – drainage 1 Drained by an open net 

2 Drained by a closed net 

2 – irrigation 3 Irrigated

4 Irrigated on drained by an open network 

5 Irrigated on drained by a closed network 

50 Irrigated

60 Irrigated on drained 

3 – two-way 
regulation

30 Drained by an open network with two-way 
regulation 

40 Drained by a closed network with two-way 
regulation 

6 Bilateral regulation with open network 

7 Bilateral regulation with closed network 

8 Polders

4 – water 
logging

9 Waterlogged 

10 Waterlogged in hollows

1.4.2. Automated System  
of the State Land Cadastre

The state land cadastre (SLC) is a set of systematized information and 
documents on the legal regime, condition, quality, distribution, economic 
and other usage of land, land plots.

In the Republic of Belarus, the SLC consists of:
• the unified registry of administrative-territorial (ATU) and territorial 

units (TU) of the Republic of Belarus (Registry of ATU and TU);
• the unified state registry of real estate, title to it and transactions with 

it (USRRE);
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• the registry of prices for land plots from the State Land Cadastre (Price 
Registry);

• the registry of the cost of land plots from the State Land Cadastre (Value 
Registry);

• the registry of land resources of the Republic of Belarus.
Information support of the automated system of the State Land Cadastre 

(SLC) consists of the databases of registers (registries) of the SLC automated 
system, digital cadastral maps, input and output forms and documents 
of subsystems of the SLC automated system; archives and other digital 
documentation.

Digital cadastral maps are SLC documents created by geo-information 
mapping about the location of features of state registration, their addresses, 
boundaries, cadastral numbers and other information. Depending on the 
purpose, cadastral maps are divided into four classes: basic cadastral maps 
(class A), cadastral maps of administrative and territorial division (class B), 
cadastral maps of the land fund condition and usage (class C), auxiliary and 
thematic cadastral maps (class D).

Cadastral maps of the administrative-territorial division (class B) are 
created as part of the Register of ATU and TU, which contains information 
about the names, sizes and boundaries of ATU and TU and their administrative 
centers. Digital cadastral maps of this class include a topographic base 
(road network layers, hydrography, vegetation), and ATU and TU (layers 
of the state boundary of the Republic of Belarus, boundaries of regions, 
boundaries of districts, boundaries of village councils, boundaries of cities 
and urban-type settlements, boundaries of rural settlements, boundaries of 
the territories with a special usage regime). The ISATF (Indications System 
for Administrative-Territorial Formations) codes are used to fill in the ATU 
and TU attributes. Maps of the administrative-territorial division of the 
republic (class B1, scale 1 : 500,000), administrative-territorial division of a 
region (class B2, scale 1 : 200,000), and administrative-territorial division of 
a district (class B3, scale 1 : 50,000–1 : 100,000) are created.

The USRRE contains information and documents regarding registered 
land plots and real estate objects located on them, including information 
about the location of land plots, their size, boundaries, purpose, titles to 
these plots, restrictions (encumbrances) of titles to land plots, including 
land easements, as well as information about transactions with them. Within 
this register, a layer of land plots registered in the USRRE is formed basing 
on coordinate catalogues, as a SHP-file with the corresponding attribute 
tables of land users (LotsREG). Using these spatial data, basic cadastral maps 
(class A) are created. These are maps of cities and urban-type settlements 
or rural settlements (class A1, scales 1 : 2,000–1 : 10,000), as well as maps of 
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district land (class A2, scale 1 : 10,000). A registry of street and road names 
(Street Registry) is maintained within the USRRE. The spatial information 
of this registry in vector form is used when entering the addresses of real 
estate objects into the USRRE.

The Price Registry contains information about prices for land plots and 
real estate objects located on these plots, fi ed at the time of transactions 
with these plots and real estate objects. Spatial information is contained in 
vector form and includes such attributive data as the address of a real estate 
object, its main characteristics, the date and price of the deal.

The Value Registry contains information on the cadastral value of 
land plots obtained during their cadastral valuation. Within this registry, 
digital layers of appraisal zoning are formed, as well as information of urban 
planning, environmental, socio-cultural purposes regarding ATU and TU of 
the Republic of Belarus, used in the cadastral valuation of land. Auxiliary 
spatial information forms class D1 cadastral maps on this subject.

The Registry of Land Resources of the Republic of Belarus contains 
information on the distribution of land by categories, classes and land users, 
composition, structure, condition, quality and economic use of land, other 
information about land. Within this class, cadastral maps of the land fund 
condition and usage (class C) are formed, which contain data on the structure 
of land, their quantity, quality, distribution by category, land owners, and 
land users. Class C maps are used for the purposes of state land registration, 
evaluation, land management, etc. These are maps of cities, other settlements 
(class C1, scale 1 : 2,000), as well as land of agricultural, forestry and other 
enterprises (class C2, scales 1 : 5,000–1 : 10,000). The LIS of the Republic of 
Belarus serves as a source for creating maps of this class.

Auxiliary maps (subclass D1) include cadastral maps created in 
the course of keeping the State Land Cadastre: individual land plots, 
refle ting the presence of real estate objects on them, as well as easements, 
encumbrances and restrictions on property rights; appraisal zones amps; 
overview maps, designed to highlight cadastral blocks. They are created in 
1 : 200–1 : 2,000 scale.

Thematic maps (subclass D2) include: land tenure maps (agricultural 
enterprises, forestries and other enterprises, institutions and organizations), 
refl cting a set of information characterizing the condition and usage of land; 
soil, geobotanical and other maps characterizing the qualitative condition 
of land. They are created in 1 : 10,000–1 : 100,000 scale.

Any cadastral map is formed by overlaying the data of a certain date 
from the State Land Cadastre on the cartographic basis. The source of 
cartographic basis for class A, B and D cadastral maps is class C cadastral 
maps or topographic survey materials.



24

1.4.3. Land Management
Land management in the Republic of Belarus includes:
• development of projects of usage and protection of land resources, 

projects of land management of ATU and TU, territories of special state 
regulation;

• development of projects for inter-farm land management, including 
projects for allocation of land plots, execution of technical documentation 
and establishment (restoration) of the territorial boundaries of land plots;

• development of projects for on-farm land management of agricultural 
organizations, including peasant (farm) enterprises, projects for the 
organization and arrangement of territories of settlements, horticultural 
associations, specially protected natural areas and other territorial units;

• development of projects for land reclamation, protection of soils from 
erosion and other harmful effects, conservation and improvement of soil 
fertility and other beneficial properties of land, as well as other projects 
related to the protection and improvement of land;

• inventory of land, systematic identification of unused or misused land;
• carrying out geodetic and cartographic works, soil, geobotanical and 

other surveys and surveys carried out for the purposes of land management, 
compiling cadastral and other thematic maps (plans) and atlases of the 
condition and usage of land resources;

• copyright supervision over implementation of projects of land 
management;

• implementation of land management activities in the course of land 
monitoring, keeping of the State Land Cadastre, including in the course of 
cadastral valuation of land, land plots, exercising state control over the usage 
and protection of land;

• implementation of research and development work, as well as the 
development and modernization of the hardware and software complex 
(software) necessary for the implementation of land management activities;

• preparation of land management materials for land disputes settlement.
Carrying out these activities is nowadays impossible without geoinformation 

mapping. Information support and automation of land management are carried 
out by means of LIS.

When drawing up projects for land management of districts, both the 
textual and the cartographic part are formed, the latter refle ting the modern 
land usage of the district and the restrictions on it, as well as proposals on 
promising areas of land usage. The cartographic part includes the main 
maps of the district in 1 : 50,000 scale, thematic maps in 1 : 100,000 scale, 
fragments of maps of other scales, and map diagrams. This part is mainly 
compiled on the basis of Local LIS. The main maps include: 1) current land 
usage; 2) restrictions on land usage; 3) long-term land usage.
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The composition and content of thematic maps is not limited and is 
determined by the assignment for the development of a land management 
project. Thematic maps show the current condition of the relevant land 
management objects and the changes resulting from the proposals and 
activities of the land management project. The production of thematic maps, 
which refle t the results of an assessment of natural conditions and of a 
complex resource assessment, visually reasoned for the concept and strategy 
of land management, is mandatory.

The composition and content of maps, graphs, diagrams, photographs 
and other illustrative materials in the text of the land management project, 
as well as of insets on maps, is not regulated.

During inter-farm land management, in the process of withdrawal and 
provision of land plots, Local LISs of the districts of the Republic of Belarus 
are used. Thus, at the stage of preliminary approval of the location of a land 
plot (if this stage is necessary) and when drawing up the project of a land 
plot allocation, digital land cadastral plan (map) is used, which is drawn up 
within the boundaries of towns of district subordination, rural settlements, 
urban-type settlements in 1 : 2,000 scale, outside them – in 1 : 10,000 scale. 
Essentially the plan (fragment of the plan) is a printed out Local LIS.

Having established the territorial boundaries of an allotted land plot and the 
state registration of the creation of the land plot and the emergence of the title 
to it, the spatial information about the land plot according to the catalogue 
of coordinates of the turning points of its boundaries is entered into the 
USRRE, and then in the form of a SHP file (LotsREG) with the corresponding 
attribute tables of the land users (land owners) is entered into the Local LIS 
(layers “Lots1, Lots2, Lots3).

When developing projects for inter- and intra-farm land 
management, the spatial information of a local level LIS in raster and vector 
form is also actively used. After the project is carried out in nature, the 
information on the land fund structure is entered into the GDB of a local LIS.

Questions for self-assessment

1. What is geoinformation mapping? What is geoinformation mapping of land 
resources?

2. Enumerate the main sources of data for geoinformation mapping of land 
resources.

3. During which period of GIS methods of land mapping development did the firs  
land information systems appear?

4. What functional groups is the software used in GIS-mapping of land divided 
into?



5. Identify and describe the three levels of the LIS of the Republic of Belarus.
6. Which scale topographic map accuracy are Local LIS of the Republic of Belarus 

created?
7. Enumerate the groups of spatial layers of the GDB of the LIS of the Republic 

of Belarus.
8. How are land classes associated with land types and subtypes of the GDB of the 

LIS of the Republic of Belarus? Provide examples.
9. Enumerate the types of ameliorative conditions of the land of the GDB of the 

LIS of the Republic of Belarus.
10. Which classes, depending on their purpose, are digital cadastral maps in the 

Republic of Belarus divided into? Describe each of the classes.
11. Identify the main directions of application of geoinformation mapping for the 

purposes of land management in the Republic of Belarus.
12. What scales are maps related to the cartographic part of land management 

projects for the districts in the Republic of Belarus created?
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2. LAND RESOURCE MANAGEMENT  
BASED ON REMOTE SENSING DATA

2.1. Remote Sensing Data Used for the Purposes  
of GIS-mapping of Land Resources

Remote sensing means obtaining information about the Earth’s surface 
(including objects located on it) without direct contact with it, by registering 
incoming electromagnetic radiation from it. Remote sensing data (RSD) 
obtained in this way in the digital form are intensively used in land resource 
management. To extract spatial information about the land recourses from 
the initial data, special methods of image classification are required. But 
before classification of data, it is necessary to understand what properties they 
have and choose the data optimal for solving the problems of land resource 
management.

RSD can be systematized on several grounds: 1) by the height from which 
the survey was made; 2) by the scale and spatial resolution; 3) by the range 
of registered radiation; 4) by technological methods of obtaining images.

According to the height from which the survey was made, there are 
aerial images (AI) (acquisition sources: airplanes and helicopters, radio-
controlled models; preferred altitudes range from 500 m to 10 km) and 
satellite images (SI) (acquisition sources: automatic satellites, spacecraft, 
manned orbital stations; altitude – more than 150 km). AI and SI have 
important differences when they are used for GIS land mapping. The benefit  
of AI are: very high detail and efficiency when it comes to small areas. In 
the Republic of Belarus it is the AI that serve as the basis for the creation of 
LIS at the local level. SI have a number of special properties (great visibility, 
complex display of geospheric components, regular recurrence of surveys, 
simultaneous surveys in different ranges of detected radiation), which make 
it possible to use them for GIS mapping of the structure and dynamics of the 
land fund.

The classification of RSD by scale is applicable to AI, which is due to their 
processing precisely in the scale of shooting. As a rule, the ratio between the 
scales of the AI and the compiled map does not exceed 3 : 1, and more often 
the image scale is twice as large as the map scale or close to it. Depending on 
the pattern of use, AI are divided into super-large-scale (larger than 1 : 5,000), 
large-scale (1 : 10,000–1 : 25,000), medium-scale (1 : 50,000–1 : 60,000), and 
small-scale (1 : 100,000–1 : 200,000). Large-scale and super-large-scale aerial 
photographs are used for geoinformation mapping of land in the Republic 
of Belarus.
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Most SI are not interpreted in the scale shooting, like AI, but with a 
significant zoom. The original scale of the image can be three to fi e or even 
ten times smaller than the scale of the map compiled from it. As a result, for 
SI, it is not so much the scale that is important, but the spatial resolution, 
which characterizes the real size of the smallest detail reproduced in the 
image. This indicator depends on the altitude of shooting, the properties of 
the lens of the shooting equipment and other factors, and is determined by 
the size of the image element, the pixel (fig  2.1). Depending on the tasks 
to be solved, there may be used the data of very low (more than 1 km), low 
(300 m – 1 km), medium (50–200 m), high (1–40 m) and very high (0.1–0.9 m) 
resolution. For GIS mapping of land resources, it is preferable to use SI of 
high and very high spatial resolution.

  
        а  b

Fig. 2.1. Space images with different spatial resolution: 
a – pixel size 1 m (QuickBird); b – pixel size 30 m 

(Landsat-7 ETM+; combination of red, green and blue zones of the visible range)

The range of registered radiation (spectral resolution) indicates 
which parts of the spectrum of electromagnetic waves are recorded by the 
sensor. Conventionally, the entire range of wavelengths used in obtaining 
remote sensing data can be divided into fi e sections: radio frequency 
range (wavelength over 1 mm); middle and far infrared (thermal) range 



29

(3–1000 µm); near infrared range (0.7–3 µm), visible range (0.4–0.7 µm); 
ultraviolet range (wavelength shorter than 0.4 µm). This division is due to 
the difference in the interaction of electromagnetic waves and the Earth’s 
surface, the difference in the processes that determine the refle tion and 
radiation of electromagnetic waves.

The most commonly used range of electromagnetic waves is visible light 
and adjacent to it shortwave infrared radiation. In this range, refle ted solar 
radiation carries information mainly about the chemical composition of the 
surface. Just as the human eye distinguishes substances by color, a remote 
sensor captures “color” in the broader sense of the word. So, if the human eye 
perceives the visible region of the spectrum, then modern sensors are able to 
distinguish tens and hundreds of zones, which makes it possible to accurately 
determine objects and phenomena by their previously known spectrograms. 
For many practical problems, such detailedness is not always necessary. If the 
objects of interest are known beforehand, you can choose a small number of 
spectral zones in which they will be most noticeable. For example, the near 
infrared range is very effective in assessing the condition of vegetation. Some 
combinations of spectral zones better show land under vegetation, others 
under anthropogenic objects, and still the others under water bodies, etc.

Usually, optical survey is carried out either at once in the entire visible 
range (panchromatic) or in several narrower spectral zones (multizonal).

Thermal infrared radiation carries information mainly about the surface 
temperature. In addition to direct determination of the temperature regimes 
of visible objects and phenomena (both natural and artificial)  thermal images 
make it possible to indirectly reveal what is hidden underground: rivers, 
pipelines, etc.

The centimeter range of radio waves is used for radar survey. The most 
important advantage of this class images is their all-weather capability. Since 
the radar registers its own radiation refle ted by the Earth’s surface, it does 
not require sunlight for its operation. In addition, radio waves of this range 
penetrate continuous cloudiness freely and are even able to penetrate to a 
certain depth into the soil. The refle tion of centimeter radio waves from the 
surface is determined by its texture (“roughness”) and the presence of various 
films on it. A characteristic feature of radar imaging is its high sensitivity to 
soil moisture, which is also important for agricultural applications.

There are three main technological methods of obtaining images: 
photographic, optoelectronic and radar. In the photographic method, the 
spatial distribution of the spectral brightness of the elements of the Earth’s 
surface is recorded directly on light-sensitive materials (black and white, 
color, spectrozonal films)  The advantage of this method is the possibility of 
obtaining images with a very high resolution, high geometric and photometric 
properties. This method is used mostly in aerial photography of land 
resources. The disadvantage of this method when shooting from space is 
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its slowness. In addition, the RSD obtained in this way require subsequent 
scanning before being used in a GIS.

The principle of the optical-electronic method for obtaining RSD consists 
of element-by-element reading along a narrow band of radiation refle ted 
by the Earth’s surface, and the image is scanned due to the movement of the 
carrier, so it is received continuously. The radiation received from the source 
is converted into an electric signal, then sent to the Earth in the form of a 
radio signal, where it is again converted into an electric signal and recorded 
on magnetic media. The images obtained in this way are discrete (consist of 
pixels) and suitable for direct processing and interpreting in GIS. The spatial 
resolution of such data depends on the pixel size.

In radar imaging, the Earth’s surface is sounded with a radio signal 
using a special device – a radar, which is an active microwave sensor capable 
of transmitting and receiving polarized radio waves in a given frequency 
range. High brightness of a pixel in the images means that most of the signal 
returned to the antenna, low brightness means the opposite. A distinctive 
feature of radar images is the presence of so called speckle noise.

In addition, in recent years, video filming and filming with digital cameras 
based on the use of fiber optics have appeared and are becoming increasingly 
important. In the Republic of Belarus, data obtained by photographic and 
optical-electronic methods are most often used for the purposes of GIS-
mapping of land.

2.2. Digital Image Preprocessing

A digital image is a raster image of the Earth’s surface stored on a 
magnetic carrier. RSD in a raster model of representing spatial data is stored 
as a uniform cellular structure that forms a rectangular matrix, in which each 
element (pixel) takes on a certain value of spectral brightness inherent in a 
real spatial object.

After obtaining the necessary RSD and immediately before geoinformation 
mapping of land resources, the images are subjected to preliminary 
processing, which includes a number of stages:

• geometric correction;
• radiometric calibration;
• radiometric correction of the influen e of the atmosphere;
• recovery of missing pixels;
• brightness transformations;
• filtering
Geometric correction includes elimination of geometric distortions of an 

image (orthorectification) and georeferencing. The main causes of geometric 
distortions of images are the curvature of the Earth’s surface, the influen e 
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of the terrain, the rotation of the Earth and the movement of aircraft, from 
which the survey is carried out. The result of geometric transformations is 
geo-referenced, projected and orthorectified images with a given reference 
ellipsoid.

Radiometric calibration arises from the need to obtain correct values of 
the spectral brightness of objects. Images originally received from satellites 
are recorded in the form of so-called “raw” brightness values. Data in this 
format cannot be adequately compared with data from other surveys. The task 
of radiometric calibration is to convert these values into physical units by 
special formulas. This correction deals with the variation of pixel brightness 
values caused by the failure or malfunction of detectors, the influen e of the 
terrain, and atmospheric effects.

Radiometric correction of the influen e of the atmosphere is due to 
the peculiarities of the composition and state of the atmosphere during the 
recording of electromagnetic radiation by the sensor. When passing through 
the atmosphere, electromagnetic waves are absorbed and scattered. The 
reason is the content of ozone, water vapor, carbon dioxide, oxygen, methane, 
dust and smoke in the atmosphere. Cloudiness also interferes with shooting in 
the optical range. These phenomena cause distortion of the brightness values 
of the pixels in images. The main methods of atmospheric correction are:

1) assessment of the content of water vapor and aerosols (smoke) in 
the atmosphere from images that include areas occupied by water surfaces 
(clouds and fogs are clearly visible against the background of water, since in 
the red and infrared parts of the spectrum, the water surface in its optical 
characteristics is close to an absolute black body);

2) the use of mathematical methods of constructing models of the 
atmosphere conditions, taking into account the types of scattering in the 
atmosphere, seasons, and meteorological data.

Restoration of missing pixels in the image is carried out, if during the 
shooting or data transfer the brightness values of the entire row were replaced 
by the values of the adjacent row. Such phenomena can interfere with the 
thematic processing of the image. Restoration is carried out by interpolation 
with a certain error.

The brightness transformations of a digital image consist of changing 
the transfer function, which characterizes the relationship between the 
brightness on location and the level of brightness in the digital image. 
Brightness transformations of panchromatic images include contrasting, edge 
enhancement, quantization, and color coding. The most common methods 
of brightness transformations of multi-zonal images are the synthesis of a 
color image, mathematical operations (ratio and subtraction, calculation of 
vegetation indexes, the Kaut-Thomas transformation) and the method of 
principal components.
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Image contrast is the difference between the maximum and minimum 
brightness values. Contrasting is performed by converting the histogram of 
images, which characterizes the distribution of brightness in the image (for 
each of the 256 levels). There are several methods of enhancing contrast 
through digital processing. With linear histogram stretching (fig. 2.2, a and b),  
all image brightness values (for example, 35–226) are assigned new values in 
order to cover the entire possible range of brightness changes (0–255). When 
the histogram is normalized over the entire possible interval of brightness 
change, then not the entire histogram is stretched, but its most intense 
section. In the process of equalization (linearization) of the histogram, 
the brightness values of the pixels are changed in such a way that for each 
brightness level there is the same or close number of pixels.

        а  b

Fig. 2.2. Example of contrasting the original 
 Landsat ETM+ image (0.52–0.90 µm) (a) 

using the linear histogram stretching method (b)

In the process of edge enhancement, the brightness value of each pixel 
is compared with its “nearest neighbors” (the pixels directly adjacent to it). 
The subsequent mathematical operations make it possible to detect boundary 
pixels and increase their brightness values.

In quantization, image brightness levels are grouped into several 
relatively large steps. In the image thus obtained, the patterns of brightness 
distribution become more pronounced.

Color coding improves the quantized image by replacing the grey scale 
with a color one. However, the use of this transformation is only expedient, 
if the number of brightness levels lies within the range of 10–30.
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According to the principle of color image synthesis the image in each 
of the shooting channels is assigned its own color. Raster image processing 
programs most often use the RGB color scheme. According to this scheme, 
any image on a color screen is formed from three primary colors – red, green 
and blue, as well as additional ones. Most often, three zonal images are 
synthesized into one. It is possible to synthesize not only zonal images that 
make up a multizonal image, but also images obtained as a result of more 
complex transformations, and multi-temporal images. Synthesis of images 
with different spatial resolution is also possible.

The following standard combinations of zones are usually used:
1) red, green and blue zones create a true color composition (fig  2.3, a). 

True color means that objects look as they would be perceived with the naked 
eye;

2) near infrared, red and green zones create a false color composition. This 
composition looks similar to the image in the infrared part of the spectrum, 
in which, for example, vegetation appears red, water appears dark blue or 
black, etc. (fig  2.3, b).

        а  b

Fig. 2.3. Variants of color synthesis of a fragment of a multi-zone  
satellite image Landsat ETM+. The colors red, green and blue are 

assigned respectively to the images in the shooting areas: 
a – 3 (0.63–0.69), 2 (0.53–0.61), 1 (0.42–0.52);  
b – 4 (0.78–0.90), 3 (0.63–0.69), 2 (0.53–0.61)
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The most commonly used mathematical operations are dividing the 
brightness values of two zonal images when working with multi-zone images 
and subtracting them when analyzing two nonsimultaneous images.

A vegetation index is an indicator calculated as a result of operations 
with different spectral channels of RSD, and related to vegetation 
parameters in a given image pixel. The main assumption about the use of 
a vegetation index is that some mathematical operations with different 
RSD channels can provide useful information about vegetation. This is 
supported by a wealth of empirical evidence. The second assumption is the 
idea that the exposed soil in the image will form a straight line in spectral 
space (the so-called soil line). Almost all common vegetative indexes only 
use the ratio of red (RED) to near infrared (NIR) channels, assuming that 
the open soil line lies in the near infrared region. This line is meant to 
mean zero vegetation.

Nowadays, there are two approaches to calculating the direction lines of 
identical vegetation (isovegetation lines): 1) all isovegetation lines converge 
at one point; 2) all isovegetation lines run parallel to the soil line. In the 
first approach, the line slope between the convergence point and the RED–
NIR point of the ratio in a pixel is measured (indices NDVI, SAVI, and RVI). 
When using the second approach, the perpendicular distance from the soil 
line to the RED–NIR point in a pixel is measured (indices PVI, WDVI, and 
DVI).

To determine the amount of photosynthetically active biomass the most 
widely-used is the normalized difference vegetation index (NDVI), calculated 
by the formula: NDVI = (NIR – RED)/(NIR + RED). Index values vary from 
minus 1 up to 1 (fig  2.4). Dense vegetation has a value of 0.7, sparse – 0.5, 
open ground – 0.025, clouds – 0, water – −0.25, asphalt, concrete – −0.5.

During the Kaut-Thomas transformation, as a result of rotating the axes 
corresponding to the brightness of a digital image in three zones representing 
the axes of three-dimensional space, the zonal features of the image are 
regrouped, in which the main part of the information is characterized by two 
features: “brightness”, i.e. the soil index, and “greenness”, the vegetation 
index.

The method of principal components is based on the fact that multi-
zone images have a significant degree of correlations between zones. The 
core of the method is to transform the original multi-zone image by creating 
new zones – components, with practically no correlation between them. 
Image processing based on this method makes it possible to obtain the 
structurometric characteristics of the image, since it fi es the frequency 
of brightness features occurrence, which is directly related to their spatial 
distribution.
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Fig. 2.4. Vegetation index NDVI

Image filtering allows enhancing of reproduction of certain objects in 
the picture, suppress unwanted veiling and eliminate other random noise. 
One of the simplest filtering methods is the sliding window transform. With 
this transformation, the brightness values of all pixels in the image are 
recalculated. Recalculation occurs for each pixel in this way: when this pixel 
is the central one in the window that “moves” over the image, it is given a new 
value that is a function of the values surrounding it in the pixel window. The 
window size can be, for example, 3 × 3 or 5 × 5 pixels. Each time the window is 
shifted by 1 pixel and moves until the entire image is covered. For all the pixels 
of the window, weight coefficients are set based on the goals of interpretation.

2.3. Methods of Image Interpretation

After carrying out the necessary stages of processing of remote sensing 
data, GIS mapping of land resources is performed by means of image 
interpretation.

Image interpretation is a method of studying objects, phenomena and 
processes on the Earth’s surface, which consists of recognizing objects by their 
features, determining characteristics, establishing relationships with other 
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objects. Depending on the content, interpretation is divided into topographic 
and special (thematic, branch). During topographic interpretation, information 
is obtained from images about the Earth’s surface and objects located on it. 
During special interpretation, thematic information of agricultural, forestry, 
geological and other purposes is selected.

The process of interpretation begins with the formulation of a general 
problem. The task is set taking into account the real possibilities of obtaining 
survey materials, the availability of appropriate equipment, the qualification  
of interpreters, etc. The classes of land (types and subtypes of land of the 
GDB of the Local LIS of the Republic of Belarus) are identified by remote 
sensing data.

With any of the interpretation methods, a preparatory stage is 
obligatory. In the Republic of Belarus, when creating a GDB of a Local LIS, 
this stage includes preparatory work, processing of aerial or satellite imagery 
materials, and creation of a raster spatial basis.

As part of the preparatory work, they collect, study, determine the quality 
and possibility of use, the necessary preparation of the original cartographic, 
aerial and space survey and factographic materials and data to create a raster 
spatial basis for interpretation.

The following are used as the main cartographic materials and data 
in the creation of the GDB of a Local LIS in the Republic of Belarus: land 
management maps in 1 : 10,000 scale; land tenure maps of the district in 
1 : 50,000, 1 : 10,000 scales and/or settlements in 1 : 10,000, 1 : 2,000 scales; 
topographic maps and plans in 1 : 10,000, 1 : 5,000, 1 : 2,000, 1 : 1,000 and 
1 : 500; plans of the territory of horticultural associations on in 1 : 500–1 : 5,000 
scale and a number of additional materials.

The following are aerial and space imaging materials: digital AI, digital 
SI, digital orthophotomaps in 1 : 10,000 or 1 : 2,000 scales, materials of 
photogrammetric processing of aerial or space survey data.

As the main factual materials and data, the following are used: data 
on current accounting of the state and use of land; cases on establishing, 
restoring the boundaries of land plots; boundaries of land plots registered in 
USRRE; data of the unified register of ATU and TU of the Republic of Belarus; 
data of the register of names of streets and roads USRRE; materials on the 
transfer of land of rural settlements to the jurisdiction of rural (settlement) 
Councils of Deputies; data on the transfer of forests under the jurisdiction of 
forestry authorities; materials on the inventory of ameliorative systems; data 
on the establishment of water protection zones and coastal strips on rivers 
and reservoirs; materials schemes of land management of districts; data of 
cadastral valuation of land of settlements, etc.

The processing of aerial or space photography materials includes the 
sequential execution of several types of work. When used as a basis for 
interpretation of aerial photography materials, the following is performed: 
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aerial photography > measurement and calculation of the coordinates of 
photographing centers using satellite geodetic equipment > photolaboratory 
work > AI horizontal and vertical reference > adjustment of the coordinates 
of survey substantiation points and identification marks determined 
using satellite geodetic equipment > AI scanning and obtaining digital 
AI > photogrammetric work on orientation of digital AI, equalization of 
phototriangulation results and construction of a digital photogrammetric 
system project. Processing of space imagery materials includes the following 
types of works: the formation of a digital photogrammetric system project 
and loading digital SI into the project > plan-altitude reference of space 
images > photogrammetric work on external orientation of space images and 
equalization of phototriangulation results.

In the process of these works, digital photogrammetric systems of the 
Photomod (Rakurs, Russia) and photogrammetric scanners are used.

The raster spatial base is formed on the basis of scanned and 
georeferenced source cartographic materials, as well as digital orthophotomaps 
created in the environment and by means of digital photogrammetric systems 
and georeferenced.

There are three main ways of image interpretation: field  cameral and 
combined.

Field image interpretation consists of comparing the image in the 
shots with the terrain, as a result of which objects are identified and their 
properties are determined. Interpretation can be terrestrial or aerovisual, 
continuous or selective (route). In the field  remote sensing data is connected 
(orientated) to the terrain, and then the interpretation is carried out directly, 
which consists of identification of objects and their designation in the image. 
If there are objects that are not refle ted in RSD, then they are applied to 
images using receivers of satellite systems for determining coordinates or 
using the methods of alignments, soundings, linear resection, etc. The main 
advantages of this method are the highest completeness and reliability of 
the results; on the other hand, the disadvantage is that this method is highly 
laborious, as well as time- and money-consuming.

Cameral interpretation consists of the logical analysis of images using 
the entire complex of interpretation characteristics (visual-logical version) or 
standard images of typical areas interpreted in the field (re erence version), 
as well as involving special software (automated version) in the laboratory. 
The main advantages of this method are: saving time and money, comfortable 
working conditions, the use of various technical means of automation, the 
possibility of using auxiliary sources of information. However, when doing 
interpretation of objects in this way, errors are quite possible, and they 
will affect the reliability of interpretation and require field refinement of 
interpretation materials.
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Combined interpretation combines the processes and techniques of 
field and cameral methods. Its main advantages are high economic efficienc  
and reliability of the results obtained. It is the combined method that is used 
in interpretation the land in the Republic of Belarus.

At the first stage, in cameral conditions, the objects of the digital land 
cadastral plan  (map) (DLCP) are interpreted and digitized in stereo or 
monoscopic modes on a raster spatial basis created from aerial or space 
imagery. In addition, the formation of the plan (map) objects occurs on the 
basis of additional data (digitization of original cartographic materials, as 
a result of their construction from coordinate catalogues or other geodetic 
survey data, as a result of importing other information systems from the 
geodetic database). In cameral interpretation, the following procedure of 
digitizing features of the DLCP is applied:

• features of administrative-territorial division (first coordinated, then 
the rest) in the Admi layer;

• land plots (first coordinated, and then the rest; first of legal entities, 
then the rest) in the Lots 3 layer;

• water and hydrotechnical features (Land layer);
• features of the street-road network (Land layer);
• land within settlements (Land layer);
• reclaimed land;
• agricultural land (Land layer);
• forests and shrubs (Land layer);
• swamps and wetland (Land layer);
• other land (layer Land);
• fence layer features;
• features of other layers Comm, Obj, Serv, Melio.
The project of field work is formed in the process of cameral interpretation 

and digitization of objects of the DLCP. Uninterpreted polygonal and line 
objects of the DLCP are highlighted in red on the map, and uninterpreted 
point objects or undefined feature signatures are marked with red question 
marks. The results of cameral interpretation and digitization are printed out 
in the form of photographic maps and serve as the source material for field
interpretation. Photomaps display combined images: a digital orthomosaic 
(in the form of a halftone image), digitized DLCP objects in the form of 
simplified conventional signs and their captions (in the form of a line image, 
possibly with fill elements), marginal design elements. In addition to the 
field work project, a text document is formed, which should contain a list of 
questions for clarification in the process of field interpretation and references 
to the object numbers of the field ork project.

Based on the materials of the completed cameral interpretation, areas of 
continuous field interpretation, optimal routes for field control and survey 
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are outlined in such a way as to cover all objects that are not interpreted in 
cameral conditions and to ensure full control of cameral interpretation and, 
first of all  built-up areas.

At the second stage, fiel  interpretation is carried out. Here all objects 
that have not been interpreted in cameral conditions are examined and 
plotted on the photographic map; then comes connecting the objects that 
are not displayed on aerial photographs (space images) and plotted on the 
photographic map in the course of field work, to the objects digitized in 
the process of cameral interpretation; control of the results of the cameral 
interpretation in the process of moving along the routes and correction 
of the identified errors in the cameral interpretation is carried out; the 
objects lost by the time of field work are marked on photographic maps (by 
means of crossing out); then instrumental determinations of the numerical 
characteristics of new objects and the objects, about which information is 
absent in the preparatory work materials.

At the third stage, in cameral conditions, digitization and editing of 
the objects of the DLCP, identified and refined as a result of the fiel  
interpretation, as well as control printing, topological and editorial 
verification of the obje ts and layers of the DLCP, are carried out.

The methods of interpretation RSD, with all their diversity, come 
down to two main ones: visual and automated. With visual interpretation, 
information from images is read and analyzed by a human. Automated 
classification is carried out completely via special software. A human 
determines the tasks and sets the algorithm of processing RSD.

It should be noted that in the case of computer processing of RSD, the 
analysis of the image is carried out according to formal features; therefore, 
the results obtained are devoid of subjectivity. However, experiments to assess 
the reliability of computer classification show that the number of correctly 
identified objects is 60–80 %. The result is the better, the more different in 
the optical properties of objects are. A certain subjectivity of the results of 
visual interpretation is not always negative, being similar to the subjectivity 
of the map. Thus, the comparison of visual and automated interpretation 
methods shows that both of them have their advantages and disadvantages, 
therefore, depending on the task, either preference is given to one of them 
or both are used simultaneously.

2.4. Visual Interpretation of Land Resources

Visual interpretation in the GIS environment involves interpretation 
and digitization of land fund objects by a interpreter in stereo or monoscopic 
modes based on aerial or space imagery in raster form. Successful 
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interpretation depends not only on the quality of the materials used, but 
also on the interpreter, the special features of its visual and logical perception. 
The process of visual analysis of an image is usually divided into three stages: 
detection, recognition, and interpretation. The latter presupposes revealing 
the essence of the object, attributing it to some category provided for by the 
legend of the DLCP or previously known to the interpreter, i.e. associated 
with logical understanding. The first two stages represent special features 
of visual perception (perception of brightness, color, size and volume). 
Interpretation and digitization in the stereoscopic mode is carried out using 
special digital photogrammetric systems, in the monoscopic mode – in any 
of the instrumental GIS.

During visual interpretation the interpreter relies on the diagnostic 
apparatus which includes interpretational characteristics – the properties 
of objects which are directly reflected in the image and used to recognize 
these objects.

It is customary to subdivide interpretation characteristics into direct – 
the properties of objects which are directly displayed on the image, and 
indirect or indicative – interconnections and interdependence of natural 
and artificial objects that characterize the object of interpretation indirectly, 
through any direct interpretational feature of other natural or anthropogenic 
objects or their complex.

Direct interpretational characteristics are usually divided into three 
groups:

1) geometric (form, shadow, size);
2) brightness (tone, brightness level, color, spectral representation);
3) structural (texture, structure, pattern).
The form is a sufficient feature to the separate the objects of natural and 

artificial origin. Artificial objects usually possess correct configuration  For 
objects of natural origin, irregular, often complex shape is typical.

The shadow allows you to judge about the spatial shape of objects. There 
is own shadow (part of an object not illuminated by direct sunlight) and 
drop shadow (shadow from an object on the Earth’s surface or the surface 
of other objects). Own shadow allows you to judge about the surfaces of 
objects possessing a three-dimensional shape, the drop shadow determines 
the vertical extent, the silhouette of the object.

In most cases the size during interpretation is estimated relatively. By 
size, it is possible to identify the class of roads, the size of buildings, forest 
and tree-shrub vegetation, etc.

A tone is the optical density of an image in black and white images. This 
characteristic is a function of the integral or zonal brightness of an object. 
A tone is assessed visually by attributing the image to a certain step of the 
non-standardized achromatic scale (white, almost white, light grey, grey, dark 
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grey, almost black, black). The number of steps is determined by the threshold 
of light sensitivity of the visual apparatus of the interpreter. This feature is 
not informative enough, since objects that are completely different in color 
can be displayed in a black and white image in the same tone.

In a digital image, the integral or zonal brightness of an object is encoded 
in the brightness levels of a grey scale (from 0 to 255 shades of grey).

A color is a more informative interpretational characteristic than the 
tone of a black and white image. In color images, differences in the spectral 
brightness of objects are transmitted precisely by this characteristic. It should 
be noted that the color sensitivity of the human eye is much higher than the 
achromatic one.

In multi-zone images, differences in the spectral brightness of objects 
are displayed as a set of tones or brightness levels in zones and are called 
spectral representation.

A texture is the character of optical density distribution over the image 
field of an object. Through the texture, the structural characteristics of the 
object are transmitted – the shape, size and relative position of the elements 
that make up the object or the elements that form its surface and their 
brightness. While visual interpretation, the texture is described by one or two 
adjectives, for example, grainy, spotty, striped, reticulated. A regular texture 
is typical of objects associated with human activity; an irregular texture is 
typical of natural formations. Texture is one of the most informative features. 
It is by texture that forests, gardens, settlements and many other objects 
are unmistakably identified  Structural characteristics are often divided 
into texture, structure, and pattern. This gradation is rather conditional; 
it is related to the size of textural characteristics and varies depending 
on the scale.

Indirect interpretational characteristics are divided into natural, 
artificial and natural-artificial  Natural (landscape) ones include interrelations 
and interdependence of objects and phenomena in nature. For example, 
dependence of the type of vegetation cover on the type of soil. With the help 
of artificia  characteristics, objects created by man are identified  In this case, 
functional links between objects, their position in the general complex of 
structures, zonal specifics of the organization of the territory, communication 
support are used. For example, a livestock farm of an agricultural enterprise 
can be identified by the totality of the main and auxiliary buildings, the 
internal planning of the territory, intensively carved runs, and the road 
network character. Natural-artifi ial ones include: dependence of human 
economic activity on certain natural conditions, manifestation of properties of 
natural objects in human activity, etc. Example: according to the placement of 
certain types of crops, one can make a certain judgment about the properties 
of the soil.
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It should be noted that interpretational characteristics are usually used 
collectively, without subdivision into any groups. The image in the iterprited 
area is perceived by the interpreter as a single whole – as a terrain model.

In the Republic of Belarus, visual image interpretation is the predominant 
method of GIS mapping of the land. In most cases, black-and-white digital 
orthomosaics are used as the initial data. interpretation is carried out in the 
context of land classes (types and subtypes of land of the GDB of the Local 
LIS of the Republic of Belarus).

Arable land in the image are characterized by the clarity of their 
boundaries, determined by the “geometry” of the shape (fig  2.5). The tone 
of the image of land plots occupied by arable land is predominantly light, but 
it cannot be a sufficiently reliable independent eature. Even in one and the 
same shot, the tone of different areas of arable land may change, which is 
associated with different species composition of crops and the peculiarity of 
their display on RSD, as well as the season of surveying. The informativity of 
the color of an arable land image is much higher. The characteristic striated 
texture of arable land is caused the presence of various crops or different 
plowing times. However, it is unstable over time. The most probable errors 
in interpretation of arable land are attributing some contours of arable land 
to fallow land and vice versa, as well as the attributing grassland plowed for 
the purpose of their radical cultivation to arable land.

Fig. 2.5. Image of arable land

The interpretational characteristics of fallow land and arable land 
are very close. Borders and traces of tillage and, accordingly, the striated 
texture of the image are preserved for many years. However, over time, there 
appear signs of the termination of cultivation – local fuzziness of the texture, 
appearance of spots (grains) showing weeds and wood vegetation (fig  2.6). 
An indirect sign of a fallow is the confinement of land to ravine and gully 
relief elements.
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The main interpretational characteristic of land under permanent crops 
is the grid or striated texture of the image (fig  2.7). If there is information 
about the types of plantations found in the area of interpretation, the 
reliability of recognition of this land increases.

Fig. 2.6. Image of fallow land

Fig. 2.7. Image of land under permanent crops

The shape and size of the plots occupied by grassland are uncertain, 
since their boundaries are the boundaries of arable land, fallow land, forests, 
as well as topographical elements of the terrain. The texture of the image 
changes depending on the qualitative characteristics of meadows. An even 
and uniform tone of meadow vegetation, depending on the lighting conditions 
during aerial photography and the degree of moisture, can vary from light to 
dark grey (fig  2.8). When interpretation grassland, indirect interpretational 
characteristics play an important role. Thus, grassland used for hayfields are 
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marked by confinement to certain natural complexes, a lack of possibility 
to drive cattle to the plot and, in general, absence of signs of its systematic 
grazing. On the contrary, meadow land used for pastures are determined by 
their position in relation to settlements and, in particular, to cattle yards, 
with the establishment of possibility to drive cattle to the pasture plot, the 
presence of many paths carved by cattle, trampled at watering and stopping 
places, the presence of special structures (pens, sheds, etc.).

Fig. 2.8. Image of grassland

The main interpretational characteristic of woodland and scrubland is 
the distinctive irregular texture of image, which is expressed in irregularly 
shaped granularity created by the alternation of rounded spots (projections 
of tree crowns) and gaps of differing contours between them, partially or 
completely taken by dark spots of shadows cast by trees. With stereoscopic 
viewing, the height of the trees is perceived quite distinctly. The size and 
shape of the grains depend on the size and structure of the crowns of trees 
on location, as well as on the forest density. Apart from the picture, taking 
into account the tone of the photographic image is also helpful. As a rule, 
coniferous forests are characterized by darker tones than deciduous ones. 
Great opportunities for recognizing the composition of plantings are provided 
by using multi-zonal satellite images.

According to the character of the texture and the height of plantations, 
determined by their shadows, one can quite reliably distinguish mature 
forests, natural forest verdure, young plantings, woodland, shrubs (fig  2.9, 
2.10). Solid thickets of shrubs are characterized in the images by fine-grained, 
sometimes somewhat “smeared” structure of the image, grey and dark grey 
tone, small drop shadows, and usually rounded or scalloped contours. Shrub 
thickets differ from forest verdure by a more even tone, due to their uniform 
composition.
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Fig. 2.9. Image of woodland

Fig. 2.10. Image of scrubland

Forest belts and protective forest plantations are reliably recognized by 
direct interpretational characteristics. Burnt areas have a spotted pattern 
of a light tone and torn borders fringed by a strip of forest, usually sparse. 
Among burnt areas, individual trees and small areas of growing forest are 
often noticeable. On littered burnt areas, fallen trees in the form of white 
strokes and dead trees, distinguishable by sparse light crowns, are clearly 
visible. Clearings are identified by their light tone and the regular shape of 
their areas.

The main interpretational characteristic of swampland is the image 
texture (fig. 2.11). Depending on the type of swamps, their shrub (forest) 
density, passability and other characteristics, the texture is very diverse 
and heterogeneous. But in most cases it is quite specific  Treeless swamps 
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are distinguished by grey tones; they are characterized by smooth, soft 
contours with single trees or dark spots of wetland. Indirect interpretational 
characteristics of swampland are their confinement to vast fla -horizontal 
areas of the terrain, absence of traces of agricultural work, presence of country 
and field ypass roads, as well as of peat extraction areas.

Land under water objects are interpreted with a high degree of 
reliability in black and white and, especially, in color AI according to direct 
interpretational characteristics. Water spaces have dark tones in black and 
white shots. The tone of a hydrographic image is influen ed by such factors 
as optical conditions of aerial photography, depth, bottom color, purity and 
transparency of water, its color, waves, and the presence of aquatic vegetation 
(fig  2.12). Typically, as the depth increases, or in silty, clayey, or peaty soils, 
the tone of the image becomes darker. Small rivers and lakes with a sandy or 
rocky bottom are predominantly light in color in aerial images. Turbid and 
foamy water also gives a lighter tone to the image.

Fig. 2.11. Image of swampland

Fig. 2.12. Image of land under water objects
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The shape of the land occupied by water objects makes it possible to 
judge about their natural or artificial origin. The coastline of reservoirs and 
ponds over a long distance does not differ from the coast of natural water 
bodies, but there is always a straight section – a dam (weir), by which they 
can be distinguished from lakes. Ameliorative canals and ditches belong to 
the category of contrasting objects; therefore, even with a small width, they 
are well interpreted by their characteristic rectilinear shape and the dark 
tone of the image. It is difficult to interpret small rivers and streams hidden 
under the canopy of a forest or shrub. This can be done only after a careful 
stereoscopic examination of the image.

If the survey was not made during the period when the water level is 
averagely stable (summer period), it is necessary to use auxiliary materials 
to interpret the coastline; those are large-scale topographic maps, since the 
coastline is plotted on them instrumentally.

Land under roads and other transport communications have specific 
direct interpretational characteristics – on ordinary black and white AP they 
are displayed as light lines (stripes) (fi . 2.13). On wet sections of unpaved 
roads, the tone of their image may be darker. Indirect interpretational 
characteristics of roads are their position on location, their connection 
with other topographic objects, the presence of structures serving roads, 
the character of their intersection with other objects, and the location of 
associated tree and shrub vegetation. Bridges and overpasses are interpreted 
by direct characteristics.

Fig. 2.13. Image of land under roads 
 and other transport communications

Waysides and railway tracks are well distinguished in the AP. Waysides 
bordering forests, arable land and other land on both sides of a road, are 
usually covered with grassy vegetation and are characterized by an even 
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grey tone. Railway sections of significant length are straight, and their turns 
are smooth, rounded. Absence of sharp turns, as well as presence of a large 
number of embankments and cuttings makes it easy to distinguish railways 
from highways in aerial photographs. In addition, stations, booths, which are 
located in the waysides next to the roadbed, are a reliable interpretational 
characteristic of railways.

Highways differ from railways by sharper turns, and in some places, by 
a noticeable steepness of ascents and descents. There are relatively fewer 
embankments and cuttings on motor roads, and their waysides are usually 
narrower than those of railways. Other roads approach motor roads from 
different directions.

The specifici y of interpretational characteristics of land under 
streets and other public places, as well as building land eliminates the 
possibility of confusing them with other objects (fig  2.14). Elements of a 
settlement – building lanes, homestead land, streets, squares, driveways – 
are easily identified by cameral and especially stereoscopic observation. 
Most artificial objects are identified with a high degree of reliability using 
indirect caracteristics, for example, by their location in a populated area, by 
the functional conditionality of the elements of a complex of structures, by 
the image of cars, barrels and other objects in the territory of the interpreted 
object.

Fig. 2.14. Image of land under streets  
and other common areas, as well as building land
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Fig. 2.15. Image of disturbed,  
unused and other land

Disturbed, unused and other land have their own specific direct (shape, 
size, tone, texture, etc.) and indirect (their certain territorial confinement  
natural and climatic conditions, etc.) characteristics (fig  2.15). The reliability 
of cameral recognition of such land is often low. Some land belonging to these 
species are identified in stereos opic mode.

2.5. Automated Land Classification

The automated image classificatio  is based on the classifi ation of 
objects. In this case, it is assumed that each pixel of a multi-zone image 
corresponds to a set of values of spectral features or a vector in the spectral 
space, whose dimension is equal to the number of image zones. Thus the 
classification process is reduced to a distribution of all elements of the 
raster into classes in accordance with refle tivity (the value of the spectral 
brightness) of each object in one or several zones of the spectrum.

The automated classification is divided into two main types: classificatio  
with training and classification without training

Classification with training (supervised classification  is a process 
where the brightness value of each pixel is compared with references, which 
results in each pixel being attributed to the most appropriate class of objects. 
This kind of classification is applicable if it is known beforehand which objects 
are refle ted in the image, or there is a small number (up to 30) of object 
classes and these classes are clearly distinguishable.

In controlled classification  the rules for the transition from spectral 
brightness indices to object classes are developed by creating signatures – 
image fragments that unambiguously refer to a certain class of objects, and 
then automatically apply them to the rest of the image. The sources by which 
the references are selected can be materials of specially conducted field work, 
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cartographic materials, interpreted images. All class reference images can be 
concentrated in one area or scattered throughout the image.

Supervised classification is carried out through algorithms using different 
methods of accounting the spectral characteristics of signatures.

The minimum distance classifi ation method makes it possible to 
attribute classified objects to a certain class by calculating the Euclidean 
distance in the feature space between the tested and the reference pixels and 
attributing each pixel to the class in which this distance to the reference is 
minimal. The method is expedient to use when the number of classes in the 
training set is limited. The disadvantage of the method is that its application 
does not take into account the distribution (dispersion) of the brightness 
value of pixels in the signatures.

The parallelepiped method implements an algorithm in which closed 
rectangular areas are selected in the feature space, whose boundaries 
are set depending on the choice of characteristic ranges according to the 
histograms of the brightness distribution of reference objects in two, three 
or more zones of the spectrum, and then each pixel of the image is attributed 
to the class in whose parallelepiped it falls by its brightness values. The 
advantage of this method is a simple and fast calculation, the disadvantage 
is frequent overlapping of parallelepipeds, which causes uncertainty in the 
classification

The maximum likelihood method calculates the probability with 
which a given pixel refers to a certain class. The number and the parameters 
of classes are set by the user by specifying training samples. Each pixel 
refers to the class to which it is most likely to belong. When calculating the 
probability, the brightness of a pixel and the brightness of its surrounding 
pixels are taken into account. It should be noted that this method is used in 
practice most frequently (fig  2.16).

Classification without training (unsupervised classification) is a 
process in which the distribution of image pixels occurs automatically, 
based on the analysis of statistical distribution of pixel brightness. Note 
that before starting this kind of classification  the interpreter often does 
not know how many and which objects are displayed in the image. After the 
classification  it is necessary to interpret the resulting classes in order to 
determine which objects they correspond to. Classification without training 
is implemented if it is not known beforehand which objects are refle ted 
in the image, and there is a large number of object classes (more than 30) 
with complex boundaries. It can also be used as a preliminary step before 
supervised classification

The most common classification methods without training are ISODATA 
and K-Means.



Fig. 2.16. Result of classification with training  
(maximum likelihood method) of the classes of land of the Kletsk 

district of the Minsk region
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The ISODATA method (Iterative Self-Organizing Data Analysis Technique) 
is based on cluster analysis. One class includes pixels with brightness values 
the closest in the space of spectral features.

The K-Means method differs from the ISODATA method in that it 
requires initial setting a certain number of average values to form the initial 
classes, therefore, this method is used when the objects in the image are 
quite distinct.

The result of classification (both with and without training) is a raster 
image, where each of the pixels is attributed to a certain class. Such rasters 
often require subsequent class merging and filtering  These procedures allow 
us to perform cartographic generalization and improve the classifica ion raster 
significantl . In addition, using the standard procedures for converting a raster 
to a vector in a GIS, specialist can operate with the classification result in a 
vector form.

After the classification process is over, it is necessary to evaluate the 
reliability of the obtained results. Classifi ation reliability is assessed visually 
or quantitatively (i.e., control areas of the classified image are compared 
with maps, large-scale images, literature data). In quantitative assessment, 
a matrix of errors is compiled. It can be used to judge about the reliability 
of each particular object (class) and the reliability of the classificatio  
in general. Reliability assessment is also carried out for visual image 
interpretation.

The use of algorithms for automated classification of multi-zone SI for 
GIS-mapping of land resources in the Republic of Belarus is currently in 
the making. The main problems hindering the development of this area of 
geoinformation mapping today are high cost of obtaining high-resolution 
multi-zone SI, a lack of clearly defined classification units for interpretation. 
And while the first problem is solved with the commissioning of the Belarusian 
space monitoring system, the second problem requires close attention.

Mapping the land fund in the context of classes, and even more so of types 
and subtypes of land in the GDB of the Local LIS causes great difficulties for 
automated classification  Many classes (types, subtypes) cannot be correctly 
classify by this method. In addition, the spatial resolution of RSD comes 
to the forefront. It is often not enough to classify land resources correctly. 
In addition, nowadays there is still an open question of choosing the optimal 
software, classification methods and algorithms, as well as training specialists 
in such methods.

One example of a successful project of land resources classification is 
the CORINE (Coordination of information on the environment) program 
initiated by the European Commission in 1985. This program allowed to 
combine the efforts of scientists and specialists from Western European 
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countries to collect, unify and coordinate geospatial and thematic information 
on the condition of land, vegetation and water bodies, distribution of 
natural resources, level of urbanization, etc., as well as development of new 
approaches to obtaining and processing data in order to improve the efficienc  
of management decisions.

The CORINE program widely uses methods of remote monitoring of the 
Earth. By the beginning of the 1990s, digital maps of land covers had been 
compiled for several countries of Western Europe in 1:100,000 scale using 
the materials of aerospace surveys from the Landsat and SPOT satellites. The 
important result of the CORINE programme was the creation of a unifie  
nomenclature of land covers for the territory of Europe (CORINE Land Cover 
Classification System). This is a multi-level classification scheme with 
objects divided into 5 classes on the 1st level, 15 classes on the 2nd level, and 
44 classes on the 3rd level. The nomenclature of land cover classes with its 
levelization, developed jointly by European countries in the CORINE LCC 
system, is presented in table 2.1. It should be emphasized that the CORINE 
LCC classification scheme allows, if necessary, further refinement in the form 
of increasing additional levels.

Table 2.1
Earth cover classes according  

to the CORINE LCC nomenclature

Level 1 Level 2 Level 3

1.
 A

rt
if

ic
ia

l s
ur

fa
es

1.1. Urban fabric 1.1.1. Continuous urban fabric (residential, build-up, 
artificial

1.1.2. Discontinuous urban fabric (residential, build-
up, artificial

1.2. Industrial, 
commercial and 
transport units

1.2.1. Industrial or commercial units (industrial; 
retail)

1.2.2. Road and rail networks and associated land
(road and rail landuse)

1.2.3. Port areas (harbour)

1.2.4. Airports (aerodrome)

1.3. Mine, dump 
and construction 
sites 

1.3.1. Mineral extraction sites (quarry)

1.3.2. Dump sites (landfill

1.3.3. Construction sites (construction)

1.4. Artificial,
non-agricultural 
vegetated areas

1.4.1. Green urban areas

1.4.2. Sport and leisure facilities
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Level 1 Level 2 Level 3
2.

 A
gr

ic
ul

tu
ra

l a
re

as
2.1. Arable land 2.1.1. Non-irrigated arable land (farmland, cropland)

2.1.2. Permanently irrigated land (farmland, 
cropland)
2.1.3. Rice field

2.2. Permanent 
crops

2.2.1. Vineyards
2.2.2. Fruit trees and berry plantations (orchard)
2.2.3. Olive groves

2.3. Pastures 2.3.1. Pastures (meadow)
2.4. Heterogeneous 
agricultural areas

2.4.1. Annual crops associated with permanent crops 
2.4.2. Complex cultivation patterns
2.4.3. Land principally occupied by agriculture, with 
significant areas of natural egetation
2.4.4. Agro-forestry areas

3.
 F

or
es

t a
nd

 s
em

in
at

ur
al

 a
re

as

3.1. Forests 3.1.1. Broad-leaved forest
3.1.2. Coniferous forest
3.1.3. Mixed forest

3.2. Scrub and/
or herbaceous 
vegetation 
associations

3.2.1. Natural grassland
3.2.2. Moors and heathland
3.2.3. Sclerophyllous vegetation (scrub)
3.2.4. Transitional woodland-shrub

3.3. Open spaces 
with little or no 
vegetation

3.3.1. Beaches, dunes, sands
3.3.2. Bare rocks
3.3.3. Sparsely vegetated areas (scrub)
3.3.4. Burnt areas
3.3.5. Glaciers and perpetual snow

4.
 W

et
la

nd

4.1. Inland 
wetland

4.1.1. Inland wetland (marsh)
4.1.2. Peat bogs (bog)

4.2. Maritime 
wetland

4.2.1. Salt marshes
4.2.2. Salines(salt_pond)
4.2.3. Intertidal flat

5.
 W

at
er

 b
od

ie
s 5.1. Inland waters 5.1.1. Water courses

5.1.2. Water bodies
5.2. Marine waters 5.2.1. Coastal lagoons

5.2.2. Estuaries
5.2.3. Sea and ocean

End of the table 2.1



The land cover information collected by the beginning of the 1990s, 
systematized in accordance with the CORINE LCC nomenclature and 
supplemented by the data from ground based observations and measurements, 
formed the contents of the CLC1990 database.

In subsequent years, other countries gradually joined the CORINE project 
(by 2000, their number in the project had reached 29), with the catalogue of 
the CLC1990 database replenished accordingly. From 2000 to 2005 by the 
initiative and support of the European Environment Agency (EEA), a large 
amount of work was carried out to improve the quality (correction) of the 
CLC1990 database contents and to update it using orthorectified materials 
of actual satellite images from the Landsat-7 spacecraft; also, technical 
requirements for the results of object classification in space images were 
formulated.

Surveys provided almost complete (without gaps) coverage of the 
entire territory of the European continent with shots, after which they were 
interpreted automatically. This made it possible not only to form a refined
and detailed map of land cover, but also to solve an urgent and important 
problem of identification and assessment of temporary changes in the natural 
environment of Europe. The updated database was named CLC2000, and 32 
countries took part in its compilation. The CLC1990, CLC2000 databases are 
available via the portal of the European Environment Agency. In addition, 
this site provides access to the CLC2006 database, which refle ts the changes 
that took place from 2005 to 2010. At present, 37 European countries are 
participating in the project.

Questions for self-assessment

1. What is remote sensing? How are RSD classified
2. What is digital image? Which spatial data model does a GIS use to store digital 

images?
3. Enumerate the main stages of preliminary processing of RSD. Reveal the essence 

of each stage.
4. What is the principle of color image synthesis? What combinations are most 

common?
5. Outline the main ways and methods of image interpretation.
6. Enumerate and characterize the direct and indirect interpretational characteristics 

used in image interpretation.
7. Outline the main features of visual interpretation of land resources.
8. What is the essence of automated RSD classification? What are the types of 

classifications? What are their similarities and dif erences?
9. Which algorithms are used to implement the classification with training?

10. In what way is the reliability of image classification results valuated?
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3. LAND RESOURCE MANAGEMENT BASED  
ON GEODETIC SURVEYS AND GLOBAL NAVIGATION 

SATELLITE SYSTEMS

3.1. Technology and Methodology  
of Geodetic Surveys

The main topographic and geodetic works for GIS mapping of land are 
surveys for establishment (restoration) of boundaries of land plots.

According to Art. 1 of the Code of the Republic of Belarus on Land, the 
boundary of a land plot is a conditional line on the surface of the Earth and 
a conventional vertical plane along this line, separating the land plot from 
other land, land plots. According to Art. 11 of the Code, the boundary of 
a land plot is established (restored) on location with fixing of its turning 
points by landmarks in accordance with the decision on withdrawal and 
allotment of a land plot (fi ed boundary). It can also be established (restored) 
according to planned and cartographic materials with an accuracy determined 
by their scale, without fixing its turning points with landmarks on location 
in accordance with the decision on withdrawal and allotment of a land plot 
(unfi ed boundary, fig  3.1).

Fig. 3.1. Unfi ed boundary of a land plot  
of a state forestry institution
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Works to establish the boundaries of land plots complete the process 
of land acquisition and are carried out in order to determine on location 
(in place) the exact geometric dimensions and position of the boundaries 
of land plots allotted on the basis of the decisions of the President of the 
Republic of Belarus, the Council of Ministers of the Republic of Belarus, 
appropriate executive and administrative bodies in accordance with the 
procedure established by the legislation of the Republic of Belarus, and for 
the preparation of documents certifying the titles to land plots. Establishment 
of boundaries of land plots is carried out in cases of formation, in accordance 
with the established procedure, of new, as well as reorganization or 
streamlining of existing land holdings and land uses.

Restoration of boundaries of land plots is carried out in case of 
complete or partial loss of landmarks and signs of boundary lines on location, 
at the request of land users, landowners, owners and tenants of land plots, as 
well as in resolving land disputes between adjacent land users, landowners, 
owners and tenants of land. In these cases, the boundaries of a specifi  
land tenure are subject to restoration and fixing with new landmarks of the 
established form instead of the lost and worn-out ones.

Measures to establish and restore the boundaries of land plots should 
ensure the indisputable determination on location of the boundaries of land 
plots (landmarks and boundary lines); accounting of land with the necessary 
and sufficient accuracy; the possibility of indisputable restoration of the 
boundaries of land tenure in the event of loss (destruction) of landmarks 
and boundary lines; subsequent state control over the targeted and rational 
use of the allotted land plots; reliability of calculation of payments for land; 
correct legal and technical registration of the boundaries of land plots for 
state registration and protection of the titles to land plots of land users, land 
owners, owners and tenants of land plots.

The establishment and restoration of the boundaries of land plots can 
be carried out by geodetic methods uses the different ways of defi ing 
coordinates known in geodetic practice.

Works on establishing and restoring the boundaries of land plots in the 
territory of the Republic of Belarus are carried out in the unified state system 
of geodetic coordinates of 1995. In settlements, these works can be carried 
out in the local coordinate systems adopted earlier.

The geodetic basis for the work on establishing and restoring the boundaries 
of land plots are the points of the state geodetic network (points of state 
triangulation and polygonometry) of the 1st, 2nd, 3rd and 4th classes, the points 
of satellite coordinate determination, the points of concentration networks of 
the 1st and 2nd categories and the points of a geodetic substantiation survey. 
In addition, it is allowed to use as initial data previously installed on location 
and coordinated landmarks, corners of permanent structures, fences, manholes, 
etc., as well as the remaining points of the planned binding of AI and SI.
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3.2. Stages of Carrying Out Activities  
to Establish and Restore Boundaries of Land Plots

The main stages of carrying out activities to establish and restore the 
boundaries of land plots are: 1) preparatory work; 2) field work; 3) cameral work.

At the stage of preparatory work, the collection, systematization, studying 
of documents and materials on the basis of which the land plot is allotted are 
carried out. After studying the available documents and materials, the possibilities 
of using various methods of transferring the boundaries of the land plot to the 
terrain are determined, the location of landmarks, the laying of theodolite 
passages and ways of connecting them with points of the geodetic network are 
outlined. Based on the available land cadastral materials (LIS, land allotment 
project, large-scale plans, topographic plans), a layout drawing of establishing or 
restoring the boundaries of the allotted land plot on location is prepared (fig  3.2).

A layout drawing displays: 1) the boundaries of the allotted land plot; 2) the 
turning points of the boundaries of the land plot, fi ed and previously fi ed by 
landmarks; 3) the numbers of turning points of the boundaries of the land plot; 
4) the points of geodetic networks used for connection with fi ed landmarks of 
the boundaries of the land plot; 5) the schemes of designed traverses, as well as 
other geodetic constructions in order to connect the boundaries of the land plot 
with the points of the geodetic network; 6) geodetic data (angles and lengths of 
lines) necessary to establish the turning points of the boundaries of the land plot; 
7) the corners of capital buildings, as well as other fi ed points of the situation 
used to determine the location and connection with them of the installed 
landmarks; 8) additional geodetic data (angular and linear), as well as coordinates 
(in the local system) of the starting points or increments of coordinates between 
them, necessary for transferring the project of a land plot allotment to the area;  
9) adjacent land plots and plots of other (outside) land users, land owners, 
owners, tenants of land plots, indicating their last names or surnames, firs  
names and patronymics; 10) the legend; 11) stamp of the organization. In the 
case of establishing and restoring the boundaries of the allotted land plots 
within their actual boundaries, making of the layout drawing may be omitted.

Field works to establish, restore and fix on location the boundaries of 
an allotted land plot using a geodetic method include: 1) reconnaissance of 
the plot; 2) transfer to the locality of the boundaries of the allotted land plot; 
3) fixing the turning points of the boundary of the allotted land plot with 
landmarks; 4) cutting clearings, in accordance with the established procedure, 
in forested and bushy areas, providing mutual visibility of adjacent landmarks; 
5) carrying out the necessary geodetic measurements in order to determine 
the coordinates of the installed landmarks and to link them with the solid 
contours of the terrain; 6) familiarization on location of interested parties 
or their representatives with the established boundaries of the land plot; 
7) carrying out control measurements and determinations.
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Fig. 3.2. A layout drawing

Fixing of the turning points of the boundaries of the allotted land plot 
transferred to the terrain is carried out by landmarks of the established form. 
After installing or restoring the landmarks, the angles and lines are measured, 
as well as the coordinates of these marks are determined in the state or local 
system of geodetic coordinates. When measuring angles and lines with geodetic 
instruments without electronic memory, a field log and an outline are kept. If 
electronic theodolites and tacheometres with memory are used, then only the 
outline is kept.

Installed and coordinated landmarks must allow indisputable identificatio  
of their location on location, restoration and use to establish the boundaries 
of adjacent land tenures. Therefore they are subject to connection (binding) 
by measuring linear segments with the corners of capital buildings, small 
architectural forms, with the centers of manholes of manholes, poles of power 
transmission and communication lines, free standing trees and other solid 
contour points of the terrain. Based on the measurements obtained, a scheme 
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of connection (referencing) of landmarks with objects and terrain contours is 
drawn up (fig  3.3). If there are no objects and contours on location to connect 
the landmark installation, it is allowed to issue a description of the location of 
the landmark or the location of the boundary of the land plot in the form of a 
separate document.

Fig. 3.3. Scheme of connection (referencing)  
of landmarks with objects and terrain contours

The establishment, restoration and fixing of the boundaries of the allotted 
land plot on location is carried out in the presence of the person to whom the 
land plot is allotted, the land user, land owner, owner, tenant of the land plot, 
from whose land this land plot is withdrawn, and, if necessary, adjacent land 
users, landowners, owners, tenants of land plots; then an act on familiarization 
of the interested parties on location with the established (restored) boundaries 
of the land plot is drawn up.

The restoration of the boundaries of a land plot consists of finding the 
position of the lost landmark on location and fixing of the found position with 
a new landmark. The technical basis is provided by geodetic data obtained as 
a result of establishing the boundaries of this section in previous years, the 
outlines of landmarks and the layout drawing.

The simplest way to restore the boundaries is to determine the location of 
the landmark visually, as well as to take control measurements of the lengths of 
the lines between visually found landmarks; to measure the length of the line on 
the plan and on location between the found landmark and the contour point of 



61

the situation; to measure the lengths of lines when finding the position of the 
lost landmark along the alignment between the contour points, perpendicular 
to the alignment, and other ways. In more difficult conditions, in the presence 
of geodetic data along the boundary of the land plot, the search for the position 
of the lost landmarks is carried out using the polar method. In the absence of 
geodetic data along the boundary of the land plot, they are calculated from 
the known coordinates of the starting points of the state geodetic network and 
concentration networks and the graphic coordinates of the landmark being 
sought by solving inverse geodetic problems with control.

At the stage of cameral work after completion of field work to establish 
and restore the boundaries of the allotted land plot and measure them, it is 
necessary to draw up a scheme of connection (referencing) the boundaries 
of the land plot with the points of the state geodetic network, networks of 
thickening with nodal landmarks, the position of which is determined by 
satellite or other methods, marks of geodetic networks in settlements (fig  3.4).

Fig. 3.4. Scheme of connection (referencing) of the boundaries  
of the land plot with the points of the state geodetic network
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The processing of field measurements, calculation of coordinates of the 
landmarks installed, restored on location along the boundary of the allotted 
land plot, compilation of catalogues of coordinates and calculation of the 
area of this land plot are performed using personal computers in packages 
for processing field geodetic observations (for example, aGeodesy Suite and 
tGeodesy Suite (BelNICzem, Belarus), Trimble Geomatics Offi e (Trimble, USA), 
CREDO_DAT and CREDO TOPOPLAN (Credo-Dialog, Belarus). In addition to 
the listed software packages, these types of work can also be performed in 
GIS, for example, ArcGIS (Survey Analyst module).

The calculation of coordinates is preceded by equalization of measurement 
results. Accuracy assessment of measurement results functions (direction 
angles, coordinates, areas) based on equalization materials is performed in 
the process of equalization calculations. The average measurement results 
and their equalized values with accuracy assessment, as well as all problems 
solution, are printed out and attached to the case materials for establishing 
(restoring) the boundaries of the allotted land plot. After completing 
equalization calculations, a catalogue of the coordinates of the turning points 
of the boundaries of the land plot is compiled (fig  3.5).

By the obtained coordinates the total area within the established 
(restored) boundaries is calculated and a plan of the boundaries of the land 
plot is drawn up (fig  3.6). The scale of the plan of the boundaries of the land 
plot is selected depending on its size and configuration in such a way that the 
plan can show all the turning points of the boundaries of this land plot and 
interspersed (outside) plots of other land tenures. The latter are allowed to 
be taken out of the general plan of the boundaries of the main land plot to a 
free place using a larger scale.

local coordinate system

№
in 

catalogue

Turning 
point 

number

Type of fixing
of the boundary 
turning points

Coordinates, m Direction 
angles, °, ′

Distances, 
mX Y

1 1 fence corner 3393,05 12134,67 278°26,18′ 34,53
2 2 fence corner 3387,98 12156,21 15°12,0′ 35,12
3 3 landmark 3353,39 12136,05 105°55,02′ 21,19
4 4 landmark 3367,75 12167,12 195°03,00′ 16,54

Plot area     813 m2  (0.0813 ha)
Polygon perimeter   27.98 m
Plot area RMS   0.1 m2   1 : 450
Permissible square discrepancy   0.00001 ha

Fig. 3.5. Example of compiling a catalogue of coordinates of turning 
points of a land plot boundary
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Fig. 3.6. Plan of the boundaries of a land plot

The plan of the boundaries of a land plot must display: 1) all the turning 
points of the boundary of a land plot; 2) the main traverses, if they were 
laid to survey rivers, streams, and so on, which serve as boundaries of land 
plots; 3) the lines of upland boundaries, boundaries passing along fences, 
contours of permanent buildings, rivers, streams and other water sources, 
with measured distances to them from the landmarks in the continuation 
of the boundary line; 4) the numbers of points and lengths of equalized 
lines or lines calculated from the coordinates of the turning points of the 
boundary of the land plot; 5) the boundaries of land tenures located within 
the boundaries of the allotted land plot, as well as the boundaries of reserve 
land, the special fund of land reserves; 6) the boundaries, codes and areas of 
land with restrictions on use.
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The plan of the boundaries of the land plot indicates: 1) total lands 
within the boundaries of the plan, ha; 2) allotted for use (lifetime inheritable 
possession or transferred to ownership, lease, etc.), ha; 3) description of 
the boundaries of adjacent lands; 4) symbolic representation of lands with 
restrictions on use; 5) the scale of the plan; 6) the stamp of the organization, 
initials, signatures of executors and dates.

The information about the boundaries of a land plot is entered into the 
LIS by the organization operating the LIS in the place of location of this land 
plot. At the same time, this organization coordinates the information about 
the boundaries of a land plot with the information about the boundaries of 
adjacent land plots, as well as the terrain objects previously entered into 
the LIS, and in case of discrepancies between the entered and available 
information, the information about the boundaries of land plots with a lower 
precision is corrected if these discrepancies are within the limits of legitimate 
value. After entering the information about the boundaries of the land plot 
in the LIS, the organization operating the LIS in the place of location of the 
land plot draws up and places in the land management file a certifi ate of 
amendments to the land accounting documentation or returns the materials 
to the executor for correction.

After the cameral work, an explanatory note is drawn up, and all the 
materials are brochured into the land management file on the establishment 
(restoration) of the boundaries of the land plot on location (in place), which 
should contain: 1) the title page of the works executor indicating the number 
and date of receipt of a special permit (license) for geodetic and cartographic 
activities; 2) a list of case documents; 3) an explanatory note; 4) a petition 
(application) of the person who has been allocated a land plot to carry out 
works on establishing or restoration of the boundaries of the land plot allotted 
to them; 5) a copy of the certificate of the state registration of a legal entity or 
an individual entrepreneur who has been allotted a land plot (if necessary); 
6) a copy of the decision to allot a land plot to a legal entity, citizen or 
individual entrepreneur; 7) materials collected at the stage of preparatory 
work; 8) a layout drawing for establishing or restoring the boundaries of the 
land plot; 9) materials of field and cameral work; 10) a catalogue of coordinates 
of the turning points of the boundaries of the allotted land plot; 11) a scheme 
of connection (referencing) of the boundaries of the land plot with the points of 
the geodetic network; 12) a scheme of connection (referencing) of landmarks of 
the boundaries of the land plot to objects and contours of the area; 13) a plan 
of the boundaries of the land plot with restrictions on the use of land (if there 
are any); 14) an act on familiarization of the interested parties on location 
with the established (restored) boundaries of the land plot; 15) acts on control 
and acceptance of the work executed; 16) a certificate of amendments to the 
land registration documentation.



The land management file on a land plot allotment and the establishment 
of its boundaries on location with an application for the state registration 
of the creation of a land plot and the emergence of title to it is transferred 
to the territorial organization for the state registration of a real estate and 
the title to it. After the state registration of the creation of a land plot and 
the emergence of the title to it, the state registration organization transfers 
the certificate of the state registration to the person to whom the land plot 
was allotted.

Questions for self-assessment

1. What is a boundary of a land plot? What is fi ed and unfi ed boundary?
2. In what cases is the boundary of the land plot established, and in what cases 

is it restored?
3. What is the geodetic basis for establishing (restoring) the boundaries of land 

plots in the Republic of Belarus?
4. Enumerate the main stages of carrying out measures to establish and restore 

land boundaries.
5. What documents are drawn up as part of the preparatory work for establishing 

and restoring the boundaries of land plots?
6. Identify the special features of the field stage of activities to establish and 

restore land boundaries.
8. What software complexes are used to process data from field geodetic 

measurements?
9. How are the Local LIS of the regions of the Republic of Belarus used in the 

process of carrying out activities to establish and restore boundaries of land plots?



66

4. LAND RESOURCE MANAGEMENT BASED  
ON CARTOGRAPHIC MATERIALS

4.1. Stages of GIS-mapping of Land Based  
on Cartographic Materials

The existing cartographic materials (land management maps and plans, 
land tenure maps of regions and settlements, topographic maps and plans, 
plans of the territory of gardening communities, etc.) are an important 
source of data for geoinformation mapping of land. When creating the LIS 
of the Republic of Belarus, the cartographic material forms a group of layers 
“Rasters” (table 1.1). The raster spatial basis of the LIS is formed on the basis 
of initial cartographic materials (ICM), scanned and georeferenced to the state 
coordinate system, as well as georeferenced digital orthomosaics created in 
the digital photogrammetric systems.

There is a number of requirements for raster copies of ICM. They must 
be formed within the framework of the corresponding nomenclature sheets 
of topographic maps (plans) with the dimensions of the sides and diagonals 
not differing from their theoretical dimensions. The spatial resolution 
should correspond to 0.07 mm ICM scale, and the format of raster copies 
should be TIFF with PackBits compression. It is also required that the border 
decoration be absent or be made a separate layer. The background pixel value 
of bitmap ICM copies must be NoData or 255 (white). Raster copies must be 
georeferenced to the ICM coordinate system.

Digital orthophotomaps (plans) must meet the following requirements: 
be formed within the nomenclature sheets of a topographic map in 1 : 10,000 
scale or topographic plans in 1 : 5,000 or 1 : 2,000 scale; the dimensions of the 
sides and diagonals are the same as the theoretical ones; spatial (geometric) 
resolution should be no worse than 0.4 m/pix; georeferencing – to the state 
coordinate system; generated in SID, JP2 or JPG formats; background pixel 
value should be “NoData” or “255” (white color).

The generalized technological scheme for the use of cartographic 
materials in GIS consists of the sequential execution of a number of 
operations: 1) scanning; 2) creation of a vector model of the mathematical 
basis (frames of nomenclature sheets, directly coal coordinate grid) in the 
ICM coordinate system; 3) transformation and georeferencing; 4) creation of 
raster catalogues in the geodatabase; 5) digitization of information contained 
in planning cartographic materials (if necessary).

Scanning of cartographic materials should be performed with a resolution 
of 300–400 dpi and, as a rule, on scanners providing scanning “in one pass”. 
Scanned copies of ICM are viewed on the monitor screen and, if necessary 
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(for example, if there are any defects in the image), they are retouched by 
means of systems such as Autodesk Raster Design. In case of unsatisfactory 
quality of raster copies, as well as in the absence of a part of the ICM image 
on them, they are scanned again.

Raster copies of ICM are saved in TIFF files  File names must contain the 
nomenclature of the topographic map (plan). If divided publishing originals 
were used as ICM, then the corresponding suffi es are added to the name 
of the nomenclature, denoting the publishing original of the corresponding 
element of the content of the map or plan.

A vector model of the mathematical basis of ICM created using the 
GIS-project “Mathematical basis” (Matbase). The result of the work executed 
is the Autodesk Map project, which contains a description with the frames of 
topographic maps (plans) and lines of a rectangular coordinate grid (fig  4.1).

Fig. 4.1. Vector model of the mathematical basis in Autodesk Map

Transforming and georeferencing raster images to the ICM coordinate 
system are performed in the Autodesk Map environment using the Autodesk 
RasterDesign module. The Image/Correlate/RubberSheet command 
superimposes a raster image with the vector layer of its frame by four corner 
points (fig. 4.2). The calculated transformation errors should not exceed 0.2 mm 
when using the Polynominal method (and the exponent of the transformation 
polynomial should not exceed 3) or be equal to zero when using the Triangular 
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method. Otherwise, it is necessary to specify the position of the corresponding 
points or remove some of them, achieving a uniform distribution of points 
over the field of the transformed raster. The result of the process are files of 
transformed raster images and files of their oordinate reference.

Fig. 4.2. Transforming and georeferencing a raster in Autodesk Map

The formation of a catalogue of images is performed by means of 
GIS ArcGIS in order to provide software organization of raster files for 
joint “seamless” viewing. Using ArcCatalogue, the RASTERS GDB and the 
corresponding raster catalogues are created, into which the transformed ICM 
raster images are uploaded. Through image catalogues, sets of oriented raster 
copies of ICM can be presented in the form of unified information units – the 
corresponding mosaic topographic maps (plans).

If it is necessary to convert a raster image into a vector form, it is digitized 
in ArcGIS GIS. Vectorization is possible in manual mode using the ArcMap 
editor or in manual, semi-automatic and automatic mode using the tools of 
the Arc Scan module (fig  4.3).

Fig. 4.3. ArcScan toolbar
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Automatic vectorization using this module significantly reduces the time 
spent on digitizing raster images. There are two ways to vectorize in this 
mode: centerlines and contours. In the first case, the central lines of raster 
linear objects and the boundaries of areal objects are constructed. In the 
second case the boundaries of all raster related components are constructed 
as polygons. The result is a set of polygons.

Semi-automatic or interactive vectorization (tracing) is used when 
more control over the vectorization process is required or a small part of the 
image needs to be vectorized. The cursor sets the starting point and tracing 
direction, after which the center line is automatically drawn from the starting 
point to the end of the raster line, unless a polygon object or an intersection 
point with another line is encountered along the way. If the center line hits 
the intersection point, then the tracer stops and waits for the operator to 
again indicate the direction in which to continue tracing. If the central line 
stops at the boundary of an areal object, then the operator has to switch to 
the manual digitizing mode and digitize this object.

Manual vectorization allows the operator to keep the vectorization 
process under continuous control by setting the position of each vertex of 
the center line using the cursor. It is used to vectorize raster images of poor 
quality, images containing several thematic layers at once, and in the presence 
of complex line types. It is also useful for digitizing straight lines. In this 
mode, there is a special tool – raster locking, which allows the operator to 
automatically bind the starting point to the center line, line intersection 
point, line ends or corners. Quick placing the cursor over specific points 
improves accuracy and increases digitizing efficiency by eliminating the need 
of frequent zooming on the screen.

4.2. The Usage of Cartographic Materials  
in GIS-mapping of Land Resources  

in the Republic of Belarus

4.2.1. Creation of the “Soil” Layer of the Geodatabase  
of Land Informational System of the Republic of Belarus
The “Soils” thematic layer (digital soil map) is created to be used 

in carrying out work on the on-farm organization of territories, planning 
agrotechnical, amelioration measures, for accounting soil resources, carrying 
out appraisal and economic valuation of soils, as well as for comparative 
assessment of the conditions of the operation of agricultural enterprises, 
conducting soil zoning for scientific and applied purposes

The thematic layer “Soils” of the LIS is created on the basis of digital soil 
maps of individual agricultural enterprises (land tenures). Creating a layer 
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is the combination and joining of digital soil maps created in the territory of 
individual agricultural enterprises, for which author’s soil maps have already 
been created. The work on the creation of digital soil maps is carried out 
jointly by specialists from soil teams and departments of the LIS RUE “Project 
Development Institute “Belgiprozem”.

The creation of digital soil maps for individual agricultural enterprises is 
performed in the ArcGIS Maps_Soils geodatabase. In the GDB, information 
about soils is presented in the form of spatial data (table 4.1). Soil attribute 
data consist of: 1) attribute information of feature classes; 2) informational 
tables: classifier of soil features (Kod_Leg_Pochv), classifier of subsoils (Leg_
podstil), classifier of boundaries of land classes (Land_lin), nomenclatural list 
of soils (Spisok_Pv); 3) reference tables: land classes (Land_dop), meliorative 
condition of land (Melio), land types (t_LandTypes)).

Table 4.1
Datasets of the GDB “Maps_Soils”

Feature Datasets Feature classes Contents

MAPS
(soil maps of land 
tenures)

Soil_<NZ> Soil varieties (polygon) 
Land_p_<NZ> Land classes (polygon)
Land_L_<NZ> Land classes boundaries (line) 
Land_t_<NZ> Codes of classes and ameliorative 

condition of land (point)
SL_SOIL
(generated soil map 
of a land tenure)

Pochv Soil varieties of the generated soil map 
(polygon)

SKETCH
(auxiliary 
information for 
execution of the 
printed soil map of 
a land tenure)

Admi_<NZ> Boundaries of adjacent settlements
Smejniki_<NZ> Information about the adjacent
Tab1_Exp_<NZ> Table for forming a nomenclatural list of 

1 column 
Tab2_Exp_<NZ> Table for forming a nomenclatural list of 

3 columns 
Leg_Tab1_<NZ> Templates for execution of soil color fills

and hatching (Tab1_Exp) 
Leg_Tab2_<NZ> Templates for execution of soil color fills

and hatching (Tab2_Exp) 
Pochv_s Polygonal class of soil varieties of the 

generated soil map

Notes.
1. The name of the feature class in the MAPS and SKETCH datasets includes layer 

rank and land tenure number <NZ>.
2. Feature classes in the SKETCH dataset that do not contain a land tenure number 

in their name, are templates.
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A digital soil map of the territory of an agricultural enterprise is created 
in one of the ways, depending on the type of the Local LIS (vector or LIS on a 
raster cartographic basis). The process of creating a digital soil map consists 
of a number of stages given in table 4.2.

Table 4.2
The main stages of creating a digital soil map

Stage Type of work Executor

Preparatory Selection and analysis of raw materials
Preparation of the soil map legend

Soil 
detachment 

Digitization of land tenure boundaries, water 
bodies (rivers, canals and ditches, lakes, 
reservoirs and ponds), railways and improved 
roads in the land tenure area

LIS department

Creation of 
raster ICM

Creation of a contour map with a summary 
of contours and codes of soil varieties of 
adjacent land uses

Soil 
detachment 

Scanning of the initial cartographic material 
(ICM) – a contour or copyright soil map
Geodetic connection and transforming of 
raster ICM 

LIS department

Creation of 
vector soil map 
of a land tenure 

Raster ICM digitizing
Joining the boundary contours of soil 
varieties of the generated soil map with the 
contours of previously created adjacent soil 
maps
Coordination of the boundary layer of soil 
variety contours with the GDB layers of the 
Local VIS of the corresponding area

LIS department

Preparation of a report and issuing a file on a
digital soil map of a land tenure creation 

Soil 
detachment

Forming of the 
“Soils” layer of 
the GDB of the 
Local LIS

Export of the soil varieties layer created 
within the land tenure boundaries to the 
“Soils” (Soil) layer of the GDB of the Local LIS 

LIS department

At the stage of preparatory work, the initial data are collected and 
analyzed about the territory of the land tenure for which a digital soil 
map is created. The initial data are: the author’s soil map of land tenure 
with a legend, compiled basing on the materials the latest soil survey and 
containing soil codes according to the nomenclatural list of soils of Belarus; 
land usage materials; information on the soils of the land tenure, clarifying 
or supplementing the data of the author’s soil map. In addition, the legend of 
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the soil map is prepared as a table with soil types and varieties identification  
The legend data of the author’s soil map are presented a table Kod_pochv, 
which contains the codes of soil varieties of land tenure in the GDB “Maps_
Soils”. The table Kod_pochv is created on the basis of the prepared template 
table Leg_shablon.

When creating a soil map as a “Soils” layer of the Local LIS on a raster 
cartographic basis, the boundaries of a land tenure are digitized (Lots layer, 
information about the land users is placed in the Users table), as well as water 
bodies (rivers, canals and ditches, lakes, reservoirs and ponds), railways and 
improved motor roads (Land) layer) on a raster cartographic basis, taking 
into account the changes displayed in the materials of graphic accounting.

The following can be used as a raster ICM for creation of a vector soil 
map: author’s soil map of a land tenure or contour soil map. A contour soil map 
is created in the cases when, from the moment of creation of the author’s 
soil map to the creation of a digital soil map, there has been a change in the 
boundaries of the land tenure or when the soil map is created as the “Soils” 
thematic layer of the Local LIS on a raster cartographic basis.

The creation of a contour soil map is as follows. On a transparent basis, 
according to the data of the Local LIS, the land tenure boundaries are plotted, 
including outside land users, rivers, lakes, reservoirs, ponds, main canals, 
railways and improved roads. Then, the features plotted on the transparent 
base are combined with the corresponding features on the copyright soil map. 
From the copyright soil map, the boundaries and numbers of soil varieties 
are transferred to the transparent base, and a summary of the contours of 
soil varieties of author’s soil maps of adjacent land tenures is carried out. 
If necessary, a new legend of the soil map is compiled.

The creation of a digital raster basis for the contours of soil varieties is 
carried out by scanning the original cartographic material (contour soil map or 
author’s soil map). ICM is scanned at 300 dpi. The scanned image is reviewed 
and cleaned if necessary. In the case of ICM scanning in parts, joining of its 
fragments is performed. Transformation and georeferencing of a raster to 
the coordinate system of the Local LIS is performed in the AutodeskMap 
environment using the Autodesk RasterDesign module or in the ArcMap GIS 
ArcGIS using the Georeferencing command.

Vectorisation of the boundaries of soil varieties is performed using raster 
ICM. In automatic and semi-automatic modes of vectorizer programmes 
(Autodesk RasterDesign, ArcScan for ArcGIS), a contour soil map is digitized, 
in semi-automatic and manual modes, c author’s soil maps are digitized. 
The digitized information is placed on the “Pochv” layer of the “Maps_Soils” 
GDB. The contours of soil varieties are coded according to the index values 
available on the author’s soil map, which are placed in the Code field of the 
attribute table.
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The digitized boundaries of soil varieties (digital soil map) must be 
coordinated with the boundaries of the contours of previously created digital 
soil maps of adjacent land tenures, as well as with the layers Land and Melio 
of the GDB of the Local LIS.

The formation of the “Soils” layer of the GDB of LIS is carried out by 
connecting the attribute table of the polygonal layer “Pochv” of the GDB 
“Maps_Soils” with the legend table of the soil map Kod_Pochv and loading the 
created digital soil map of the land tenure into the “Soil” layer (Soil) of the 
GDB of the Local LIS (the Phocv layer of the GDB “Maps_Soils”). The structure 
of the attribute table of the “Soil” layer of the GDB of LIS is presented in 
table 4.3.

Table 4.3
The structure of the attribute table of the “Soils” layer  

of the GDB of the Local LIS

Data name Field name Field type Note

Classification status of soi SoilCode1 Textual Codification
according to the 
Nomenclatural List 
of soils of Belarus

Genesis of parent rocks SoilCode2 Textual

Granulometric or botanical 
composition of soil 

SoilCode3 Textual

The character of the underlying SoilCode4 Textual

Ameliorative condition and 
development

SoilCode5 Textual

4.2.2. Creation of Digital Elevation Models  
and Three-dimensional Elevation Models

A Digital Basic Cartographic Terrain Model (DBCTM) is an element of 
automated technology for joint land cadastral and topographic interpretation 
of aerial photography materials and the construction of a multipurpose 
digital terrain model as a basis for creating digital land cadastral (LIS) and 
topographic (digital maps) terrain models.

In terms of its content, a DBCTM is, on the one hand, a final product – 
a result of complex work on aerial photography and digital interpretation 
for the purposes of the land cadastre and topography. In this capacity, it can 
serve as a source of digital cartographic information for the construction of 
thematic GIS, maps and plans for various sectors of the national economy of 
the Republic of Belarus.

On the other hand, a DBCTM is an intermediate product intended for the 
formation of a land information system and digital large-scale topographic 
maps and plans. With these goals in mind, the content of a DBCTM is define  
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in such a way that the formation of LIS and digital topographic maps and plans 
is carried out in cameral conditions by constructing queries and reorganizing 
information.

A DBCTM is created only when the object of work requires creation or 
updating of both LIS and digital topographic maps or plans. It is a complex 
of interrelated and complementary GIS of geodetic, cartographic and land 
cadastral content. The list of GIS that make up a DBCTM is given in table 4.4.

Table 4.4
The composition of GIS included in the DBCTM

GIS name GIS contents GIS designation

Mathematical 
basis

Nomenclature layout of topographic 
maps and topographic plans, rectangular 
coordinate grids for the entire scale range

MatBase

Planned-altitude 
base

Elements of the state geodetic network, 
concentration networks, survey networks

GeoBase

Raster 
topographic base

Raster oriented mosaic topographic maps 
in 1 : 10,000 scale, topographic plans in 
1 : 2,000 scale, orthophotomaps

Rastr

Boundaries Administrative-territorial and 
administrative units, model boundaries

Boundaries

Aerogeodetic data Aerial photography route schemes, 
aerial photography frame schemes, 
photocondensing results, digital aerial 
photographs

AeroGeo

Three-
Dimensional 
Model

Contour lines, elevation marks, cut lines, 
edges, cliffs, retaining walls

3D model

Terrain model Water and land cover, aboveground and 
underground structures, hydrographic and 
road network, communications and other 
linear features, point features, annotations 

Model

The GIS “Mathematical basis” covers the entire territory of the Republic 
of Belarus; it is transferred to the enterprises that execute the work of DBCTM 
formation.

The GIS “Planned-altitude base” and “Raster topographic base” are 
created for the entire territory of the Republic of Belarus gradually – as the 
work on the formation of the DBCTM of the regions of the republic progresses. 
The GIS “Raster topographic base” is developed on the basis of topographic 
maps of the appropriate scale and is used as an auxiliary material for cameral 
interpretation.
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The GIS “Three-Dimensional Model” is created on the basis of 
topographic maps of the appropriate scale and is supplemented with vector 
information about the characteristic elements of natural and artificia  
landforms, obtained by digitizing the stereo model. The vector elevation 
model is a layer of a digital topographic map, and is also used to build a 
matrix relief, which, in turn, serves as the source material for creating 
orthophotographic maps.

The GIS “Aerogeodetic data” is formed on the basis of scanned 
negatives of aerial photographs, aerial photography parameters and data 
from photocondensing projects.

ATU and TU coverage, included in the GIS “Borders”, is created for the 
entire territory of the Republic of Belarus. It is transferred to the enterprises 
that execute the work of DBCTM formation and is periodically updated as 
changes and additions are made to the register of ATU and TU (including 
those based on the results of work on DBCTM formation).

The GIS “Terrain Model” is developed by digitizing according to a 
stereomodel or an orthophotographic map of objects that are common for 
both topographic maps and LIS, and is used to create digital plans and maps.

The digital elevation model (DEM), according to the structure of the 
DBCTM, is included in the GIS “Three Dimensional Model”, which is created in 
the territory of the Republic of Belarus gradually – as the DBCTM progresses. 
The information model of the GIS “Three Dimensional Model” is given in 
table 4.5.

Table 4.5
GIS “Three-dimensional model” attribute tables structure

Data Field Representation

Elevations 

Contour lines 

Streams 

Coastlines 

Slope edges 

Roofs 

Feature code by classifie Code Numeric

…

Feature code by classifie Code Numeric

All attribute tables of the topics of a given GIS have the same structure. 
The coordinates of elevations (X, Y, Z) are contained in the model in the 
coordinates of the corresponding graphic primitives – 3d points. The contour 
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heights are contained in the model in the level (Z coordinate) of graphic 
primitives of the model – polylines. The information about the height of 
buildings and structures (features of the Roof layer) is also contained in 
the level (Z coordinate) of graphic primitives of the model – polygons. The 
information about the height of all other GIS features is contained in the Z 
coordinates of the 3d-polyline vertices.

The features of the layers “Streams”, “Coastlines”, “Slope edges” and “Roofs” 
of the GIS “Three-dimensional model” are templates of the corresponding 
features of the GIS “Terrain model”. When converting (unloading) features 
from one model to another, they are converted from 3D to 2D.

The average height accuracy of the model elements additional to the 
contour lines is 1 m. Streams are digitized with reference to the contour lines 
they intersect. Channels and ditches less than 5 m wide are not digitized in 
the 3D vector model.

A three-dimensional model is created in order to build orthophotomaps 
and vectorization of buildings and constructions correctly. The formation of 
the model is carried out within the boundaries of the DBCTM. The DEM of 
DBCTM is created in three stages:

1) creation of a vector relief model;
2) addition and editing of the three-dimensional vector model of the 

relief;
3) digitization of buildings and constructions.
First, according to the raster topographic map of the GIS “Raster 

topobasis” using vectorizer programs, contour lines and elevations and water 
lines are digitized. Then, along the routes, in accordance with the scheme of 
aerial photography, the relief model is supplemented and edited by digitizing 
by digital stereopairs on the Digital Photogrammetriс Station (DPS) with 
uploading fragments of digitized contour lines of characteristic elements of 
artificial and natural relief forms (edges of cliffs, slopes of embankments and 
cuts, thalwegs, etc.). The Roof coverage is formed along the routes by digital 
stereo-pairs in the same projects at the cameral stage of interpretation.

The technology for constructing a DEM based on the vectorization of raster 
topographic maps is as follows:

1) scanning of topographic maps in scale 1:10,000;
2) georeferencing of obtained images;
3) vectorization of rasters;
4) verification the results of digitization
5) summary of the results obtained for the entire area of work;
6) vectorization of characteristic relief elements (edges, slopes, cliffs, 

edges of rivers and reservoirs);
7) summary of received models in autodeskmap, arcgis or photomod dtm;
8) verification and appr val of the composite model, fig  4.4.
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Fig. 4.4. DEM (area of the educational geographic station of the BSU 
“Western Berezina”), obtained using the Topo to Grid interpolation 

method (GIS ArcGIS)

The next step in the formation of a three dimensional terrain model is the 
vectorization of characteristic elements of the DTM according to the prepared 
Photomod projects. The digitization of edges of slopes, cliffs, retaining 
walls, edges of roofs of buildings and constructions, edges of watercourses 
and reservoirs is carried out. Vectorization is carried out using Photomod 
StereoDraw.

After summarizing all the digitized relief elements (contour lines, 
elevations, cliff edges, slopes, retaining walls, shorelines of watercourses 
and reservoirs) into a single model, its verification follows. Model summary 
is done using ArcGIS or Photomod DTM:

1) building a tin-model;
2) building contours according to TIN-model;
3) comparison of the original contour lines and elevations with the 

received ones and editing the original ones, if necessary.
At the final stage, after merging two vector models, a TIN model is built, 

according to which the combined model is viewed and thus checked and, 
if necessary, the original vector features are corrected.

4.2.3. Creation of Maps of Boundaries of Land Plots
Creation of plans of the boundaries of plots of gardening communities 

is carried out within the process of formation of land management affairs to 
establish (restore) boundaries on location (in place). When creating new 
or changing the boundaries of existing communities, as well as for their 
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state registration and obtaining documents certifying the titles to land 
plots, measures are taken to establish (restore) the boundaries with the 
entire complex of geodetic surveys. When preparing a land management 
file based on the materials of previously performed (before the widespread 
use of GIS technologies in land management practice) steps to establish 
(restore) boundaries, it is possible to use cartographic data available from 
these materials. It is important that since the creation of the materials in 
gardening community there have been no changes in its external boundary, 
the boundaries of public land and plots of citizens. In this case, the main 
stages of work are:

1) creation of the outer boundary of gardening community in the local 
lis according to the catalogue of coordinates;

2) scanning the paper plan of the land of gardening community;
3) transformation of the resulting raster file and its georeferencing to the 

coordinated outer boundary;
4) vectorisation of the boundaries of public land and plots of citizens; 

comparison of the actual areas of the plots with the areas indicated on the 
plan;

5) creation of catalogues of coordinates of the turning points of 
boundaries and plans of land boundaries.

The outer boundary of gardening community is created according to 
the catalogue of coordinates available in the boundary setting materials in 
the Lots3 layer of the Local LIS. The “Add X, Y data” tool is used when the 
catalogue of coordinates is generated electronically as a Microsoft Offi e Excel 
or Microsoft Offi e Access table, or “Absolute X,Y” in the ArcMap edit mode 
of the GIS ArcGIS. If the coordinate catalogue was created in a coordinate 
system other than the LIS, the work is done in the original system, and then 
the data are reprojected. At this stage, it is important to check whether the 
actual area of the community corresponds to the area indicated on the plan 
and in the materials of boundaries establishment. By converting polygons 
into lines and points, turning points of the boundary and line boundary of 
gardening community are created in the layers Lots1 and Lots2 of the GDB 
of the Local LIS.

Scanning of a paper plan of land plots of gardening community is 
performed with a resolution of at least 300 dpi. The scanned image is reviewed 
and cleaned. If the plan is scanned piecemeal, the joining of its fragments is 
performed. Transformation and georeferencing of a raster to the coordinated 
outer boundary of gardening community is performed in the AutodeskMap 
using the Autodesk RasterDesign software system or in ArcMap of the GIS 
ArcGIS using the Georeferencing command.

Vectorization of the boundaries of public land and plots of citizens is 
carried out by means of editing with ArcMap of the GIS ArcGIS in the layers 
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Lots3, Lots1 and Lots2 of the GDB of the Local LIS. Topology editing compares 
the actual areas and lengths of the plot boundary lines with the areas and 
lengths specified on the plan. After checking the accuracy of comparison, the 
topology of the GDB of the Local LIS is also checked.

Creation of catalogues of coordinates of the turning points of the 
boundaries (fig  4.5) is carried out by exporting the attribute table of the 
Lots1 layer to a text file  Plan of the boundaries of land plots of gardening 
community and plans of the boundaries of citizens’ plots (fig  4.6) are 
generated in the layout mode of ArcMap.

1963 coordinate system

Point No. X coordinate, m Y coordinate, m Distances, m Directional 
angles, °,′

1 2863.91 51684.33 8.5 278°26.16′

2 2875.34 51678.24 15.1 8°12.18′

3 2884.57 51672.11 28.7 58°34.27′

4 2886.89 51623.63 21.4 77°55.33′

5 2864.33 51622.34 26.7 13°15.56′

Plot area               613 m2 

Fig. 4.5. Catalogue of coordinates of the turning points  
of the boundaries of a land plot

Fig. 4.6. Land boundary plan



Questions for self-assessment

1. What is the sequence of operations when using cartographic materials for 
geoinformation mapping of land?

2. What resolution is optimal when scanning cartographic materials for subsequent 
GIS mapping?

3. What does the process of transformation and georeferencing of scanned 
cartographic materials consist of?

4. What modes in GIS is it possible to use for vectorization of scanned and 
georeferenced cartographic materials?

5. Enumerate the main stages of creating a digital soil map based on cartographic 
materials.

6. What purposes does the technological process of creating the GIS “Three-
dimensional model” for the DBCTM serve and what are its special features?

7. In what cases is the creation of plans for the boundaries of the land of gardening 
communities carried out according to cartographic materials?

8. Enumerate the main stages of creating plans for the boundaries of the land of 
gardening communities based on cartographic materials.
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5. LAND RESOURCE MANAGEMENT  
BASED ON VECTOR DATA. 

LAYOUT OF LAND-CADASTRAL MAPS

5.1. General Recommendations for Mapping.  
Main Elements of Maps

Cartography can be described as a set of graphic principles, including a 
range of technologies, as well as scientific and artistic approaches, necessary 
for the creation of geographical maps. Originating many centuries ago, 
cartography has come a long way of development and continues to improve. 
In recent decades, a lot of new developments have appeared in cartography, 
and the means of cartography are also being transformed, taking into account 
advances in the study of human psychology and visual perception.

Traditionally, the creation of maps was determined by the function of 
storing spatial information in them in the form of an image. The introduction 
of geoinformation technologies into geographic research has given rise to a 
systemic revolution in cartography.

The traditional approach to maps, the message paradigm, viewed a map 
as an end product designed to communicate spatial distributions through the 
use of symbols, classifications, and so on. However, this is a limited approach 
to cartography, as the map doesn’t give the user the initial, unclassifie  
information. In other words, the user, having only the final product, cannot 
rearrange the data to obtain greater returns under changing circumstances 
or needs.

An alternative approach to cartography, which maintains the storage of 
original data to enable later reclassification  was developed around the same 
time that map makers began to use the advances in computer technology. 
In this approach, called the analytical paradigm, the original attribute data 
is stored on computer media and displayed based on the needs of the user 
and with the use of their classifications. An early forerunner of computer 
mapping and GIS itself, this method is now much more fl xible in application 
than its predecessor. The impetus for its development is the idea that a map, 
especially with the use of computer technology, should not only communicate 
information, but also allow its analysis.

When preparing different types of maps, it is necessary to adhere to a 
number of general recommendations for their creation. It is important to 
understand the purpose of the map and its audience. As a rule, the purpose 
of a map is the storage of spatial information. Trying to convey too much 
information on one map only confuses its user. It is much better to create 
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two maps, each having its own purpose. It is also necessary to understand 
what audience the cartographic product is to serve.

The physical size of a map relative to the area displayed on it dictates its 
scale and determines how the actual size and the quantity of objects shown 
on the map will be represented. The carrier also plays an important role, as a 
map printed on newsprint does not reproduce fine details much better than 
the same map printed on high quality paper.

Emphasis is what the map designer wants to focus on first  Usually cool 
colors (shades of purple, blue, light blue) are used for background information, 
while warm colors (red, yellow and green) attract the attention of map readers.

The map must be visually balanced. This implies the evenness of 
all the map elements relative to each other, the dominant position of the 
cartographic image, and the absence of large empty spaces.

The completeness of the map implies the content on it of a number of 
obligatory elements, such as mathematical basis, cartographic image and 
accessories, additional data.

The main elements that represent the mathematical basis of the map are 
the projection and scale of the map. The projection is a mathematical formula 
that transforms the locations of spatial objects from a three-dimensional 
Earth’s surface to a fl t map surface. Projections can cause distortions in line 
lengths, areas, shapes, and directions.

Accordingly, the type of projection is usually indicated on the map so 
that its readers understand how accurate information that they can get from 
the map is. The graticule of the map is associated with the map projection. 
Quite often, the direction is shown using the north arrow. The map can show 
true and magnetic north. However, if the map is gridded, it is not necessary 
to add a north arrow.

Scale provides information to help map readers determine distances. The 
map scale is the ratio of one unit of length measurement on the map to the 
corresponding distance on location. It can be numerical (1 : 10,000), linear 
(scale bar) or named (ten kilometers in one centimeter).

Cartographic image (data frame) is the main area of a map (fig  5.1). You 
can place one or more data frames within one document. For example, you 
can place multiple images showing different but related information, such 
as dynamics of changes in the land fund by year.

The elements of the auxiliary equipment of a map include the legend 
(symbols and their textual explanations) and reference data (the title of a map, 
the author, the sources used, the place and year of publication).

Additional data may also be present on a map. These are additional 
maps (locator map, detail map). Besides, additional data includes textual 
and numerical data, as well as diagrams, graphs, photographs, tables that 
complement and enrich the map.
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Fig. 5.1. Some elements of a map 

5.2. Stages of Design and Layout  
of Maps in GIS. External and Internal Factors  

of Cartographic Design

The process of designing and laying out a prepared map in GIS has 
several steps. All operations are carried out in the layout mode of the GIS 
programme.

At the first stage, the layout of the map is developed. The developer 
selects the type of the map he is going to create, places all the elements on 
it, forms its general view, guided by the basic recommendations for mapping. 
This stage is very intuitive, its result is the general plan of the map.

At the second stage, the development of techniques for the design and 
symbolization of the map is carried out. The developer chooses how to display 
the cartographic image, selects symbols for displaying objects, class intervals, 
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colors, line types and other graphic elements. Here the sizes of objects and 
the distances between them are selected; this is usually done very carefully, 
depending on the scale of the map. All the necessary annotations are created 
and placed.

At the third stage, all errors and defects are corrected, and the finished
map is printed. The final step in the design process is fine setting of what 
was done at the previous stage. Only small changes can be made to the map 
layout here. The main thing is to create a prototype of the finished map on 
the monitor screen before printing. Now it is necessary to take into account 
the possible differences in images on the monitor screen and on paper, due 
to the use of special languages for controlling peripheral devices (mismatch 
between fonts and colors of GIS data input and output devices). Here you 
can recommend to output a reduced copy of the map or part of it in order to 
evaluate the compliance and, if necessary, make adjustments before printing 
the entire map.

At all stages of designing and laying out maps in the GIS, it is necessary 
to take into account external and internal factors of cartographic design.

The external factors of cartographic design determine the nature of the 
map created, the types of graphic elements used, and the internal cartographic 
design principles applied. These include the purpose of the map, its realism, 
the availability of data for mapping, the target audience and the conditions 
of using the map, as well as the technical limits of the equipment for creating 
and printing the finished map

The first and most important factor is the purpose of the map, while 
the essential task is related to the nature of the information to be displayed. 
Thematic maps created in the GIS are designed to represent specific results 
of analysis. Simplicity is very important here: the more focused the output, 
the easier it is to understand. Another aspect of the purpose of the map – 
ergonomics – is not so much about what is displayed, but how it is done. 
Having decided what will be displayed on the map, it is also necessary to 
choose a form of presentation that can adequately convey its message. If a 
map shows land use restrictions, then its design should clearly demonstrate 
their importance.

The second factor is realism, which means that each area has its own 
characteristics that impose restrictions on the applicability of design 
criteria. Geographical analysis usually involves areas with complex physical, 
transportation, social, or economic structures. This complexity can severely 
limit naming options, character sizes and styles, hatch types, etc. Such 
limitations are inevitable, and only a working knowledge of the field of study 
and the nature of the data about it can be of help. Knowing the constraints a 
priori will help you choose the best design strategy beforehand, rather than 
at the later stages, when making changes can be much more difficult
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The third factor is data availability. Most geodatabase of GIS have a 
significant volume. For example, a map with a hundred categories of land 
use is quite feasible, but creating a hundred distinguishable colors is very 
problematic. In this case, the design procedure should be modified to include 
a subdivision hierarchy with different colors and hatch types for each 
subdivision. There may be a counter-problem with the availability of data: 
the data is either insufficient to display, or it is old and collected on different 
principles, or too sparse a sample was used for it. For example, it will not be 
easy to compare centuries old vegetation data with the modern RSD. The 
former will most likely contain only a few general categories, often influen ed 
by the personal experience of the data collector, while the RSD will have a 
large number of categories derived from computer classification algorithms. 
The representation is also partly dependent on the scale of the map. Its 
scaling down reduces the detail of the map and proportionally reduces its 
symbols. But at some point, further reduction of symbols becomes impossible 
due to the loss of their distinguishability. Therefore, when designing a map, 
the choice of objects, simplification and generalization (generalization) 
become of great importance.

The next factor is the target audience. Many users of GIS output documents 
do not have knowledge and experience in geography and cartography. Under 
such conditions, the map should be read as easily as possible, by retaining only 
the most important objects and names, and by using well-known symbols. At 
the same time, advanced users will be able to extract additional information 
from a denser representation with abstract symbols.

The conditions of use play an important role in map design. This includes 
not only options for a poster map or a desktop document. If the map is to 
be used in the field  for example for field interpretation of land, then it may 
need lamination. The entire set of conditions of working with the map must 
be considered before the final design is a cepted.

Finally, the design of the map is affected by the technical limits of the 
equipment. Obviously, a color map cannot be printed on a black and white 
printer. Cheap color printers often have only a small number of reproducible 
colors. The spatial resolution of the output device is also significant, limiting 
the size of symbols and the level of detail. All these factors must be taken 
into account.

Since the maps are perceived as a unit (as opposed to a text which is 
read sequentially word by word), it is necessary to pay special attention to 
the internal factors of cartographic design. Among them: the ratio of the 
main image and the background, legibility, visual contrast and hierarchical 
structure.

The ratio of the main image and the background on the map plays an 
important role. When creating a map layout, you need to take into account 
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the fact that you will have to place its elements in a limited area. A lot of maps 
look uninteresting because they have too much or too little white background. 
A map that consists entirely of the main image is less desirable than a map 
with some amorphous background that separates the main image and gives 
a sense of belonging to land. The background also raises contrast and visual 
appeal. A map that has too much background reduces the value of the main 
image and may lead the viewer to suspect that it is not complete. But the 
picture–background correlation contains more than just aspect ratio. If land 
and water surfaces have the same color, the viewer can easily confuse them. 
Adding names, familiar boundary lines, map grids, and shading will allow 
the user to distinguish between the studied and not analyzed areas of the 
map easily.

Graphic symbols on a map must first of all be legible: individual lines 
separable, colors distinguishable, shapes recognizable. The sizes of symbols 
are determined by the distance from which the map is viewed and which 
can vary from tens of centimeters for individual work to several meters for 
demonstration to a team. At the same time, the physical limitations of the 
equipment and the human eye must also be kept in mind.

Another factor of legibility is the visibility of the characters themselves. 
For example, lines are easy to see, so there is no need to make them 
particularly wide. Some color combinations enhance distinguishability (black 
letters on a white background), others hamper it (the same black letters on 
a dark blue background). Finally, the use of easily recognizable symbols and 
their combinations helps legibility – the classic example is the figures used 
on road signs, they convey the message without using text.

Visual contrast is also necessary to distinguish between graphics and text 
against existing backgrounds, as well as when they are close together. If some 
elements look almost the same due to the similarity in size, shape, shading, 
or other parameters, then it may be useful to introduce additional variations 
to increase contrast. In this case, one should not “go too far”, since too much 
contrast can fatigue the viewer during a prolonged viewing.

The final principle of graphic design is hierarchical organization. All 
graphic elements present on a map should be organized in such a way as to 
emphasize what is most important. This principle is poorly applied on general 
geographic maps, since their goal is to enable users of different interests to 
focus on the elements that are important to them, so all the elements of such 
kind of map should have equal importance. And thematic maps, most common 
in the GIS environment, must to highlight specific objects. This can be done 
through hierarchical organization or by separating elements into levels of 
visual significan e. There are three main methods for achieving hierarchical 
organization.
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The stereogram method requires the selection and modification of graphic 
techniques in order to allow the most significant elements to look placed 
higher than the less important elements. This is a useful technique for 
improving the figure–ground correlation. The keys to depth perception can 
be the use of 3D objects, differences in line thickness, color, brightness, or size.

The second method of hierarchical organization is called expansion and is 
most commonly used to rank linear or dot features. For example, main roads 
should look more prominent than secondary roads. Here you can vary the 
thickness of the lines, their brightness or internal structure (line brokenness, 
stroke length, etc.), as well as combinations of these properties to show the 
significan e of each linear object.

The last method of creating a hierarchical graphic organization, called 
the subdivisional hierarchy method, is mainly used to show differences in the 
internal arrangement of areas. Thus, for example, pastures can be divided into 
actively, moderately and little used. The same method is used when denoting 
the borders of states with thick lines, while the internal administrative 
division is shown as thin lines.

In addition to the main internal factors of cartographic design, when 
creating a map, it is necessary to take into account or use variations in the 
form of vectors representing dot, linear, and areal objects so that these objects 
are distinguishable. The main parameters that can be changed are the shape, 
size, orientation and color. In addition, to fill areal objects, hatching can be 
used, which is characterized by its organization (regular or random), frequency 
of the elements, which makes them look lighter or darker, and the orientation 
of these elements. All of these options can be changed to improve the graphic 
representation of objects and their groups.

Tables and charts on a map can enhance the understanding of 
cartographic results greatly. As with maps, these elements also have their 
own design principles. Tables in GIS are most commonly found in map legends 
for associating attribute data with map graphic objects and as printouts of 
attribute values of objects. They may also be accompanied by the contents of 
a data dictionary to describe the data in detail and complete the map legend.

Text output design considerations include general ideas of purpose, 
readability, and target audience. In the question of purpose, consideration 
should be given to how effectively the text and tables can supplement or 
completely replace cartographic output.

Text and tables are understandable to almost everyone, and issues of 
readability are fairly well known: a simple font should be used; the color 
and brightness of the characters and the background should form a good 
contrast; tables and text should preferably be separated from the map by 
a frame; abbreviations should not be abused – the less explanation a table 



88

requires, the more convenient it is; for groups of rows or columns that 
are close in meaning, you can use additional highlighting, for example, 
by color.

Graphing has become quite a trivial task thanks to the computer. The 
programs for constructing them offer a lot of additional options: the use of 
colors, three-dimensional letters, lines and figures  entertaining symbols, 
etc. In fact, such embellishments are in most cases superfluous  they only 
worsen the readability of the output and strain the eyesight.

The most important thing here is that graphic solutions follow the main 
criterion – simplicity and legibility. The main principles of plotting are as 
follows: significant lines should stand out against the general background; 
the coordinate grid should not be too frequent and obscure the graph itself; 
the coordinate axes must reach the maximum values of the displayed 
values, it is also desirable to put the maximum and minimum values of the 
coordinates on the axes; when combining several graphs, care should be 
taken that the scale for each indicator does not mislead the viewer that small 
values are larger than they are in reality, and vice versa.

5.3. Using Vector Models  
for Land Resource Management

Already existing spatial data in the vector form are often used as initial 
data in geoinformation mapping of land. As an example, we can cite the 
use of GDB layers of the Local LIS and other electronic sources of spatial 
information when compiling cartographic parts of land management 
projects.

A land management project is a land use planning document that 
defines the concept and strategy of sustainable land use, the prospects 
for redistribution, transformation, improvement and protection of land 
within the boundaries of the region, and is intended for local executive and 
administrative bodies, land management and geodetic services, other state 
bodies and organizations in accordance with their competence to regulate 
and manage the use and protection of land, as well as for other interested 
parties. The cartographic part of the land management project should refle t 
the current land use of the area and restrictions on it, proposals for promising 
ways of land use. It includes main and thematic maps.

The main source intended for information support of land management 
projects is the LIS of the Republic of Belarus. In this regard, the most rational 
way to organize the spatial data of a land management project is to create 
a GDB (the main format of the GIS ArcGIS).
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Spatial data, on the basis of which land management projects are 
developed, are systematized in the GDB in the form of feature classes: spatial 
and object. Spatial classes contain geometric descriptions in the form of 
points, lines, polygons, and labels (annotations). Object classes contain 
various characteristics of objects that are used in calculations, when creating 
tables and graphs, and filling in the a tribute fields of spatial classes

The GDB of a land management project, which serves as the basis for 
creating the cartographic part of the scheme, includes data that is extracted 
from various vector formats, such as ESRI exchange format (*.shp), ArcInfo 
coverages (*.adf, *.e00), CAD drawings (*.dxf, *.dwg), MapInfo worksheets 
(*.mif, *.tab), etc. For this purposes, the ArcGIS Data Interoperability GIS 
module is used, which provides the ability to import data from widespread 
vector formats.

Many of the feature classes for the GDB of land management project are 
obtained by modifying the content of other classes taken from LIS or other 
electronic sources of spatial information. For this, operations of vector GIS-
analysis are used. Among them, the following operations can be singled out: 
elementary spatial analysis (viewing data on vector geoobjects, analysis of 
attributes, cartometric measurements, compiling thematic cartograms by 
attributes), spatial statistics (statistical processing of attributes, statistics 
of selection; working with databases attribute information, advanced 
spatial statistics operations), as well as advanced spatial analysis (overlay 
operations, buffering, reclassification  regionalization, generalization, and 
geoprocessing).

The main sources for vector GIS-analysis are LIS layers – Admi, Lots, 
Comm, Land, as well as the cartographic base. The Land layer can also act 
as a cartographic base, but it is preferable to create a base from several 
thematic layers, including, in addition to the hydrographic and road network, 
types of land, settlements, the signatures of these objects, as well as other 
significant obje ts.

The development of cartographic materials for land management projects 
is based on a set of cartographic display methods. These include methods of 
qualitative and quantitative background, cartograms, map diagrams, line 
symbols, signs and signs of motion.

The procedure for preparing each map in a land management project using 
GIS is as follows:

1) defining the map oncept;
2) specification of its ontent;
3) adaptation of spatial data to the content of the map;
4) development of symbols for displaying spatial data on a map;
5) editing spatial data for better perception of the map;



90

6) arrangement of elements for printing a map;
7) production of an electronic version of the map;
8) making the required number of copies.
On the first of the main maps of the land management project Modern use 

of land, the main content is displayed by applying the following information 
layers: classes of land, generalized and grouped for the purposes of the 
land management project; the main land users in the district; conditional 
boundaries of forest areas; settlements (cities, urban-type settlements, rural 
settlements); specially protected natural territories (reserves, national parks, 
reserves and natural monuments of republican and local significance); motor 
roads (international, republican, local); railways; border checkpoints; pipelines 
(main), communication and power lines of 110 kV or more; boundaries of the 
administrative region in the form of a line with outlining (state, regional); 
signatures (directions of roads that go beyond the area; names of hydrographic 
objects, agricultural organizations, settlements, forestry organizations, 
specially protected natural areas, neighboring areas, road numbers, land user 
numbers, numbers of agricultural organizations).

The following information layers of the GDB of the land management 
project are plotted on the main map Restrictions on the use of land: the 
main land users in the district; forest land, divided forest groups (forests of 
the 1st group, forests of the 2nd group, especially valuable forest ecosystems); 
settlements (cities, urban-type settlements, rural settlements); hydrographic 
objects; specially protected natural territories and their protected zones; 
proposals for the development of specially protected natural areas (creation of 
new ones, changing the boundaries of existing ones, boundaries of protected 
zones); habitats of protected animal species, habitats of protected plant 
species, especially valuable meadow and swamp communities; monuments of 
archeology, architecture and history; motor roads (international, republican, 
local); railways; border checkpoints; pipelines (main), communication and 
power lines (over 100 kV); the boundaries of the administrative region in 
the form of a line with a stroke (state, regional, district); livestock farms 
and complexes; cemeteries, treatment facilities, landfi ls, livestock dumps; 
sanitary protection zones of cemeteries, treatment facilities, livestock farms 
and complexes; zones of sanitary protection of water intakes; water protection 
zones; suburban areas; green areas; border zone; the boundary of the territory 
contaminated with radionuclides and the density of contamination; signatures 
(directions of roads that go beyond the area; names of hydrographic objects, 
names of settlements, specially protected natural areas, neighboring areas, 
numbers of monuments of archeology, architecture and history).

On the main map Perspective land use the content is displayed by 
applying the following information layers: promising classes of land, 
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generalized and grouped for the purpose of creating a land management 
scheme, including land transferred to agricultural organizations from the 
land of village councils; fund (reserve) of land redistribution; the main 
land users in the district; settlements within existing boundaries (cities, 
urban-type settlements, rural settlements); the boundaries of the planned 
expansion of settlements; specially protected natural areas (reserves, 
national parks, wildlife preserves and natural monuments of republican 
and local significan e); boundaries of the projected expansion of specially 
protected natural areas; motor roads (international, republican, local); 
railways; border checkpoints; boundaries of the administrative region in 
the form of a line with a stroke (state, regional, district); the boundaries 
of the spatial limits of the village councils with a stroke; the boundaries 
of agricultural organizations that do not coincide with the boundaries of 
the spatial limits of village councils; signatures (roads directions leading 
beyond the area; names of hydrographic objects, agricultural organizations, 
settlements, specially protected natural areas, neighboring areas, road 
numbers, land user numbers, numbers of agricultural organizations).

In addition to the main content, these maps in 1 : 50,000 scale 
additionally display mandatory elements (map name, symbols, the table 
“Technical and economic indicators of the scheme of land management”, 
the stamp “for official use”, copyright, brand) and optional elements (photos, 
the map “Confli t (environmentally hazardous) territories” in the inset, 
diagrams (distribution of land by categories of land users; distribution 
of the land fund by types of land; dynamics of land of agricultural and 
forestry organizations; dynamics of the area of the natural frame land), in 
the inset – the map “Assessment of the production potential of agricultural 
organizations”).

The composition and content of thematic maps are not limited. They 
are carried out on a scale of 1 : 100,000. A possible list of them is as follows: 
administrative-territorial division and main land users; development and 
placement of the agro-industrial complex; road network and roadside service 
facilities; land plots intended for placement of real estate objects; placement 
of horticultural associations; resettlement of the population and the main 
characteristics of settlements; ecological framework and especially valuable 
natural areas and objects; regional ecological network; placement of health-
improving institutions, memorial complexes, museums, sports and tourist 
facilities; estimated zoning of settlements; integrated assessment of land 
according to land usage conditions, etc. When preparing thematic maps, 
information layers of the geographic data base of the land management 
scheme are used, prepared by vector GIS analysis of the geographic data 
layers of the Local LIS and other spatial data in digital form.



92

5.4. Special Features of Design and Symbolization  
of Land Cadastral Maps of the Republic of Belarus

In the process of creating and operating LIS, various cartographic 
materials are formed (both digital and on a solid carrier): orthophotomaps and 
photomaps, land cadastral and soil maps, maps of districts, land tenure plans 
and land boundaries, as well as copies from them. Cartographic materials 
are produced on the following scales: 1 : 1,000, 1 : 2,000, 1 : 5,000, 1 : 10,000, 
1 : 25,000, 1 : 50,000. The planned accuracy of the cartographic materials 
corresponds to the accuracy of the spatial layers of the GDB of the Local LIS.

Digital cartographic materials are prepared in vector, raster or vector-
raster form in the formats: mxd (ArcMap ArcGIS), pmf (ArcReader ArcGIS), 
pdf (Adobe Reader), TIF (with compression PACKBITS). Cartographic materials 
on a solid basis are made in the standard framework of the nomenclature 
sheet of a topographic map or plan, or in arbitrary frames on sheets of A4, 
A3, A2, A1 formats. The arrangement of cartographic material in arbitrary 
frames is carried out in such a way that the sheets of maps (plans) have the 
smallest possible format, and the break lines of multi-sheet documents are 
made mainly along the boundaries of land plots or land cover contours. When 
forming a multisheet cartographic material, an auxiliary layer of its cutting 
into sheets is created and used.

Cartographic materials prepared according to the GDB of the LIS of the 
Republic of Belarus are drawn up in one of the two options:

1) with full filling of the rame of the cartographic image;
2) with partial filling of the rame of the cartographic image.
Depending on the method adopted, the location of the mandatory and 

optional elements of the layout of the cartographic document changes.
The mandatory elements of the layout of cartographic materials include: 

1) the frame of the cartographic material (black line 0.7 mm thick) at a 
distance of at least 1.5–2.0 cm from the edge of the sheet; 2) a cartographic 
image frame corresponding to one of the standard nomenclature sheet or 
arbitrary (black line 0.3 mm thick) at a distance of 1.0 cm from the outer 
frame in the first case and at an arbitrary one in the second; 3) the name 
of the cartographic document with the territorial reference of the mapped 
territory (region, district, settlement); 4) the name of the department, 
enterprise, executor and inspector who produced the document, and the 
date of its production; 5) source of cartographic information; 6) scale for 
displaying cartographic information; 7) stamp of the cartographic document; 
8) conditions for replicating a cartographic document.

Optional elements of the layout of cartographic materials: 1) the scale 
corresponding to the initial accuracy of cartographic information – in the case 
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of producing a cartographic document with the accuracy of an adjacent smaller 
scale (scale plan 1 : 5,000 with a scale accuracy of 1 : 10,000 or 1 : 1,000 – with 
an accuracy of 1 : 2,000); 2) layout of sheets, indication of their number and 
sheet number – for multi-sheet cartographic documents; 3) north direction 
arrow – if the cartographic image was rotated during the formation of the 
layout of the cartographic image; 4) symbols of the objects of the cartographic 
image; 6) textual data, usually in tabular form. The text part of the cartographic 
materials prepared according to the data of the GDB of LIS is recommended 
to be performed using the Arial font in all its varieties: straight and oblique, 
normal width and narrow, normal and bold thickness (table 5.1).

Table 5.1
Examples of the design of the textual part  

of cartographic materials prepared according to the data  
of the GDB of the LIS of the Republic of Belarus

Design areas
Font

Headline Contents

Name ARIAL NARROW 22 PT
Territorial binding Arial 16 pt
Name of the department, 
enterprise, executor and
inspector who produced 
the document, and the 
date of its issue

Arial Narrow 10 pt (8 pt)

Cartographic information 
source

Arial Narrow 10 pt (8 pt)

Scale arial 16 pt arial 10 pt

Classification stam Arial Narrow 13 pt
Replication conditions Arial Narrow 10 pt (8 pt)
Planned accuracy Arial Narrow 10 pt (8 pt)
Signature and inscriptions 
of the sheets layout, 
indication of their quantity 
and sheet number

ARIAL 13 PT Arial 10 pt

Legend ARIAL 13 PT Arial 10 pt
Grid labels ARIAL NARROW 9PT
Tabular data text ARIAL 13 PT Arial 10 pt
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In the case of preparation of cartographic materials with partial fillin  
of the cartographic image of their frame, the main part of the mandatory 
design elements is concentrated in the stamp of the document. Examples of 
layouts of cartographic documents with full and partial filling of its frame 
are shown in fig  5.2 and 5.3.

Design areas: 
1 – cartographic image;
2 – name;
3 – territorial binding;
4 – manufacturer;
5 – source of information;
6 – scale;
7 – stamp;
8 – replication conditions;

9 – planned accuracy;
10 – scheme of sheets;
11 – number and sheet number;
12 – arrow to the north;
13 – symbols;
14 – coordinate grid;
15 – tabular information.

Fig. 5.2. Registration of LIS cartographic materials  
with full filling of the fram

In the case of designing and preparing orthophotomaps for printing, it is 
assumed that digital orthophotomaps will be involved in the process of layout 
and the creation of a coordinate grid and marginal design. The preparation 
of cartographic materials is carried out by selecting the required fragment 
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in the required scale from the corresponding catalogue of images for the 
entire territory of the Local LIS. Orthophotomaps can be made within the 
nomenclature sheets of topographic maps and plans or within arbitrarily 
specified boundaries. The design of orthophotomaps should correspond to 
the form shown in fig  5.2 and 5.3.

Photomaps are used for field interpretation, land acquisition, 
and resolution of land disputes. To create them, a layout of a digital 
orthophotomap, vector features of digital land-cadastral map (plan) or GDB 
of the Local LIS, objects of the field work project and marginal registration is 
carried out. The symbolization of vector objects is carried out by simplifie  
conventional signs, the color and graphic design of which ensures their 
unambiguous visual perception against the background of a black and white 
halftone image of an orthophotomap.

Land cadastral maps are formed for planned cartographic support of 
current accounting of the state and use of land resources of regions and 
settlements of the Republic of Belarus. They display digital layers of contours 
of the features of administrative-territorial division, land plots, annotations, 
features and symbols, communications, fences, ameliorative state of land, 
land contours, land cover and intersections. To symbolize the features of 
the land cadastral map, special symbols are used. Signatures of features 
of administrative-territorial division, land numbers of users, land cover 
features, features of communication layers, objects and symbols, as well as 
areas (in hectares with an accuracy of two decimal places), features of the 
intersection layer and other layer labels are created on the map annotations.

When creating a soil map, the design and layout process involves the 
layers of ATE, land plots and outside land users, landmarks of adjacent 
land plots, land contours, land coverage, ameliorative state of land, soil 
characteristics, soil contours, intersections of the Land, Melio layers. and 
Soil_Clip as well as annotations. The layers of soil characteristics of the 
map are performed using queries to the “Soils” layer: moistening, erosion, 
underlayment, granulometric composition. Soil map features are symbolized 
using special conventional designations. Features of ATU layers, land tenure 
plots, landmarks of adjacent land plots participate in the formation of 
signatures. In addition, signatures of codes for land and ameliorative state, 
as well as numbers of soil contours, are created.

Tables are placed on the soil map: 1) nomenclature list of soils; 2) land 
plots of adjacent land users, indicating the initial and final marks of the 
boundaries and their names.

According to the attribute table of the intersection layer, textual 
applications of the soil map are formed: 1) explication of land by soil 
varieties; 2) explication of the qualitative condition of land.
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The map of a district is a generalized land cadastral map of a district of 
the Republic of Belarus. It is intended for planned cartographic support of 
land management and geodetic service of the corresponding district, region 
and the country as a whole. Its compilation involves digital layers of ATU 
contours, labels boundaries of adjacent areas, land plots (a selection of the 
largest land users of the area (agricultural, forestry enterprises, peasants, 
subsidiary farms, gardening associations, etc.)), annotations, communications 
(a selection of axial improved roads and watercourses with a width of more 
than 10 m), zones of restricted land use (a selection of land subjected to 
radioactive contamination), land coverage (a selection of objects with an 
area of at least 2.5 ha). To symbolize the objects of the map of the area, 
special symbols are used. The map must contain the signatures of the ATE of 
the district and adjacent districts, names or numbers land users, reservoirs, 
roads and streams. In addition, on the map of the district there is a table of 
names of land users, land use, the serial numbers of which are displayed on 
the map. The design of the map sheet of the area should correspond to the 
form shown in fig  5.3.

Fig. 5.3. Registration of LIS cartographic materials  
with incomplete filling of the frame (see design areas in fi  5.2)
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A land cadastral map (plan) within a particular land tenure is called a land 
tenure map (plan). It is intended for planned and cartographic support of the 
economic activities of a legal entity or a natural person – the owner of land 
tenure, as well as for coordinating the boundaries of land tenures when they 
are established or restored. The land tenure plan can be made either exactly 
within the boundaries of the land plots, or using a 200 m wide buffer zone 
around them.

If a land tenure plan is prepared within the boundaries of land plots, 
it contains the layers of ATU contours, land tenure plots and outside land 
users, landmarks of adjacent land plots, annotations, objects and symbols, 
communications, fences, ameliorative condition of land, land contours, land 
cover within the land tenure and intersections. To symbolize the objects of the 
land tenure plan, special symbols are used. The following labels are created 
on the map: ATU; land tenure plots, outside and adjacent plots; land cover, 
communications, objects and symbols, as well as areas (in hectares with an 
accuracy of two decimal digits) of objects of the intersection layer and other 
labels for the annotation layer. The land tenure plan contains a list of outside 
and adjacent land users.

When preparing a land tenure plan for coordinating the results of work 
on establishing or restoring the boundaries of land plots, it is supplied with 
another text attachment – the land explication of the land tenure. The design 
of the land tenure plan sheet must comply with the form shown in fig  5.3.

The land plot boundary plan is a graphic attachment of title documents 
of the land tenure (land management files for establishing or restoring the 
boundaries of land plots). Its formation involves the layers of the turning 
points of the boundaries of land plots of the land tenure, boundaries of land 
plots of the land tenure and outside land users, landmarks of the boundaries 
of adjacent land plots, of land use restriction zones within the land plots of 
the land tenure, annotations. The symbols used to symbolize the objects of 
plans of the boundaries of land plots are given in table 5.2 and 5.3. As labels 
there are the numbers of turning points, land plots of land tenure, their areas 
and ordinal numbers of outside land users, landmarks of adjacent land plots 
boundaries, types and areas of restricted zones.

Table 5.2
Symbolization and annotation of objects in the layers of land boundaries

Layer Object Symbolization
Signature

Contents Font

Turning 
points of 
land plots 
boundaries

Fixed on location O 1.0 Point numbers Arial 6–8 pt
Not fi ed on 
location

• 0.8 Arial 6–8 pt
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Layer Object Symbolization
Signature

Contents Font

Land plots 
boundaries

of the land 
tenure

0.2  – –
0.2  – –

of the adjacent 
ones

5.0
0.6     А

Symbolic marks 
of adjacent plots 
boundaries: 
A–Z

Arial 13 pt

Land plots of the land 
tenure

Plot № 1
25.05

Numbers and 
plot area, ha

Arial 9 pt

of the outside 
ones

2
6.0

Filing number Arial 10 pt

Notes.
1. All dimensions are in mm.
2. Black color shows the upland areas of land plots boundaries, green – passing 

along the banks of reservoirs and streams, streams, ditches.
3. Plot numbering is omitted if there is only one plot in land tenure.

Table 5.3
Symbolization and annotation of features  

in the “Land use restrictions” layer 

Layer Symbolization
Label

Contents Font

Water protection zones of 
rivers and reservoirs 

14.09

Zone code: 1 
(rivers) or 2  
(water bodies);
area, ha

Arial 7–8 pt

Coastal strips of rivers and 
water bodies

114.22

Surface and underground 
sources of household water 
use sanitary protection zones 

120.02

Zone code – 3;
area, ha

Sanitary protection strips of 
water passages

20.01

Zone code – 4;
area, ha

End of the table 5.2
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Layer Symbolization
Label

Contents Font

Security zones of 
communication and radio 
lines 

15. 02

Zone code – 5;
area, ha

Security zones of power 
transmission lines 

0.02

Zone code – 6;
area, ha

Security zones of main 
pipelines, gas supply 

12.13

Zone code – 7;
area, ha

 systems and other linear 
engineering structures 

0.12

Zone code – 8;
area, ha

Areas subjected to 
radioactive contamination 

145.99

Zone code – 9;
area, ha

Health-improving areas 

59.12

Zone code – 10;
area, ha

Recreational areas 

44.40

Zone code – 11;
area, ha

Arial 7–8 pt

Areas of historical and 
cultural value

87.02

Zone code – 12;
area, ha

Conservation areas 

70.45

Zone code – 13;
area, ha

Сontinuation of the table 5.3
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Layer Symbolization
Label

Contents Font

Areas with restrictions on 
construction, improvement, 
etc. 

62.33

Zone code – 14;
area, ha

Areas with other restrictions 

14.09

Zone code: 1 
(rivers) or 2 
(water bodies);
area, ha

The following tables are placed on the land plot boundaries plan: 1) land 
plots of adjacent land users, indicating the initial and end landmarks and 
their names; 2) land plots of outside land users, indicating their names and 
areas of the plots. The design of the land plot boundaries plan must comply 
with the form shown in fig  5.3.

Excerptions  from  cartographic materials  prepared  according  to  the 
information of the GDB of the Local LIS are, as a rule, used as a spatial basis 
of various purposes of land management documentation. They contain 
the same composition of layers in the same graphic representation as the 
original cartographic material. They are produced on sheets of the required 
format of a portrait or landscape orientation using a design template 
with incomplete frame filling (see fig. 5.3). At the same time, the name 
of the cartographic document in the stamp should begin with the words 
“Excerption from...”, the title in the upper part of the sheet will be the title 
of the land management document drawn up on the basis of this excerption, 
and the empty lines of the stamp are for placing the names and signatures 
of the document executors.

Questions for self-assessment

1. Give general recommendations for creating maps, including using GIS.
2. What are the main elements of a map?
3. Enumerate the main stages of the process of designing and laying out a finishe  

map in GIS.
4. What external and internal factors of cartographic design is it necessary to 

consider when creating maps in GIS?
5. What are the special features of using vector models for representing spatial 

data for GIS-mapping of land?



6. What operations of vector GIS analysis are used in the formation of feature 
classes of the GDB of the land management project of a district in the Republic of 
Belarus?

7. What order of preparation is recommended to follow when creating each of the 
maps within the land management project of a district in the Republic of Belarus?

8. What are the special features of the design and symbolization of land-cadastral 
maps with the help of GIS in the Republic of Belarus?
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6. EXERCISES FOR GIS-MAPPING  
OF LAND RESOURCES

Practical exercises allow students to study the main GIS-operations and 
technologies applied in GIS-mapping of land resources in the Republic of Belarus. 
Tutorial materials contain author’s methodological data and instructions on 
laboratory, practical and controlled independent work. The exercises were 
developed for using of the licensed ESRI Inc. software (ArcGIS with additional 
modules). The initial geodata for the exercises include digital materials provided 
for the educational process by the State Property Committee of the Republic of 
Belarus, as well as digital information freely available on the Internet.

Exercise 1. Creation a Geodatabase (on an Example of the Geodatabase 
of Land Informational System of the Republic of Belarus).

Purpose of the exercise: to study an algorithm of the building a 
geodatabase in the ArcCatalog GIS ArcGIS software (on an example of the 
geodatabase of Land informational system (LIS) of the Klieck district of the 
Minsk region).

Basic concepts and their definitions
The geodatabase is the native data structure for ArcGIS and is the primary 

data format used for editing and data management. A key geodatabase 
concept is the dataset. It is the primary mechanism used to organize and use 
geographic information in ArcGIS. The geodatabase contains three primary 
dataset types: feature classes, raster datasets, tables.

A feature class is a collection of geographic features that share the same 
geometry type (such as point, line, polygon or annotation) and the same 
attribute fields or a common area. 

Raster datasets represent geographic features by dividing the world 
into discrete square or rectangular cells laid out in a grid. Each cell has a 
value that is used to represent some characteristic of that location, such as 
temperature, elevation, or a spectral value. Raster datasets are commonly 
used for representing and managing imagery, digital elevation models, and 
numerous other phenomena. 

In the geodatabase, attributes are managed in tables based on a series of 
simple, yet essential, relational data concepts: tables contain rows, all rows in 
a table have the same columns, each column has a data type, such as integer, 
decimal number, character, and date, a series of relational functions and operators 
(such as SQL) is available to operate on the tables and their data elements.

Feature dataset holds a collection of spatially related feature classes, or 
build topologies, networks, cadastral datasets, and terrains.
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Attribute domains specify a list of valid values or a range of valid values 
for attribute columns. Domains are often used to enforce data classification  
(such as road class, zoning codes, and land-use classifications)

Subtypes manage a set of feature subclasses in a single feature class. This 
is often used on feature class tables to manage different behaviors on subsets 
of the same feature type.

Exercise progress
Step 1. Start ArcCatalog. Right-click the folder where you want to create 

the file geodatabase, point to New, and click File Geodatabase (fig. 6.1). Type 
a new name LIS-Klieck for the file geodatabase

Fig. 6.1

Step 2. Right-click the LIS-Klieck geodatabase, click New → Feature 
Dataset (fig  6.2). Type a name ALLMS for the feature dataset. 

Fig. 6.2
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Navigate to the WGS_1984_UTM_Zone_35N spatial reference for the 
feature dataset. Choose the coordinate system that will be used from XY 
coordinates from the folders Projected Coordinate Systems → Utm →  
→ WGS 1984 → Northern Hemisphere. Do not choose Z and M coordinate 
system.

Step 3. Similarly, as in step 2, create a new Objects feature dataset.
Step 4. Right-click the ALLMS feature dataset to create a new feature 

class. Point to New → Feature Class. Type a name for the feature class 
according to the table 6.1. Choose from the drop-down list the geometry 
type of features that will be stored in this feature class according to the 
table 6.1. Click Next and Finish. Similarly, create all feature classes according 
to the table 6.1., fig  6.3.

Table 6.1
Feature classes Geometry type

Admi Polygon

Lots1 Point

Lots2 Line

Lots3 Polygon

Serv Polygon

Land Polygon

Meleo Polygon

CrosTab Polygon

Fig. 6.3

Step 5. Similarly, as in step 4, create all feature classes according to the 
table 6.2 in Objects feature dataset.
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Table 6.2
Feature classes Geometry type

Comm Line

Fence Line

Obj Point

Texts Point

MapLis Polygon

Step 6. Right-click the Land feature class, point to Properties. Click 
the Field tab. To add a new field to the feature class, click the next blank row 
in the Field Name column, then type a name. Click the Data Type column next 
to the new field s name and click its data type. Create all fields according to 
the table 6.3, fig  6.4.

Table 6.3
Field name Data type

LandType Short Integer

LandSubtype Short Integer

Texts Text (Length 20)

Name Text (Length 20)

Fig. 6.4
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Step 7. Right-click the LIS-Klieck geodatabase and click Properties. This 
opens the Database Properties dialog box. Click the Domains tab. Click the 
first empty field under Domain Name and type LandTypeDomain for the name 
of the new domain. In the Description field  type Land types.

Under DomainProperties, click the drop-down for the Field Type and 
click Short Integer. This defines the data type of the column to which the 
domain can be applied. Click the drop-down for the Domain Type and click 
Coded Values. Click the drop-down for the Split policy and click Duplicate, 
fig  6.5.

Fig. 6.5

Click the first empty field in the Code column under Coded Values: and 
type “101”. Click the Description field beside it and type “Cultivated land” for 
the code’s description. Add all another 25 coded values according to the 
table 6.4.

Table 6.4
Code LandType Code LandType

101 Cultivated land 202 Tree plantings
102 Permanent crops 203 Coppice
103 Grassland 204 Other wooded areas
201 Forests 205 Other nonwooded areas
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Code LandType Code LandType

206 Swampland 504 Buildings
301 Watercourses 505 Constructions
302 Reservoirs 601 Disturbed land
401 Roads 602 Unused land
402 Railways 701 Improved land
403 Communication 

elements
702 Mineral extraction and 

construction sites
501 Squares and streets 703 Dump sites
502 Green spaces 704 Burial places
503 Yards 705 Other land

Similarly, create all 26 domains according to the table 6.5., fig  6.6. Use 
the same domain properties for new domains (Field Type – Short Integer, 
Domain Type – Coded Values, Split policy – Duplicate).

Table 6.5

Domain name Description 
Coded values

Code Description 

Plants101 Cultivated land 3 Arable land
4 Fallow land

Plants102 Permanent crops 5 Other permanent crops
6 Orchards
7 Berry field

8 Plantations
9 Fruit nurseries

Plants103 Grassland 111 Flooded, clean
112 Flooded, shrubby
113 Flooded, improved 
114 Other floode
121 Upland, clean
122 Upland, shrubby
123 Upland, improved 
124 Other upland 
131 Waterlogged, clean
132 Waterlogged, shrubby
134 Other waterlogged

End of the table 6.4
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Domain name Description 
Coded values

Code Description 

Forests201 Forests 291 Coniferous
301 Deciduous
311 Mixed
326 Without specifying of tree species 

composition
Forests202 Tree plantings 294 Coniferous

304 Deciduous
314 Mixed
327 Without specifying of tree species 

composition
Forests203 Coppice 295 Coniferous

305 Deciduous
315 Mixed
328 Without specifying of tree species 

composition
Forests204 Other wooded 

areas
321 Tree-shrubbery vegetation 
322 Forest and scrub belts 

Forests205 Other 
nonwooded 
areas

324 Cutting areas
325 Burnt areas
329 Other areas

Forests206 Swampland 34 Upland
35 Transitional
36 Lowland

Waters301 Watercourses 40 Rivers and streams
43 Canals and drains

Waters302 Reservoirs 39 Other water bodies
41 Lakes
42 Reservoirs and ponds

Roads401 Roads 441 Field and forest roads 
444 Clearings
445 Country roads
446 Improved roads
447 Roadsides
448 Ditches

Сontinuation of the table 6.5
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Domain name Description 
Coded values

Code Description 

449 Slopes
450 Dividing lanes
704 Cattle passes

Roads402 Railways 701 Bed
702 Ditches
703 Slopes
705 Cargo and passenger platforms

Roads403 Communication 
elements

440 Other communication elements
442 Pipelines
443 Bridges and overpasses

Buildings501 Squares and 
streets

451 Squares
452 Streets and driveways
453 Carriageways of streets and driveways
454 Sidewalks and footpaths
458 Porches and blind areas 
459 Stairs

Buildings502 Green areas 455 Boulevards

456 Lawns and fl wer-beds
460 Parks and squares

Buildings503 Yards 67 Estate land
457 Other common areas
461 Utility yards
463 Open-air warehouses
473 Paddocks

Buildings504 Buildings 464 Residential, fire-resistan
465 Residential, non-fire-resistan
466 Residential, mixed-fire-resistan
467 Non-residential, fire-resistan
468 Non-residential, non-fire-resistan
469 Non-residential, mixed-fire-resistan

Buildings505 Constructions 470 Light-type constructions
471 Greenhouses
472 Other constructions

Сontinuation of the table 6.5
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Domain name Description 
Coded values

Code Description 

462 Silo pits
661 Dams 
667 Slopes 

Bedland601 Disturbed land 48 Other disturbed land
49 Disturbed in the result of mining
50 Disturbed in the result of peat and 

sapropel extractions
51 Disturbed during construction works

Bedland602 Unused land 53 Other unused land
54 Sands devoid of vegetation
55 Ravines and gullies
56 Ramparts
58 Burnt peatland
59 Former agricultural land 

contaminated with radionuclides
662 Mounds
663 Pits
664 Soaks

Others701 Improved land 23 Under melioration construction

24 Under fertility restoration
Others702 Mineral 

extraction and 
construction 
sites

37 Peat and sapropel extraction sites
665 Waste dumps and waste heaps
668 Quarries
669 Construction sites

Others703 Dump sites 62 Other dump sites
63 Household waste dump sites
64 Industrial waste dump sites
65 Contaminated by radionuclides dump 

sites
Others704 Burial places 60 Cemeteries

61 Cattle burial sites
Others705 Other land 57 Under brows

666 Other land

End of the table 6.5
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Fig. 6.6

Step 8. Double-click the Land feature dataset in the LIS-Klieck 
geodatabase to open its Properties. Click the Field tab. Click the Domain drop-
down list for the LandType field and click LandTypeDomain to set it as the 
default attribute domain (fig  6.7).

Рис. 6.7
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Step 9. Click the Subtypes tab in the LandType Properties dialog box. 
Click the Subtype Field drop-down arrow and click LandType.

Add subtype codes and their descriptions according to the table 6.6. For all 
new subtypes, set the domain according to the table 6.6 for the LandSubtype 
field  fig  6.8.

Table 6.6

Subtype code Description Domain for LandSubtype fiel

101 Cultivated land Plants101

102 Permanent crops Plants102

103 Grassland Plants103

201 Forests Forests201

202 Tree plantings Forests202

203 Coppice Forests203

204 Other wooded areas Forests204

205 Other nonwooded areas Forests205

206 Swampland Forests206

301 Watercourses Waters301

302 Reservoirs Waters302

401 Roads Roads401

402 Railways Roads402

403 Communication elements Roads403

501 Squares and streets Buildings501

502 Green spaces Buildings502

503 Yards Buildings503

504 Buildings Buildings504

505 Constructions Buildings505

601 Disturbed land Bedland601

602 Unused land Bedland602

701 Improved land Others701

702 Mineral extraction and 
construction sites

Others702

703 Dump sites Others703

704 Burial places Others704

705 Other land Others705
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Fig. 6.8

Questions
1. What types of geometry can you set for the geodatabase feature class? Give a 

brief description of each type.
2. What types of attribute fields can be set for the attributes of the geodatabase 

feature class? Give a brief description of each type.
3. What types of domains can be created in the geodatabase? Give a brief 

description of each type.

Exercise 2. Creating a Geodatabase Topology (on an Example of the 
Geodatabase of Land Informational System of the Republic of Belarus).

Purpose of the exercise: to study an algorithm of the creating a 
geodatabase topology in the ArcCatalog GIS ArcGIS software (on an example 
of the geodatabase of LIS of the Klieck district of the Minsk region).

Basic concepts and their definitions
Topology is a collection of rules that, coupled with a set of editing tools 

and techniques, enables the geodatabase to more accurately model geometric 
relationships. ArcGIS implements topology through a set of rules that defin  
how features may share a geographic space and a set of editing tools that work 
with features that share geometry in an integrated fashion. A topology is stored 
in a geodatabase as one or more relationships that define how the features 
in one or more feature classes share geometry. The features participating 
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in a topology are still simple feature classes – rather than modifying the 
definition of the feature class, a topology serves as a description of how the 
features can be spatially related. The topology includes three sets of parameters: 
rules, ranks, and cluster tolerances.

Topology rules define the permissible spatial relationships between features. 
Creating topological relationships involves analyzing the coordinate 

locations of feature vertices among features in the same feature class as well 
as between the feature classes that participate in the topology. Those that fall 
within a specified distance – a cluster tolerance – of one another are assumed 
to represent the same location and are assigned a common coordinate value 
(in other words, they are colocated).

The coordinate accuracy ranks you specify for feature classes in a 
geodatabase topology control the movement of feature vertices during 
validation. The rank helps control how vertices are moved when they fall within 
the cluster tolerance of one another.

Violations of topology rules are initially stored as errors in the topology. 
Error features record where topological errors were discovered during validation. 
Certain errors may be acceptable, in which case the error features can be marked 
as exceptions. 

Exercise progress
Step 1. Start ArcCatalog. In the Catalog tree, navigate to the ALLMS feature 

dataset in the LIS-Klieck geodatabase. Right-click the ALLMS feature dataset, 
point to New, then click Topology. The New Topology wizard starts. Click Next 
(fig  6.9).

Fig. 6.9
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Step 2. The wizard presents a default name and cluster tolerance for 
the topology. You will accept the default name that the wizard provides. The 
default cluster tolerance is based on the XY tolerance of the Landbase dataset. 
Type 0,001 to set the new cluster tolerance. Click Next.

Check all feature classes with the exception of CrossTab, fig  6.10. These 
feature classes will participate in the ALLMS Topology. Click Next.

Type 3 for the number of ranks. Choose 1st rank for Lots1, Lots2 and Lots3 
feature classes, 2nd rank for Admi and Land feature classes, 3rd rank for Melio 
and Serv feature classes (fig  6.11). Click Next.

Fig. 6.10

Рис. 6.11
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Step 3. Create topology rules. To create each rule, click Add Rule. In the 
Add Rule window, click the Features of feature class drop-down arrow and 
click required class. Click the Rule drop-down arrow and click required rule. 
If necessary, click the Feature class drop-down arrow and click required class 
(fig  6.12). Set the topology rules according to the table 6.7. Click Finish.

Рис. 6.12

Table 6.7

Features of feature class Rule Feature class

Admi Must Not Overlap

Admi Must Cover Each Other Lots3

Lots1 Point Must Be Covered By Line Lots2
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Features of feature class Rule Feature class

Lots2 Endpoint Must Be Covered By Lots1

Lots2 Must Not Have Pseudo Nodes

Lots2 Must Not Intersect

Lots2 Must Be Single Part

Lots2 Must Not Intersect Or Touch Interior

Lots2 Must Not Self-Intersect

Lots3 Boundary Must Be Covered By Lots2

Lots3 Must Be Covered By Admi

Lots3 Must Not Overlap

Lots3 Must Not Have Gaps

Land Must Be Covered By Lots3

Land Must Not Overlap

Land Must Not Have Gaps

Melio Must Not Overlap

Step 4. In the Catalog tree, navigate to the Objects feature dataset in the 
LIS-Klieck geodatabase. Create new topology with Comm and Fence feature 
classes (cluster tolerance – 0,001, number of ranks – 1). Set the topology rules 
according to the table 6.8. Click Finish.

Table 6.8

Features of feature class Rule Feature class

Fence Must Not Intersect

Fence Must Be Single Part

Fence Must Not Intersect Or Touch Interior

Fence Must Not Self-Intersect

Comm Must Not Have Pseudo Nodes

Comm Must Not Intersect

Comm Must Be Single Part

Comm Must Not Intersect Or Touch Interior

Comm Must Not Self-Intersect

End of the table 6.7
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Questions
1. Create a description and list the possible errors for each topology rule of ALLMS_

Topology.
2. List the main topology parameters of ALLMS_Topology and give their 

characteristics.
3. What is the peculiarity of the vector-topological model of the representation 

of spatial data in GIS, in contrast to vector-non-topological.
4. What spatial problems are solved in GIS by creating a topology?

Exercise 3. Visual Interpretation of Land Types and Subtypes of the 
Geodatabase of Land Informational System of the Republic of Belarus 
Based on Aerial Photography Materials.

Purpose of the exercise: to master the algorithms of visual interpretation 
of land types and subtypes in the GIS ArcGIS software (on an example of a 
fragment of the Klieck district of the Minsk region)

Initial data:
GDB “LIS-Klieck”, formed as a result of exercises 1 and 2 (LIS-Klieck.mdb);
• a shape-file containing the border of a fragment of the Klieck district 

(Area_Border.shp);
• a table containing the coordinates of the turning points of the 

settlement border, obtained as a result of establishing its borders using the 
geodetic method (Settlement_Border in the database Settlement.mdb);

• a shape-file containing the borders of the land plots obtained as a result 
of establishing them using the geodetic method (Geodesy.shp);

• color and transparent templates of the legend of the layer Land  
(Land.lyr);

• an orthorectified and georeferenced photoplan (scale 1:10,000) of a 
fragment of the Klieck district (Orthophotomap.tif);

• an unattached fragment of a topographic map on a scale of 1:100,000 
(topo.tif);

• orthorectified and georeferenced multizone satellite images obtained 
by the Landsat 7 satellite ETM+ imaging system (10 – band 1, visible mode, 
blue spectral range, spatial resolution 30 m; 20 – band 2, visible mode, green 
spectral range, spatial resolution 30 m; 30 – band 3, visible mode, red spectral 
range, spatial resolution 30 m; 40 – band 4, near infrared (IR) mode, near IR 
range, spatial resolution 30 m; 50 – band 5, shortwave IR mode, mid-IR range, 
spatial resolution 30 m; 70 – band 7, shortwave IR mode, mid-IR range, spatial 
resolution 30 m; 80 – band 8, panchromatic mode, spatial resolution 15 m);

• the results of field interpretation of the lands of a fragment of the Klieck 
district (Field survey_orthophotoplan.tif).
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3А. Preparation of Initial Data for Visual Interpretation of Land. 
Preliminary Analysis of the Study Area.

Purpose: to master the algorithms for adding and symbolizing data in GIS 
ArcGIS, georeferencing raster images, coordinate digitizing and combining 
channels of multizone images; perform a preliminary analysis of the study 
area using the initial raster data.

Exercise progress
Step 1. Open the ArcCatalog of the GIS ArcGIS. Load the data of shape-

file Area_Border.shp into the Land feature class of the LIS-Klieck GDB. Right-
click Land feature class, click Load → Load data (fig  6.13).

Fig. 6.13

In the window Simple Data Loader, click Next. In the next loading step, 
select the shape-file “Area_Border.shp” (fig  6.14) as input data and click the 
Add button. Leave the options for the next loading steps as default. Finally, 
click the Finish button.

Step 2. Open the ArcMap of the GIS ArcGIS. Create a project Visual 
Interpretation of Land. To do this, use the Save As option in the File menu. 
Save the project in your folder.

Add the original raster (Orthophotomap.tif, topo.tif, 10, 20, 30, 40, 50, 70, 
80) and vector (set of ALLMS dataset classes of the LIS-Klieck GDB) data to 
the project using  the “Add data” icon. Do not build Pyramidal layers for 
rasters. Leave only the layers topo.tif and Land in the visualization (check only 
these layers in the table of contents). Hide all layer legends. Zoom the extent 
of the data frame to the Land layer (right-click on layer → Zoom to Layer).
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Fig. 6.14

Step 3. Perform the georeferencing of the fragment of a topographic 
map at a scale of 1:100,000 (topo.tif). When you spatially reference a raster 
dataset, you locate it in the map coordinates and set the coordinate system. 
Georeferenced raster data can be displayed and analyzed along with other 
geographic data.

Open the Georeferencing toolbar (Customize → Toolbars → Georeferencing). 
Pull the panel to the top of the working window to a place convenient for you.

In the Georeferencing toolbar (fig  6.15), choose the georeferencing 
layer – topo.tif. Then perform the operation Fit to Display (Georeferencing →  
→ Fit to Display). Thus you will move the topo.tif raster to the desired area. 
In addition, tick the option (Georeferencing → Auto Adjust).

Fig. 6.15

Symbolize the Land layer. To do this, open the Layer Properties window 
(right-click on the Land layer → Properties). Select the Symbology tab and set 
the display function Features: Single Symbol for this layer. Click on the icon of 
the symbol and select for it: Fill Color – No color, Outline Color – Mars Red, 
Outline width – 1 (fig  6.16).
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Fig. 6.16

Open the Snapping toolbar (Customize → Toolbars → Snapping). Pull the 
panel to the top of the working window to a place convenient for you. Choose 
Snapping → Use Snapping. Set available only the icon Vertex Snapping in the 
Snapping toolbar.

Perform the georeferencing of the border of the interpretation area on the 
topo.tif raster (marked with a purple outline, fig  6.17, a) to the border of the 
interpretation area located in the Land layer (symbolized in red, fig  6.17, а).

To do this, use the icon  Add Control Points on the Georeferencing 
toolbar. After clicking the icon, the cursor will turn into a crosshair. Place the 
cursor on the upper left corner of the border of the study area, indicated on 
the raster, and click left mouse button (LMB). A green crosshair will remain 
at the control point.

Find the equivalent corner of the study area border in the Land vector layer 
(you symbolized it with a red outline). Move the cursor to the corresponding 
point of the vector layer. Once the Snapping option is enabled, click on it. The 
raster image will shift and the control point on the raster and on the vector 
layer will be connected. This image shift is a one-point transformation based 
on the combination of one control point on the raster and the corresponding 
control point in the target data (in our case, the Land layer) and is called a link.

Do the same for other control points representing the corners of the study 
area border on the raster, and link them to the same corners in the vector 
layer, fig  6.17, b. In case of an error, you can also delete link by opening the 
window  View Link Table on the Georeferencing toolbar.
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                                       a                  b

Fig. 6.17

After creating all links, perform the operation Georeferencing → Update 
Georeferencing.

Step 4. Add the turning points of the border of the settlement “Ruda”, 
located in the study area, surveyed using a geodetic method, using the Add 
XY data operation in the File → Add data menu.

In the Add XY Data window, select the Settlement_Border table from 
Settlement.mdb database. Define the fields of the Settlement_Border table 
containing the X coordinate and the Y coordinate. Set the coordinate system 
to WGS_1984_UTM_Zone_35N, it is located in the Projection Coordinate 
Systems → Utm → WGS 1984 → Northern Hemisphere → WGS_1984_UTM_
Zone_35N section (fig  6.18). As a result, the Settlement_Border Events point 
layer appears in the data frame.

Fig. 6.18
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Step 5. Label the numbers of the turning points of the border of the 
settlement. To do this, go to Layer Properties “Settlement_Border Events”, in 
the Labels tab check the box Label features in this layer, select OBJECTID_1 
as the label field and symbolize the labels in a font and size convenient for 
you (fig  6.19).

Fig. 6.19

Step 6. Create a vector polygon feature of the “Ruda” settlement in the 
Admi layer from its border turning points (“Settlement_Border Events” layer). 
To do this, use the tools of the Editor panel (Settings → Toolbars → Editor), 
shown on fig  6.20.

Fig. 6.20
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Start the editing session (Editor → Start Editing). Select the LIS-Klieck 
personal geodatabase for editing. In the Create Features window (appears 
automatically after the start of an editing session), fig  6.21, select the layer to 
which the new features will belong. This layer will be the Admi (administrative 
division) layer. For the Construction Tool, choose Polygon.

Fig. 6.21

Since you will be creating a new feature based on another layer, it is 
necessary that the vertices of the sketch of the new feature correspond to 
the points of the “Settlement_Border Events” layer. To do this, set the option 
Point Snapping on the Snapping toolbar, fig  6.22.

Fig. 6.22

Now you can start creating the border of the settlement. Zoom in the 
extent of the data frame around the first turning point of the corners of the 
settlement border and lock on it (click with LMB).
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Continue snapping to each subsequent point of the “Settlement_Border 
Events” layer by making one click with LMB. The map extent can be varied 
using the tools  Zoom In,  Zoom Out,  Fixed Zoom In,  Fixed Zoom 
Out,  Pan. If you put the vertex of the sketch in the wrong place it can 
be deleted by clicking RMB near the vertex and selecting Delete Vertex. It is 
necessary to double click the last point with LMB (fig  6.23). Thus, the border 
of the settlement “Ruda” in the Admi layer based on the turning points of 
the border has been created. Stop your editing session (Editor → Stop Editing). 
Choose a symbol for the Admi layer that is convenient for you.

Fig. 6.23
Step 7. Composite the bands of the multizone satellite image obtained 

by the ETM+ imaging system of the Landsat 7 satellite. To do this use the 
Composite Bands tool. Open the ArcToolbox , find the required tool (Data 
Management → Raster → Raster Processing → Composite Bands). In the tool 
window in the Input Data section you should sequentially select the first  
second, and third rasters corresponding to the required bands.

For the Composition of the 4th, 3rd and 2nd bands (the “artificial colors” 
composition), we sequentially select the following rasters that you previously 
added to the project: 40, 30 and 20 (fig  6.24). The output  raster with 
composited bands must be saved under the name 432. After the necessary 
calculations, the program will add a raster with composited bands to the 
project.

Repeat this sequence of operations to composite the 3rd, 2nd and 1st 
bands (the “natural colors” composition).
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Fig. 6.24

Step 8. Save the project “Visual interpretation of lands” (File → Save).
Step 9. Using all the original raster data, as well as the rasters obtained 

by composition of bands, perform a preliminary GIS analysis of the study area 
for the spatial location of land types.

Questions
1. List the basic sequence of steps for georeferencing a raster image in the GIS 

ArcGIS. Describe the structure of the world file
2. List the basic sequence of steps for creating a vector feature in the GIS ArcGIS 

based on existing vector features. What is the essence of the Snapping function?
3. What composition of bands (beside the “natural colors” and “artificial colors” 

compositions) can be produced with multizone images Landsat ETM+? How will land 
types be refle ted in different compositions?

3B. Visual Interpretation of Land Types and Subtypes.

Purpose: to master the algorithms for editing, overlay operations, loading 
data from one feature class to another in the process of visual interpretation 
of land types and subtypes in the GIS ArcGIS software.

Exercise progress
Step 1. Open the ArcMap of the GIS ArcGIS. Open the project Visual 

interpretation of land.mxd created in Exercise 3.1 (File → Open).
Step 2. Organize the vector data into a group layer. First, it allows you to 

group several layers, and, second, to display or not to display all them in the 
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map extent. To create a group layer, right-click on the Layers data frame and 
select New Group Layer. Rename it to LIS. By dragging the ALLMS_Topology 
layers, as well as Admi, Land, Lots1, Lots2, Lots3, Melio, Serv, and CrosTab, 
up all the way to the LIS group layer, drop them into this group layer. In the 
same way as for the LIS group layer, create the following group layers for raster 
data: Orthophotomap (should contain Orthophotomap.tif layer), Topomap 
(topo.tif layer), Landsat_ETM+ (layers 10, 20, 30, 40, 50, 70, 80), Composition 
of Landsat_ETM+ bands (layers 432 and 321) (fig  6.25).

Fig. 6.25

Step 3. Add to the project the layer Geodesy.shp, which contains the 
boundaries of land plots obtained as a result of their establishment using the 
geodetic method and corresponding to land types (use  the Add data icon).

Perform an overlay operation of overlaying a polygonal feature, which is 
the border of a fragment of the Klieck district and located in the Land layer 
and polygons of the Geodesy.shp layer. To do this, use the Identity tool (
ArcToolbox → Analysis Tools → Overlay → Identity). In the tool window, 
mark the Land layer as the Input Features, the Geodesy.shp layer as the Identity 
Features, Land_Identity as the Output Feature Class (save it in the LIS-Klieck 
geodatabase), Join Attributes as All (fig  6.26). After the necessary calculations, 
the program will add the Land_Identity layer to the project.

Start editing the LIS-Klieck geodatabase (Editor → Start editing). Set the 
Tables of contents “Layers” display option  List By Selection (the button is 
located in its upper part). Make only the features in the Land layer selectable. 
Select the only feature located in this layer (the border of the fragment of 
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the Klieck district), using the tool  Select Features (fig  6.27) and delete 
it, pressing the Del key on the keyboard. Finish editing by saving all changes 
(Editor → End Editing). Delete the Land layer from the project (right click on 
the layer in the table of contents → Delete).

Close ArcMap after saving the project “Visual land decryption.”

Fig. 6.26

Fig. 6.27
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Step 4. Open the ArcCatalog of the GIS ArcGIS. Load the Land_Identity 
feature class data into the Land feature class of the LIS-Klieck GDB. To do this, 
click on the Land → Load → Load Data. In the Simple Data Loader window, 
click Next. In the next loading step, select the Land_Identity class as input 
and click the Add button. For the Target Field LandType of the Land feature 
class set the LANDTYPE Matching Source fiel  of the Land_Identity feature 
class. Similarly, for the LandSubtype fiel  – the LANDCODE field (fig  6.28). 
Close ArcCatalog after loading the data.

Fig. 6.28

Step 5. Open ArcMap. Add the Land_color.lyr file to the project (to the LIS 
group layer) (use  the Add Data icon). This file contains color symbolization 
for all types and subtypes of the Land layer.

Set the Land feature class of the LIS-Klieck geographic database as the 
data source for the Land.lyr layer. To do this, go to the Properties of the Land_
color.lyr layer (right-click on the layer → Properties), select the Source tab 
and press the Set Data Source button.

Step 6. Add the following additional editing tools: Topology and Advanced 
Editing (Editor → More Editing Tools) (fig  6.29, 6.30) and drag them to the 
top of the working window to a place convenient for you.
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Fig. 6.29

Fig. 6.30

Step 7. Start an editing session (Editor → Start Editing). Select the LIS-
Klieck personal geodatabase for editing.

Set the Table of contents “Layers” display option to  By selection. Make 
selectable only the features in the Land layer. With the Select Features 
tool, select the only non-coded feature in the Land layer, which is the result 
of the previous overlay between the Land layer and the Land_Identity layer 
(fig  6.31).

Fig. 6.31

This feature is multipart. To explode it, use  the Explode Multipart 
Feature tool on the Advanced Editing toolbar. The multipart polygon will be 
divided into a series of singlepart polygons.

Step 8. On the Snapping toolbar, set Vertex Snapping option. Also check 
the Snap to Sketch option by choosing Snapping → Snap to Sketch.

Step 9. Perform a visual interpretation of the types and subtypes of 
land within the settlement “Ruda”. Zoom in the extent of the data frame 
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to a settlement using  the Zoom In tool. Turn on the display of the 
“Orthophotomap” group layer.

Start by interpretation of the Streets and driveways land sybtype. Create 
a polygon feature of the Squares and streets land type using the direct 
interpretational characteristic of the road network – light lines (stripes) 
on the orthophotomap, as well as the indirect characteristic – the fences 
of individual plots (dark straight lines) and detail it into the Streets and 
driveways subtype.

To create a vector feature using  the Select Features tool, select a 
non-coded polygon feature in the Land layer, which is located on the site of 
a street in a settlement. Using  the Cut polygons tool on the Editor toolbar 
and pressing the V key on the keyboard (allows you to see all the vertices of 
the existing vector features of the Land and Admi layers), start cutting the 
selected non-coded polygon, placing the first vertex of the sketch outside 
the selected polygon, the subsequent ones – within the selected polygon and 
closing on the tops of the layers Land and Admi, and the last one – outside 
the borders of the selected polygon (fig  6.32).

Fig. 6.32

After creating the last vertex of the sketch by double-clicking finis  
cutting the polygon. This sequence of operations is used if the cutting feature is 
located at the borders of the editing area.

Use  the Select Features tool to select the newly created polygon 
feature. Using  the Attributes tool on the Editor toolbar, select the required 
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type (Squares and streets) and subtype (Streets and driveways) of land for the 
created feature (fig  6.33).

Start interpretation the land type of Buildings in the settlement “Ruda”. 
Based on the main interpretational characteristics – the geometry of shapes, 
as well as the shadows depicted on the orthophotomap, find buildings and 
create new features of the “Buildings” land type in the Land layer by cutting 
a non-coded polygon.

Fig. 6.33

To do this, using  the Select Features tool, select a non-coded 
polygon feature of the Land layer, which is located in the place of the 
Buildings feature, using direct and indirect interpretational characteristics. 
Using  the Cut Polygons tool on the Editor toolbar, start cutting the 
selected polygon. Put all the vertices of the sketch in the corners of the 
building to be deciphered (fig  6.34). The last vertex should be snapped 
to the first one and double clicked to complete the sketch. This sequence 
of operations is applied if the cutting feature is inside the borders of the  
edit area.

Do the interpretation of all lands of the Building type within the Ruda 
settlement by clipping polygon feature s from the non-coded polygon. 
Buildings located near the street, refer to the subtype Residential non-fire
resistant, located away from the street – Non-residential non-fire-resistan  
(fig  6.35). To do this, use  the Attributes tool.
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Fig. 6.34

Fig. 6.35

In the similar way carry out the interpretation of the lands of the subtype 
Estate land of the Yards type. For this lands, the direct interpretational 
characteristics are: the originality of the form, the specifici y of the texture, 
the geometric dimensions. Estate land are also well recognized by indirect 
characteristic – by the presence of fences that limit the plots of individual 
land users and landowners. In a black and white photograph, they are dark 
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geometric stripes. Another indirect characteristic is the presence of buildings 
on the estate land.

Using the tool  Cut polygons, cut three poligons of Estate land within 
the borders of the settlement “Ruda” from a non-coded polygon (fig  6.36). 
Snap on the already interpreted features of the Land layer and the border of 
the settlement in the Admi layer.

Fig. 6.36

Step 10. Interpret the land under roads and other transport 
communications. Most of this land within the study area was preliminarily 
photographed by instrumental methods. Analyze the peculiarities of 
direct and indirect interpretational characteristics of these lands on the 
orthophotomap.

Note that roads appear as light lines (streaks) in black and white aerial 
photographs. In addition, on the Improved road (southwestern part of the 
study area), even the road markings and the number of lanes are visible. Field 
and forest roads are less clearly visible in the image. Indirect interpretational 
characteristics of roads are their position on the ground, their connection 
with other topographic features, the presence of structures serving the roads, 
the nature of the intersection with other features, and the location of the 
accompanying forest and scrub belts.

Using the tool  Cut polygons, interpret on the basis of orthophotomap 
the land type Roads, the subtype Field and forest roads from the non-coded 
polygon (fig  6.37, 6.38). Snap to existed features in the Land layer.
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Fig. 6.37

Fig. 6.38

Step 11. Do the interpretation of the land under water objects. They 
could interpret with a high degree of certainty in black and white and 
especially reliable on color aerial photographs based on direct interpretation 
characteristics. Most of the lands under rivers and streams and reservoirs and 
ponds within the study area were indicated by geodesic methods. Analyze the 
peculiarities of direct and indirect interpretational characteristics of these 
lands on the orthophotomap. In addition, using the rasters of composition of 
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various bands of the Landsat ETM+ imagery, as well as the orthophotomap, 
try to recognize reservoirs and ponds that remained uninterpreted, and cut 
them out of the non-coded polygon of the Land layer, coding the cut polygon 
vectors as the land type Reservoirs, subtype Reservoirs and ponds (fig  6.39).

In the similar way interpret and cut out from the non-coded polygon of 
the Land layer the features belonging to the type of land Watercourses, the 
subtype Canals and drains (fig  6.40).

Fig. 6.39

Fig. 6.40
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Step 12. Perform the interpretation of swampland. The main 
interpretation characteristic of swamps is the texture of the image. It, 
depending on the type of swamps, their overgrowth (forest cover), passability, 
is very diverse and heterogeneous, but in most cases it is quite specific  
Indirect interpretation characteristics of swamps are confinement to vast fla -
horizontal areas of the terrain, the absence of traces of agricultural processing, 
the presence of country and field bypass roads, and the presence of peat  
mining.

Interpret and cut out features from the non-coded polygon of the 
Land layer that can be attributed to the Swampland land type. As you have 
no information about the subtypes of swamps, code them as Transitional 
(fig  6.41).

Fig. 6.41

Step 13. Perform the interpretation and cut out features of the Forests 
land type from the non-coded polygons of the Land layer. Use the rasters of 
composition of various bands of the Landsat ETM+ imagery as an auxiliary 
material.

As a subtype, use Without specifying of tree species composition, since you 
cannot judge the composition of the forests (fig  6.42). Remember that the 
main interpretation characteristic of forests is the texture.

Do the interpretation and cut out the land type Other wooded areas. For 
the subtype, use Tree-shrubbery vegetation (fig  6.43).
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Fig. 6.42

Fig. 6.43

Step 14. The main interpretation characteristics of arable land are: clarity 
of borders, certain geometric shape of the fields  texture of the image, color of 
the image. Carry out interpretation and extraction from non-coded polygons 
of the Land layer of the arable land. Use Arable land as a subtype, Cultivated 
land – as landtype (fig  6.44).
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Fig. 6.44

Step 15. Carry out interpretation and cut features of the Grassland 
(fig  6.45). Use Other waterlogged as a subtype, since you cannot judge the 
state of grassland from remote sensing data. Remember that the shape and 
size of the grassland plots are uncertain, since their borders are the borders 
of arable land, fallow land, forests, as well as topographical elements 
of the terrain, and the texture changes depending on the qualitative 
characteristics.

Fig. 6.45
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Step 16. Interpret the remaining non-coded lands in attributes as type 
Other land, subtype Other land (fig  6.46).

Fig. 6.46

Step 17. Check and edit the topology of the geodatabase “LIS-Klieck”. To 
do this, in the table of contents, enable the display ALLMS_Topology layer. 

Zoom the extent of the data frame to the Land layer. Using  the Validate 
Topology in Current Extent tool on the Topology toolbar, check the topology 
of GDB. Open the tool  Error Inspector. With the help of  Fix Topology 
Errors Tool select the extent of all layers. In the Error Inspector window there 
will appear topology errors (if any). Correct all errors. Save editing the GDB, 
saving all changes (Editor → Stop Editing). Save the project (File → Save).

Questions
1. List the basic sequence of steps for creating vector features by cutting out 

fragments of an existing polygon vector in the GIS ArcGIS.
2. What tool is used to make changes to the attributes of vectors in the GIS ArcGIS? 

How do geodatabase domains and subtypes work?
3. What is the workfl w for checking and editing a topology in the GIS ArcGIS? 

Where are topology errors stored?

3С. Correction of the Results of Visual Interpretation Based on the 
Field Interpretation

Purpose: to master the algorithms for editing vectors, their attributes, 
checking and editing the topology in the GIS ArcGIS using the example of 
correcting the results of visual interpretation based on the field interpretation.
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Exercise progress
Step 1. Open the ArcMap of the GIS ArcGIS. Open the Visual Interpretation 

of Land.mxd project created in task 3.1 and 3.2 (File → Open).
Step 2. Add a non-georeferenced raster Field survey_orthophotomap.tif to 

the project (use  the “Add data” icon). This raster, which is the territory of 
visual interpretation of land in the Klieck district of the Minsk region, presents 
the results of field interpretation. All polygonal features that require editing 
are marked with a violet contour on the raster and signed in red as compared 
to the visual interpretation carried out as part of task 3.2 (fig. 6.47).

Fig. 6.47

Step 3. Georeference the raster Field survey_orthophotoplan.tif using the 
coordinates of four points known on it (table 6.9). In the table of contents 
“Layers”, right-click the Field survey_orthophotoplan.tif layer and select Zoom To 
Layer. On the Georeferencing toolbar, in the Choose Georeferencing Layer setup, 
select the Field survey_orthophotoplan.tif raster to georeference.

Table 6.9
Raster corners X Y

Top left 466425.999 5865961.643
Top right 469060.353 5865977.094
Bottom right 469052.923 5863143.323
Bottom left 466429.674 5863142.250

Zoom the map extent to the desired corner, for example top left. On the 
raster, the border of the fragment of the Klieck district is marked with a blue 
outline. Place the initial control point on the corner of the blue contour on 



142

the raster (  the Add control points icon). A green crosshair will remain at 
the reference point. To set the coordinates of the final reference point, click 
with the right mouse button and select Input X and Y. In the Enter coordinates 
window, type the coordinates of the given corner of the raster (fig  6.48). After 
finishing entering  click OK.

Fig. 6.48

After performing this operation, the “Field survey_orthophotoplan.tif” 
raster will move to the fragment area of the Klieck district. In the table of 
contents, right-click the Field survey_orthophotoplan.tif layer and select Zoom 
To Layer. Repeat this algorithm of operations for the remaining corners of 
the “Field survey_orthophotoplan.tif” raster (fig  6.49).

After creating all control points, perform a raster transformation 
using the operation Georeferencing → Transformation order → Projective 
transformation. Create a georeferencing file by choosing Georeferencing → 
→ Update Georeferencing.

Step 4. Loading a transparent legend for the Land layer. Delete the Land 
layer from the project (right-click on the layer in the table of contents → 
→ Delete). Add the Land_transparent.lyr file to the project (to the LIS 
multiple layer) (use  the “Add data” icon). This file contains transparent 
symbolization for all types and subtypes of the Land layer.

Set the data source for the Land_transparent.lyr layer to the Land feature 
class of the LIS-Klieck geographic database. To do this, go to the Properties of 
the layer Land_transparent.lyr (RMB click on the layer → Properties), select 
the Source tab and press the Set data source button (fig  6.50).
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Fig. 6.49

Fig. 6.50

Step 5. Edit the features referred after field interpretation to another 
type and subtype of land to compare with visual interpretation. Such features 
signed in red on the “Field survey_orthophotomap.tif” raster. Start an editing 
session (Editor → Start Editing). Select the LIS-Klieck personal geodatabase 
for editing.

Set the table of contents “Layers” display option to  List By selection. 
Make selectable only the features in the Land layer.
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Use  the Select Features tool to select one of the features referred 
after field survey to a different land type and subtype compared to visual 
interpretation. Using  the Attributes tool on the Editor toolbar, select for 
this feature the required type and subtype of land (fig  6.51).

Fig. 6.51

In the same way, edit all features of the Land layer referred after fiel  
interpretation to a different type and subtype of land compared to visual 
interpretation. Analyze interpretational characteristics.

Step 6. Edit the features referred after field interpretation to a different 
land subtype compared to visual interpretation (land type has not changed). 
Such features have a signature in red of only the changed land subtype on 
the “Field survey_orthophotoplan.tif” raster. Using  the Select Features and 

 Attributes tools, assign these features to the desired subtype (fig  6.52). 
Analyze the interpretational characteristics.

Step 7. In the process of visual interpretation, some lands are quite 
difficult to identify. They are identified in the process of field interpretation, 
the results of which are their creation or editing in the Local LIS geodatabase.

To create features that belong to the Grassland land type, use the already 
familiar editing algorithm, which consists in cutting polygons.

On the Snapping toolbar, set the Vertex Snapping option. Also check the 
Snap to Sketch option by choosing Snapping → Snap to Sketch.

Use  the Select Features tool to select a feature in the Land layer, from 
which you need to cut a new one. Using  the Cut Polygons Tool on the 
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Editor toolbar and pressing the V key on the keyboard (allows you to see all 
the vertices of the existing vector features of the Land and Admi layers), start 
cutting the selected polygon, closing the first vertex of the sketch at the top 
of the selected polygon, the subsequent ones – within selected polygon and 
the last one at the top of the selected polygon (fig  6.53). Complete cutting 
the polygon by double-clicking on the last vertex of the sketch. After creating 
a new feature, encode  the Attributes which are necessary for it.

Fig. 6.52

Fig. 6.53
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Step 8. To create new features that belong to the Roads land type, Field and 
forest roads subtype, use the new editing algorithm, which consists in creating 
a new polygon and then clipping all existing ones in the layer along it.

Leave the Selections and Snapping options the same as in the previous 
step. In the Create Features window, select the layer to which the new features 
will belong. This layer will be the Land layer (Roads, Field and forest roads). For 
the Construction Tools, select Polygon. By pressing the V key on the keyboard 
(allows you to see all the vertices of the existing vector features of the Land 
and Admi layers), start creating a new polygon according to the fi ld survey 
materials and close on the vertices of the existing vector features of the Land 
layer. Complete the creation of the new polygon by double-clicking on the last 
vertex of the sketch (fig  6.54).

After creating the vector, you need to clip the newly created polygon from 
all the polygons that intersect it and belong to the edited layer.

To do this, use  the Select Features tool to select the newly created 
polygon (check in  the Attributes window that only this feature was selected, 
otherwise you will need to click RMB to execute Remove the selection, as shown 
in fig  6.55). To cut the created feature from the overlapping features, use the 
Clip tool (Editor → Clip). In the clipping parameters use Buffer distance – 0.000, 
when clipping features – Delete the area that intersects.

After the clipping process is completed, especially in cases where the 
intersection feature overlapped several polygons, compound polygon features 
can be formed (fig  6.56). Explode them into separate ones using the  
Explode Multipart Feature tool on the Advanced Editing toolbar (fig  6.57). After 
exploding, edit the attributes of these polygons, if necessary.

Fig. 6.54



Fig. 6.55

Fig. 6.56

Fig. 6.57
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Step 8. In the same way as in the previous step, create new features that 
belong to the Watercourses land type, Canals and drains subtype. To create 
features, use the editing algorithm, which consists in creating a new polygon 
and then clipping all existing o features in the layer along it (fig  6.58).

Fig. 6.58

Step 9. Check and edit the topology of the geodatabase “LIS-Klieck”. 
To do this, in the table of contents, enable the display ALLMS_Topology 
layer. Zoom the extent of the data frame to the Land layer. Using  the 
Validate Topology in Current Extent tool on the Topology toolbar, check 
the topology of GDB. Open the tool  Error Inspector. With the help 
of  Fix Topology Errors Tool select the extent of all layers. In the Error 
Inspector window there will appear topology errors (if any). Correct all 
errors. Save editing the GDB, saving all changes (Editor → Stop Editing). 
Save the project (File → Save).

Step 10. Load a color legend for the Land layer. To do this, delete the Land 
layer from the project (right-click on the layer in the table of contents →  
→ Delete). Add the Land_color.lyr file to the project (use  the Add Data 
icon). This file contains color symbolization for all types and subtypes of 
the Land layer. Set the data source for the Land_color.lyr layer to the Land 
feature class of the LIS-Klieck geographic database. To do this, go to the 
Properties of the Land_color.lyr layer (click the right mouse button on the 
layer → Properties), select the Source tab and press the Set data source button 
(fig  6.59). Save the project (File → Save).
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Fig. 6.59

Questions
1. List the main interpretational characteristics of land types.
2. What is the difference between georeferencing a raster to a vector layer and 

using points on a raster with known coordinates?
3. List the main sequence of operations for creating a new vector feature; clipping 

a fragment from an existing vector; creating a new one and clipping it to all existing 
ones in the GIS ArcGIS.

Exercise 4. Automated Classification of Land Classes Using Multizone 
Satellite Images.

Purpose of the exercise: to master the technique of automated 
classification of land classes based on materials of multizone satellite 
information using the GIS ArcGIS (on the example of a fragment of the 
territory of the Klieck district of the Minsk region).

Initial data:
• a feature class of GDB «Automated_classification» containing the border 

of a fragment of the territory of the Klieck district (Border);
• a raster data set of GDB «Automated_classification» containing a 

composition of “artificial colors” (4, 3 and 2 bands) of a multizone satellite 
image Landsat 7 ETM+ (432);

• a raster data set of GDB «Automated_classification» containing a 
fragment of the territory of the Klieck district, refle ting the actual state of 
the land fund in the context of land classes (data obtained as a result of a 
field su vey) (land).
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Exercise progress
Step 1. Open the ArcMap of the GIS ArcGIS. Create an “Automated land 

classification  project. To do this, use the Save As option on the File menu. 
Save the project in your folder.

Step 2. Add to the project a raster data set of GDB «Automated_
classification» containing a composition of “artificial colors” (4, 3 and 2 bands) of 
a multizone satellite image Landsat 7 ETM+ (432) using  the “Add data” icon.

Step 3. Go to the menu Customize → Extensions and check the box for the 
Spatial Analyst extension. Open the Image Classifi ation toolbar (Customize → 
→ Toolbars → Image Classification)  fig  6.60.

Fig. 6.60

Step 4. On the Classifi ation toolbar, enable  Training Sample Manager. 
Using  the Draw Rectangle tool, create a training sample that displays 
on the composition of “artificial colors” (4, 3 and 2 bands) of a multizone 
satellite image Landsat 7 ETM+ (432) the Arable land class (turquoise color 
in the image). In the “Training Sample Manager” window, write “Arable” in 
the Class Name field  select orange in the Color field (fi  6.61).

Fig. 6.61
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Create a series of training samples for arable land, and then combine them 
with the one class already created earlier by selecting them all and clicking the 
button  Merge training samples in the window “Training Sample Manager”.

Step 5. Using the algorithm described above, create training samples 
for other land classes (groups of classes): grassland (red color in the image); 
woodland and scrubland (wine-colored); land under water objects (black); land 
under roads and other transport communications, land under streets and other 
public spaces, building land (green-blue). In the Class Name field  assign names 
to them according to fig  6.62. In the Color box, select the appropriate colors.

Fig. 6.62

Step 6. Save the training samples as a feature class in the GDB 
«Automated_classification» using the Save Training Samples in the Training 
Sample Manager window.

Step 7. Perform an automated classification of land classes (groups 
of classes) in the fragment of the Klieck district using the maximum 
likelihood method, fig  6.63. Use the Interactive Supervised Classifi ation tool 
(Classification → Interactive Supervised Classification) to do this

Step 8. Close the “Training Sample Manager” window and click the Clear 
Training Samples button on the toolbar “Classification .

Save the raster of classification results in the GDB «Automated_
classification»  To do this, right-click on the “Classification_432  layer and 
select Data → Export Data. In the “Export raster data” window, in the Location 
field  specify the location in the GDB «Automated_classification»  in the Name 
field  leave “Classification_432  as the file name. After that click OK. The saved 
raster will be automatically added to the project. Delete the unsaved raster.



152

Fig. 6.63

Step 9. Add a raster of a fragment of the territory of the Klieck district 
to the project, refle ting the actual state of the land fund (data obtained as 
a result of a field survey), using the icon  “Add data” (fig  6.64). Download 
the layer legend. To do this, go to “Layer Properties” (right-click on the layer 
in the table of contents → Properties) and select the “Symbology” tab. Select 
“Unique Values” and click the “Import” button. Select the land.lyr legend for 
the raster from the source data folder.

Fig. 6.64
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Visually compare the results of the automated classification with data on 
the actual state of the land fund.

Step 10. Evaluate the accuracy of the automated classification  Create a 
point vector containing 100 random points within the fragment of the Klieck 
district for which the assessment will be made. To do this, open the ArcToolbox 

, find the Create Randomly Placed Points tool (Data Management →  
→ Sampling → Create Random Points). In the tool window, under Output 
Location select the GDB «Automated_classification»  designate “Points” as the 
Output point feature class, choose “Same as layer land” as Constructing Extent, 
Number of points – 100, Minimum Allowable Distance – 10 m (fig  6.65).

Fig. 6.65

Step 11. For each randomly generated point, obtain the values of the land 
classes (groups of classes) according to the field survey data (raster land) and 
according to the results of automated classification (raster Сlassifi ation_432). 
Open the ArcToolbox  , find the Sample tool (Spatial Analyst Tools →  
→ Extraction → Sample). In the Tool window, select the “land” raster as the 
Input rasters, as well as the “Classifi ation_432”. As Input location raster or point 
features, select Points layer, Save the Output table in the GDB «Automated_
classification» under the name “Accuracy_assessment” (fig  6.66).

After the necessary calculations the table Accuracy_assessment will be added 
to the project. Open the table (right-click on the table → Open). In the table, for 
each point, the code of the type (group of types) of lands from the “land” raster, 
as well as from the “Classification_432  raster (fig  6.67) is entered. Codes of 
types (groups of types) of lands can be specified by opening the attribute table 
of the corresponding raster (right-click on the raster → Open attribute table).
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Fig. 6.66

Fig. 6.67

Step 12. To assess the accuracy of automated classification  it is necessary 
to create an error matrix (an example of an error matrix is given in table 6.10).

According to the error matrix, you can judge the reliability of each specifi  
feature (class) and the reliability of classification as a whole. In matrix the 
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number of correctly classified feature s of a certain class and the number 
of features assigned to one class or another for some reason are indicated. 
The criterion for the quality of classification as a whole is the proportion of 
correctly classified features. It is calculated by dividing the sum of correctly 
classified features located along the diagonal of the matrix by the number of 
all checked features. It is 67% for the data given in table 6.10:

(28 + 32 + 3 + 1 + 3) / 100 = 67 %.
In addition, one can calculate the reliability of classification of each of 

the features (classes). Thus, the ratio of the number of correctly classifie  
features of the arable land class (28) to the sum of all features classified to 
this type (50) characterizes the reliability of classification this class (5  %).

After creating an error matrix for automated classification  evaluate the 
reliability of classification of each land class and determine the main reasons 
for the incorrect recognition of some features.

Table 6.10

Field Survey Result
(raster «land»)

Classification result ( Classification_432  raster)
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Arable 28 20 0 0 2 50 56
Grassland 0 32 0 0 1 33 97
Woodland and scrubland 0 1 3 0 0 4 75
Under water objects 0 0 0 1 0 1 100
Under roads and other 
transport communications, 
land under streets and other 
public spaces, building land

5 4 0 0 3 12 25

Total 33 57 3 1 6 100 67

After the necessary calculations the table Accuracy_assessment will be 
added to the project. Open the table (right-click on the table → Open). In 
the table, for each point, the code of the type (group of types) of lands from 
the “land” raster, as well as from the “Classification_432  raster (fig  6.67) is 
entered. Codes of types (groups of types) of lands can be specified by opening 
the attribute table of the corresponding raster (right-click on the raster →  
→ Open attribute table).
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Questions
1. List the main sequence of steps for the automated classification of land classes 

based on multizone satellite images in the GIS ArcGIS.
2. How are different land classes displayed on the composition of “artificial colors” 

(4, 3 and 2 bands) of a multizone satellite image Landsat 7 ETM+?
3. List the main sequence of steps for evaluating the accuracy of automated 

classification results

Exercise 5. Creation of Plans of Boundaries of Land Plots in GIS Based 
on Geodetic Surveys.

Purpose of the exercise: to study the algorithms of processing of 
geodetic survey data in GIS ArcGIS using the example of creating a plan of the 
boundaries of land plots of the gardening community “Mayak” (GC “Mayak”).

Initial data:
• a shape-file containing geodetic points of the state geodetic network, 

which served as reference points for laying the theodolite traverse through 
the GC “Mayak” (polygonometry_points.shp);

• a shape-file ontaining traverse points (traverse_point.shp);
• a shape-file ontaining the sides of the traverse (traverse_sides.shp);
• a shape-file containing additional geodetic points, measured by the 

polar method from the points of the traverse, necessary to determine the 
turning points of the boundaries of the land plots in places of their difficult
visibility from the points of the traverse (additional_points.shp);

• a shape-file containing the turning points of the boundaries of the land 
plot of GC “Mayak” and the citizens’ plots, measured by the polar method 
from the points of the traverse and the additional geodetic points (turning_
points.shp);

• a shape-file containing polar links of tacheometric survey (polar_links.shp).
• GDB Gardening_community.mdb containing feature classes Gardens 

(it will be used for creation of the land plot polygon of the GC “Mayak”), 
Lots1 (the turning points of the boundaries of the land plot of GC “Mayak”, 
the turning points of citizens’ plots and the turning points of public lands), 
Lots2 (external boundary of the GC “Mayak”, boundaries of citizens’ plots, 
boundaries of public lands), Lots3 (GC plot, citizens’ plots, public lands). 
Feature classes participate in topology (table 6.11).

Table 6.11

Features of feature class Rule Feature class

Gardens Must Not Overlap

Gardens Must Be Covered By Lots2

Gardens Boundary Must Be Covered By Lots3



157

Features of feature class Rule Feature class

Lots2 Must Be Covered By Boundary Of Lots3

Lots2 Must Not Have Dangles

Lots2 Must Not Self-Intersect

Lots2 Must Not Self-Overlap

Lots2 Must Be Single Part

Lots2 Must Not Intersect Or Touch Interior

Lots2 Endpoint Must Be Covered By Lots1

Lots3 Must Not Overlap

Lots3 Boundary Must Be Covered By Lots2

Lots3 Must Be Covered By Feature Class Of Gardens

Exercise progress
Step 1. Open the ArcMap of the GIS ArcGIS. Open the Mayak.mxd project. 

Repair data sources for project layers (these operations are necessary when 
the project files have been moved to another location on the hard disk or to 
another disk). Repair data source for the layers of the Geodetic survey group 
layer to shp-files of the same name (right-click on the layer → Data → Repair 
Data Source), fig.re 6.68. For the layers of the Gardening_community group layer, 
also set the sources to the feature classes of the same name from the feature 
dataset Garden in the Gardening_community GDB.

Fig. 6.68

Step 2. Explore the spatial data of the geodetic survey of the gardening 
community “Mayak” (fig  6.69).

The work on establishing the boundaries of the land plot of GC “Mayak” 
was carried out in accordance with the requirements of. The external boundary 

End of the table 6.11
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of the GC “Mayak” was surveyed by the polar method from the points of the 
theodolite traverse. Polygonometry points 8422 and 9338 served as reference 
points for the position of the traverse. Horizontal angles and line lengths were 
measured with a Trimble 3305DR station. The turning points of citizens’ plots 
and public lands were measured by the polar method from the points of the 
theodolite traverse and from additional geodetic points.

Fig. 6.69

The data of geodetic measurements were imported into the CREDO_
DAT program of the CREDO software from a Trimble 3305DR station. This 
program allows for automated cameral processing of field geodetic data. 
Initially, the theodolite traverse was adjusted. The absolute discrepancy 
was 0.420 m, the relative error was 1:2000, the angular discrepancy was 7.0//, 
while the allowable error was 20.0//. Then, the coordinates of the turning 
points of the external boundary of the GC “Mayak”, citizens’ plots and public 
lands were calculated.

All survey data were exported from CREDO_DAT in the GIS ArcGIS as 
shp-files (in the Mayak.mxd project they are placed in the Geodetic survey 
multiple layer).

Step 3. Create a land plot of the GC “Mayak” based on the data of geodetic 
survey.

Select the turning points of the external boundary of the GC “Mayak” from 
the “turning_points” layer. Open the attribute table for this layer (right-click 
on the layer in the table of contents → Open Attribute Table). Click the  
Table Options button and select the Select By Attributes tool (fig  6.70, a).  
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In the window Select by Attributes that will open, form the query “Boundary” 
= ‘Turning point of the boundaries of the land plot of GC “Mayak”’.

To do this, double-click on the field of the attribute table “Boundary”, 
then on the operator “=” and on the “Turning point of the boundaries of the 
land plot of GC “Mayak” (use the button Get Unique Values) (fig  6.70, b). Then 
click the Apply button. As a result of the selection, all turning points of the 
external boundary of the GC “Mayak” will be selected.

         
                           a  b  

Fig. 6.70

Export the turning points of the external boundary of the GC “Mayak” 
from the “ turning_points “ layer to a separate shp-file  Close the attribute 
table of the layer (note that features selected by attributes remain selected 
in the view). Export the selected data to a separate feature class in the GDB 
“Gardening_community” by right-clicking on the “turning_points” layer, 
then Data → Export Data (fig  6.71). Save the data using the same coordinate 
system as this layer’s source data. Name the new feature class as Turning_
points_external_boundary in the GDB “Gardening_community”. Agree to add 
the exported data to the project. Also, deselect the features in the “turning_
points” layer using the menu Selection → Clear Selected Features.

Label the layer just added to the data frame, Turning_points_external_
boundar. Go to Layer Properties (right click on layer → Properties). Go to the 
Labels tab, in the Labels tab check the box Label features in this layer, select 
Boundary_N as the label field and symbolize the labels in a font and size 
convenient for you (fig  6.72).

Turn off the display of the Geodetic survey group layer and hide its legend.
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Fig. 6.71

Fig. 6.72

Create a vector polygon feature of the external boundary of the GC 
“Mayak” in the Gardens layer using its turning points. To do this, use the 
tools of the Editor panel.

Start  the editing  session (Editor → Start Editing). Select the GDB 
“Gardening_community” for editing. In the Create Features window (appears 
automatically after the start of an editing session), select the layer to which 
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the new features will belong. This layer will be the Gardens layer. For the 
Construction Tool, choose Polygon.

Since you will be creating a new feature based on another layer, it is 
necessary that the vertices of the sketch of the new feature correspond to the 
points of the Turning_points_external_boundar layer. To do this, set the option 
Point Snapping on the Snapping toolbar.

Now you can start creating a vector polygon feature of the external 
boundary of the GC “Mayak”. Zoom in the extent of the data frame around the 
first turning point of the boundaries of the land plot of GC “Mayak” and lock 
on it (click with LMB). Continue snapping to turning point of the boundaries 
of the land plot by making one click with LMB. If you put the vertex of the 
sketch in the wrong place it can be deleted by clicking RMB near the vertex 
and selecting Delete Vertex. It is necessary to double click the last point with 
LMB. Stop your editing session (Editor → Stop Editing) (fig  6.73).

Fig. 6.73

Step 4. Select the turning points of arrays of citizens’ plots from the 
“turning_points” layer (attribute field “Arrays”, values “Turning point of the 
boundaries of citizens’ plots. Array 1” – “Turning point of the boundaries of 
citizens’ plots. Array 8”). Export the selected data to a separate feature class 
in the GDB “Gardening_community”. Name the new feature class as Turning_
points_arrays_citizens_plots. Agree to add the exported data to the project. Also, 
deselect the features in the “turning_points” layer using the menu Selection → 
→ Clear Selected Features. Turn off the display of the Survey multiple layer 
and hide its legend. Label the features of the “Turning_points_arrays_citizens_
plots” according to the field Arrays_N.
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Open the attribute table of the layer “Turning_points_arrays_citizens_plots”. 
Perform a selection of the turning points of the array of citizens’ plots No. 1 
from the layer (attribute fiel  – Arrays, value – Turning point of the boundaries 
of citizens’ plots. Array 1). Close the attribute table.

Create a vector polygon feature of the array of citizens’ plots No. 1 in the 
Lots3 layer using its turning points. To do this, start editing the personal GDB 
“Gardening_community”. In the Create Features window, select the layer to which 
the new features will belong. This layer will be the Lots3 layer. For the Construction 
Tool, choose Polygon. Zoom in the extent of the data frame around the turning 
points of the array of citizens’ plots No. 1 and create a polygon (fig  6.74). In 
the Attributes window of the newly created feature, in the Name field  write its 
name – “Array of plots 1”.

By analogy, create in the Lots3 layer the remaining arrays of citizens’ plots 
based on geodetic survey. In the attribute table field Name of the Lots3 layer, 
specify the names of the arrays. After creating all the plots, end the edit session 
saving the changes.

Label the features of the Lots3 layer. To do this, go to the properties of this 
layer. On the Fields tab, click the button Number Format to change the number 
format of the SHAPE_Area field  Set rounding to 0 decimal places. Now the area 
values (in m2) of citizens’ plots will be rounded to integers. Go to the Labels 
tab. Check the box Label features in this layer and click the Expression button. 
Create the expression [Name]&VBnewline&[SHAPE_Area]. The ‘VBnewline’ 
part of the expression is keyboard-typed and means “from a new line”, & is 
also keyboard-typed and means “and”. Using this expression the labels of the 
layer will consist of two lines: the top line – the name of the array of citizens’ 
plots, the bottom – the area in m2 (fig  6.75).

Fig. 6.74
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Fig. 6.75

Step 5. Close the Mayak.mxd project saving the changes. Open the 
ArcCatalog of the GIS ArcGIS.

Create a linear feature class Lots2 (external boundary of the GC “Mayak”, 
boundaries of citizens’ plots, boundaries of public lands) based on the created 
polygons of the GC plot and arrays of citizens’ plots. To do this, use the GIS 
tool to convert polygonal features to linear features.

Open the ArcToolbox . Open the Feature to Line tool (Data Management 
Tools → Features → Feature to Line). In the tool window, in the Input Features 
section, select the Gardens polygon feature class of the GDB “Gardening_
community”. Save the Output Feature Class in the same database as Gardens_
FeatureToLine.

Repeat this GIS-tool for the polygonal feature class Lots3. After the 
necessary calculations, the program will create a line feature class Lots3_
FeatureToLine in the GDB “Gardening_community”.

The next task is to split two linear feature classes “Gardens_
FeatureToLine” and “Lots3_FeatureToLine” into a set of separate lines. To 
do this, open the ArcToolbox tool Split Line at Vertices (Data Management → 
→ Features→ Split Line at Vertices). In the tool window, in the Input Features, 
select the “Gardens_FeatureToLine” feature class. Save the Output Feature 
Class in the GDB “Gardening_community” as Gardens_FeatureToLine_
SplitLine.

Repeat this GIS-tool for the linear feature classes “Lots3_FeatureToLine”. 
After the necessary calculations, the program will create a line feature class 
Lots3_FeatureToLine_SplitLine in the GDB “Gardening_community”.
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Load the created linear features into the “Lots2” class. To do this, right-
click on this feature class in the GDB “Gardening_community”, select Load →  
→ Load Data. Select the class “Gardens_FeatureToLine_SplitLine” as input 
data, click the Add button, leave the following loading steps as default. Repeat 
this process to load the “Lots3_FeatureToLine_SplitLine” class into the “Lots2” 
feature class.

Step 6. Create a point feature class Lots1 (the turning points of the 
boundaries of the land plot of GC “Mayak”, the turning points of citizens’ 
plots and the turning points of public lands). To do this, load into this class 
of spatial features from the classes “Turning_points_external_boundary” and 
“Turning_points_arrays_citizens_plots” of the GDB “Gardening_community”. 
Right-click the “Lots1” feature class, choose Load → Load Data. Select the 
input data “Turning_points_external_boundary”, click Add. Set the matching 
of the target field and the sour e field (fi  6.76, a).

Similarly, load into the “Lots1” feature class the point features from the 
“Turning_points_arrays_citizens_plots” class. Set the matching of the target 
field and the sour e field (fi  6.76, b).

  
                          a  b

Fig. 6.76

Step 7. Create a public lands polygon by erasing the Lots3 feature class 
from the Gardens class. To do this, use the ArcToolbox Erase tool (Analysis 
Tools → Overlay → Erase). In the tool window, in the Input Features section, 
select the “Gardens” feature class of the GDB Gardeners, in the Erase Features 
section, select the “Lots3” class. Save the output feature class in the Gardeners 
database under the name Public_lands.

Step 8. Close the ArcCatalog. Open the ArcMap of the GIS ArcGIS, project 
“Mayak.mxd”.

The loaded data appeared in the layers Lots1 and Lots2.
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Add the “Public_lands” feature class from the GDB “Gardening_
community” to the project on the Gardening_community group layer using 
the “Add data” icon.

Step 9. Symbolize the layers of the Gardening_community group layer. 
Right-click on the “Public_lands” layer, open layer Properties. Select the 
Symbology tab and set the layer’s display option to “Features: Single Symbol”. 
Click on the icon of the symbol and select for it “Fill color” – Olivine Yellow, 
“Outline Color” – no color, “Outline width” – 0.

Symbolize the rest of the layers (Lots1, Lots2, Lots3, Gardens). For the “Lots3” 
layer, select “Fill Color” – no color, “Outline Width” – 1, “Outline Color” – Black.

For the “Lots2” layer, set Color to Black and Width to 1.
Layer “Lots1” symbolize as follows: “Category” – Circle 2, “Color” – Red 

Mars, “Size” – 5; “Gardens” layer – “Fill color” – no, “Outline width” – 1.5, 
“Outline color” – Black.

Step 10. Label features in layers. In the layer properties go to the Labels 
tab. Label the features of the “Lots1” layer by the field Number_(font – Arial, 
size – 8, color – Mars red); “Lots2” layer – by the SHAPE_Length field (in the 
“Fields” tab, set rounding to 2 decimal places, pad with zeros; Arial font, size – 
8, color – black. “Lots3” layer will be labeled with the expression composed in 
step 4; Arial font, size – 10, color – Amethyst.

Step 11. In the Data Frame Properties window (View → Data Frame Properties) 
on the Data Frame tab, set the map to Fixed scale equal to 1:1000 (fig  6.77).

Fig. 6.77
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Step 12. Convert layer labels (Lots1, Lots2, Lots3) to annotation. To do 
this, right-click on the layer and select Convert Labels to Annotation. In this 
way, you will be able to transform interactive labels into stable graphics. Save 
annotation in the map document (fig  6.78).

Fig. 6.78

Move the labels using the Select Elements  tool located on the main 
toolbar so that they do not overlap with other labels and vector features. Try 
to place the numbers of the turning points turning points of arrays of citizens’ 
plots inside the arrays, lengths of the external boundary of the GC “Mayak”, 
arrays of citizens’ plots – on the outside, the numbers of the turning points of 
the boundaries of the land plot of GC “Mayak” – also on the outside (fig  6.74).

Fig. 6.79
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Step 13. Layout the plan for the boundaries of the land plot of GC 
“Mayak”. To do this, go to “Layout View” (View → Layout View). In the 
“Page and Print Setup” menu (File → Page and Print Setup), set the A2 paper 
size for the plan. Use the option Use Printer Paper Setting for map page size 
(fig  6.80).

Fig. 6.80

Using the  Select Elements tool, stretch the data frame page size. Using 

the tool  Move, place the land plot of the GC “Mayak” in the center of the 
sheet.

Using the   Text tool located on the Drawing toolbar, create the text 
Plan of the boundaries of land plots of the gardening community “Mayak” (font 
Arial, size – 28, color – black). Use the  Select Elements tool to move the 
created label to the top center.

Similarly, create a text (font Arial, size – 20, color – black) (fig  6.81):
The total area of the gardening community is 5.84 hectares.
The area of land for common use is 1.46 ha.
The area of land of the members of the community is 4.38 hectares.
Insert the scale text in the bottom center of the map sheet (Insert → Scale 

text). Use font Arial, size 26, color black.
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Fig. 6.81

Create a legend of map (Insert → Legend). Define the layers “Lots1”, 
“Lots3”, and “Public_lands” as legend points. Rename the specified layers 
(right-click on the layer → Properties → General tab → Layer name). Rename 
the “Lots1” layer Turning points of the boundaries of the land plots, “Lots3” – 
Land plots, “Public_lands” – Public lands.

Questions
1. List the basic steps to create a layout maps and their design in the GIS ArcGIS.
2. What operations of converting vector features from one type to another (for 

example, a polygon to a line) are possible in the GIS ArcGIS? In what cases is this 
necessary?

3. What overlay operations can be performed in the GIS ArcGIS? For what purposes 
are they used?

Exercise 6. Creation of Plans of Boundaries of Land Plots of Gardening 
Communities Using Cartographic Materials.

Purpose of the exercise: to study the algorithms of working with scanned 
cartographic materials in the GIS ArcGIS for creating a plan of the boundaries 
of the land plots of the gardening community “Zarya” (GC “Zarya”).

Initial data:
• GDB Gardening_community.mdb containing feature classes Gardens, 

Lots1, Lots2, Lots3, topology Gardens_Topology. The structure and content of 
the GDB are similar to those used in task 5;

• a scanned “Plan of the boundaries of the land plots of the gardening 
community “Zarya” (Plan_Zarya.tif);
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•  a catalogue of coordinates of the turning points of the boundaries of 
the land plot of GC “Zarya” (table Turning_points in the database “GC_Zarya.
mdb”).

Exercise progress
A member of the GC “Zarya” Nadezhda Ivanova wants to get her land plot 

No. 168 in the GC “Zarya” into private ownership. The chief specialist of your 
organization visited the archive of the Department of Land Resources and 
Land Management and discovered that it contains Materials on establishing 
boundaries and preparing catalogs of coordinates in order to issue title 
documents for the public lands of the GC “Zarya” (1988). In these materials 
there are a Catalogue of coordinates of the turning points of the boundaries 
of the land plot of GC “Zarya” and a Plan of the boundaries of the land plots of 
the GC “Zarya”. From the point of view of economic feasibility, these materials 
turn out to be sufficient for filing the case Materials on the transfer of land 
plot No. 168 to private ownership, since there have been no changes in the 
external boundary of the GC “Zarya” and the boundaries of citizens’ plots 
since the boundaries were established by the geodetic method in 1988. The 
chief specialist of the organization instructed you to carry out this task. At 
the first stage, you scanned the “Plan of the boundaries of the land plots of 
the gardening community “Zarya” (Plan_Zarya.tif) and using the Microsoft 
Access program created the database GC_Zarya.mdb” with the table “Turning_
points”, in which the coordinates of the turning points of the boundaries of 
the land plot of GC “Zarya” were entered.

Step 1. Open the ArcMap of the GIS ArcGIS. Create a “Zarya” project. 
To do this, use the Save As option on the File menu. Save the project in your 
folder.

Add the “Garden” feature dataset to the project from the GDB “Gardening_
community” using  the “Add data” icon. Four layers (Lots1, Lots2, Lots2, 
Gardens) and a topology (Garden_Topology) will be added to the project.

Symbolize the added layers as shown in fig  6.82.

Fig. 6.82
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Step 2. Add the turning points of the boundaries of the land plot of 
GC “Zarya”, surveyed using the geodetic method, by performing the Add XY 
Data operation in the File → Add data → Add XY Data menu. In the “Add 
XY Data” window, select the “Turning_points”| table from “GC_Zarya.mdb” 
database. Define the fields of the “Turning_points” table containing the X 
coordinate and the Y coordinate. Set the coordinate system to “WGS_1984_
UTM_Zone_35N”, it is located in the Projection Coordinate Systems → Utm → 
→ WGS 1984 → Northern Hemisphere → WGS_1984_UTM_Zone_35N section 
(fig  6.83). As a result, a point layer Turning_points Events will appear in the 
data frame. Zoom the data frame to this layer.

Fig. 6.83

Step 3. Copy the features of the “Turning_points Events” layer to the Lots1 
layer. To do this, go to the attribute table of the “Turning_points Events” layer 
(right-click on the layer in the table of contents → Open Attribute Table). Press 
the Table Options button and select the Select All tool. After the selection, 
close the attribute table.
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Start an editing session (Editor → Start Editing). Select to edit the GDB 
“Gardening_community.mdb”. Execute Edit → Copy. Now all features of the 
“Turning_points Events” layer are copied to the clipboard. Finish editing 
session, then start it once again. Paste these features using the Edit → Paste 
command. In the Paste window, select “Lots1” as the Target Layer.

Deselect all features (Selection → Clear Selected Features). Open the 
attribute table for the Lots1 layer. Note that in addition to the features 
themselves, their attributes were also copied. Assign the values of the 
“OBJECTID” field to the “Number_” field  Right-click on the field name 
“Number_” and select Field Calculator. In the “Field Calculator” window, 
define the assignment by the “Number_” field of the values of the OBJECTID 
field (fi  6.84).

Fig. 6.84

Close the attribute table for the “Lots1” layer. Save your edit changes 
(Editor → Save Edits). Delete the “Turning_points Events” layer from the 
project (right-click on the layer → Remove).

Step 4. Go to the “Properties” layer “Lots1”. In the “Labels” menu, check 
the Label features in this layer function, select the “Number_” label fiel  
and symbolize the labels with a font and size that is convenient for you 
(fig  6.85).
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Fig. 6.85

Step 5. Create a polygon feature of the land plot of the GC “Zarya” in 
the Gardens layer using the turning points of the external boundary of the 
GC located in the “Lots1” layer. To do this, in the Create Features window, 
select the layer to which the new features will belong. This layer will be the 
Gardens layer. For the Construction Tool, select Polygon.

Since you will be creating a new feature based on another layer (Lots1), 
then you need the vertices of the sketch of the new feature to correspond 
to the points of this layer. To do this, set the option Point Snapping on the 
Snapping toolbar.

Zoom the extent of the data frame in the area of the first turning poin  
of the external boundary of the GC and lock on this point (click with the 
left mouse button). Continue Snapping to each subsequent point of the 
layer “Lots1” by making one click with LMB. Double click on the last point 
with LMB.

Using  the Attributes window specify the name of the created 
polygonal feature in the “Name” fiel  – GC “Zarya”. Label the “Gardens” layer. 
On the |Fields tab click on the button to change the number format of the 
SHAPE_Area field  In the “Number Formats” window, set rounding to Number 
of decimal places – 0. Now area values (in m2) will be rounded up to integers. 
Go to the Labels tab. Check the box next to Label features of this layer and click 
the Expression button. Create the expression [Name]&VBnewline&[SHAPE_
Area].

Stop the editing session (Editor → Stop Editing) (fig  6.86).
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Fig. 6.86

Step 6. Add a scanned “Plan of the boundaries of the land plots of the 
gardening community “Zarya” (Plan_Zarya.tif), using the icon “Add data.”

Open the Georeferencing toolbar (Customize → Toolbars → Georeferencing).
In the Georeferencing toolbar, choose the georeferencing layer – “Plan_

Zarya.tif”. Then perform the operation Fit to Display (Georeferencing → Fit to 
Display). Thus you will move the “Plan_Zarya.tif” raster to the desired area. 
In addition, tick the option (Georeferencing → Auto Adjust).

Perform a georeferencing of the raster “Plan_Zarya.tif” to the turning 
points of the boundaries of the land plot of GC “Zarya” located in the “Lots1” 
layer. On the Snapping toolbar, set the Snapping to points option.

Zoom the extent around the location of the 42nd turning point of the 
boundaries of the land plot of GC “Zarya” on the raster. Click the  Add 
Control Points icon on the Georeferencing toolbar. After clicking the icon, the 
cursor will turn into a crosshair. Place the cursor on the turning point on the 
raster and click with the left mouse button. A green crosshair will remain at 
the control point.

Find the equivalent turning points of the boundaries of the land plot of 
GC “Zarya” in the “Lots1” layer. Move the cursor to the corresponding control 
point of the vector layer. Once the Snapping option is enabled, click on it. The 
raster image will shift and the control point on the raster and on the vector 
layer will be connected.

Continue georeferencing the raster by turning points 44, 8 and 20. This 
is necessary for the raster to have control point on different sides, otherwise, 
if you perform the georeference sequentially from the 1st to the 87th point, 
severe raster distortion may occur.
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Do the same for other control points representing the turning points of 
the boundaries of the land plot of GC “Zarya” (fig  6.87). Snap option can be 
turned on and off.

Fig. 6.87

In case of an error, you can also delete link by opening the window  
View Link Table on the Georeferencing toolbar. After creating all control 
points, perform a raster transformation using the operation Georeferencing → 
→ Transformation → Projective Transformation. Perform the operation 
Georeferencing → Update Georeferencing

Step 7. Start an editing session (Editor → Start Editing). Select GDB 
“Gardening_community.mdb” for editing.

Set the option Point Snapping on the Snapping toolbar. In the Create 
Features window, select the layer to which the new features will belong. This 
layer will be the Lots3 layer. For the Construction Tool, select Polygon.

Zoom the extent around the array of land plots No 166, 167, 168 and create 
polygon of this array snapping on the turning points of the boundaries of the 
land plot of GC “Zarya” (fig  6.88).

Set the Tables of contents “Layers” display option  List By Selection. 

Make only the objects in the Lots3 layer selectable. Using the tool  Select 
Features, select the newly created polygon.

Using  the Cut polygons tool on the Editor toolbar and pressing the V 
key on the keyboard (allows you to see all the vertices of the existing vector 
features), cut the array into parts corresponding to land plots (fig  6.89).
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Fig. 6.88

Fig. 6.89

In the same way, create land plots of neighboring array located to the 
east (fig  6.90).

With the creation of land plots in the southernmost array of the 
GC “Zarya” let’s do it in a different way. Using the Create Features window, 
create one land plot in this array (fig  6.91).
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Fig. 6.90

Fig. 6.91

Next, using the AutoComplete Polygon in “Construction tool” section in 
the Create Features window, create a land plot nearby, closing only on the 
common vertices of the adjacent polygon (fig  6.92). Thus, create all plots 
within this array. If necessary, enable the Vertex Snapping and Edge Snapping 
options on the Snapping toolbar.

After creating the plots, write in the  Attributes window in the Plot_N 
field the number of each land plot according to their internal numbering in 
the gardening community.
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Label the features of layer “Lots3” (fig  6.93). To do this, go to the 
properties of this layer. On the Fields tab, click the button to change the 
numeric format of the SHAPE_Area field  In the “Number Formats” window, 
rounding to Number of  decimal places – 0. Area values (in m2) will be 
rounded up to integers. Go to the Labels tab. Check the box next to Label 
features of this layer and click the Expression button. Create the expression 
[Parsel_N]&VBnewline&[SHAPE_Area].

Fig. 6.92

Fig. 6.93
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Step 8. Based on the land plots of the “Lots3” layer, create their 
boundaries in the “Lots2” layer. To do this, go to the attribute table of the 
“Lots3” layer (right-click on the layer in the table of contents → Open attribute 
table). Press the Table Options button and select the Select All tool. After the 
selection, close the attribute table.

Press Edit → Copy. Now all features of the “Lots3” layer are copied to the 
clipboard. Finish editing session, then start it once again. Paste these features 
using the Edit → Paste command. In the Paste window, select “Lots2” as the 
Target Layer. Deselect all features (Selection → Clear Selected Features).

Now you need that each segment of the boundary to be a separate line. 
To do this, you need to split all the lines were they intersected. Go to the 
attribute table of the “Lots2” layer and select all features of this layer (Table 
options → Select All). Once selected, click the tool  Planarize Lines on the 
Advanced Editing toolbar (Editor → More Editing Tools → Advanced Editing).

Label the “Lots2” layer with the SHAPE_ Length field  On the Fields tab, 
click the button to change the numeric format of the SHAPE_ Length field  
In the “Number Formats” window, rounding to Number of decimal places – 2. 
Check Pad with zeros. Now all line lengths (in m2) of land plots will be rounded 
to two decimal places (fig  6.94).

Fig. 6.94

Due to the fact that not all sides of the boundaries of land plots have a 
intersection with each other (first of all, these are the extreme sections of 
the arrays), it is necessary to perform their splitting in manual mode. To do 
this, set the display option “Tables of contents” to  List By selection. Make 
selectable only the features in the layer “Lots2”. Using the Select Features   
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tool, select the side of the plot boundary where the segments were not 
completely split automatically. Split sides of the plot boundary with the  
Explode Tool on the Editor toolbar.

Step 9. Create the turning points of the boundary of the land plot No. 168, 
owned by citizen Nadezhda Ivanova. In the Create Features window, select 
the layer to which the new features will belong. This layer will be the Lots1 
layer. For the Construction Tool, select Point.

After creating features, write in the  Attributes window in the Number_ 
field the number of each point starting from the bottom left within the land 
plot, and then continue numbering clockwise (fig  6.95).

Fig. 6.95

Step 10. During the initial digitization, it is rather difficult to obtain the 
required areas of land plots and the lengths of their boundaries. Your task is 
to get the vector layers to fully correspond to the dimensions indicated on 
the scanned paper plan, i.e. so that each line vector of the boundary of land 
plot has the same length as indicated on the plan, also with the area of each 
land plot. The most convenient way to achieve this is to use the  Topology 
Edit Tool on the Topology toolbar.

The Topology Edit Tool allows you to simultaneously edit the features 
of all layers involved in the topology. The procedure for using this tool is as 
follows: select this tool and then click on the vertex you want to edit. It will be 
highlighted in purple color (fig  6.96, a). After that, you can move this vertex 
to the place you need. Together with the vertex, all the vertices of the layers 
participating in the topology will move (fig  6.96, b).
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Disable the Snapping option (Snapping → Use Snapping). Using the 
Topology Edit Tool tool, make sure that all line vectors of the boundary of land 
plot No. 168, as well as the area of this plot, correspond to those indicated on 
the raster plan (fig  6.97). At the same time, do not topologically edit those 
turning points of the land plot that correspond to the turning points of the 
external boundary of the gardening community “Zarya”.

      
                                         a  b

Fig. 6.96

Fig. 6.97

In the same way, edit all the lengths of the lines and all the land 
plots areas of the three arrays of citizen plots you digitized (fig  6.98). Do 
not subject to topological editing those sides of the boundaries of the 
land plot, which are the sides of the external boundary of the gardening 
community.

After topological editing, save the changes editing (Editor → Save Edits).
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Fig. 6.98

Step 11. Zoom the extent of the data frame to the Lots3 layer. Turn on the 
display of the Garden_Topology layer. Use the  Validate Topology in Current 
Extent tool (found on the “Topology” toolbar) to check the topology. Open 
the  Error Inspector tool. With the help of the  Fix Topology Errors Tool 
select the entire extent of “Lot3” layer. Topology errors will appear in the Error 
Inspector window.

The error group Boundary Must Be Covered By (Gardens polygons, Lots2 
lines) as exceptions. To do this, select these errors and right-click → Mark as 
exception (fig  6.99).

Fig. 6.99
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In the same way, mark as exceptions the group of errors Endpoint must 
Be Covered By (lines Lots2, points Lots1) (fig  6.100).

The remaining group of errors Area Boundary Must Be Covered By Boundary 
Of (Gardens polygons, Lots3 polygons) also mark as exceptions (fig  6.101).

After correcting all topology errors, close the “Errors Inspector”, turn off 
the display of the “Garden_Topology” layer, and save your editing changes 
(Editor → Editor → Save Edits).

Fig. 6.100

Fig. 6.101
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Step 12. Open the attribute table of the Lots1 layer, select the points that 
are the turning points of the boundaries of the land plot No. 168 and click  
the  Show selected records button. Calculate the X coordinate for the 
selected points (right click on the X field name → Calculate Geometry) 
(fig  6.102). In the “Calculate Geometry” window, select the X Coordinate of 
Point in the Property section (fig  6.103).

Fig. 6.102

Fig. 6.103

In the same way calculate the Y coordinate in the “Y” field by selecting 
the expression Y Coordinate of Point in the Calculate Geometry window in the 
Property section.

End the editing session (Editor → Stop Editing).
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Step 13. Export the coordinates of the selected points as a text file. To 
do this, in the attribute table, select Table Options → Export (fig  6.104). Save 
the entries as a text file in your folder under the name 168 (fig  6.105). Do not 
add the export result to the project.

Fig. 6.104

Fig. 6.105

Step 14. Open Microsoft Excel. Launch the option Data → From text. Load 
exported from the GIS ArcGIS text fi e of the turning points of the boundary 
of the land plot No. 168. Use a semicolon as a separating character.

By copying data from a Microsoft Excel spreadsheet, create a catalogue 
of coordinate in Microsoft Word as shown below (fig  6.106).



185

Catalogue of coordinates
of the turning points of the boundaries of the land plot No. 168,

provided for private ownership
by Nadezhda Ivanova

in the gardening community “Zarya”
coordinate system UTM zone 35N

Point Number X coordinate Y coordinate

1 ххх ххх

2 ххх ххх

3 ххх ххх

4 ххх ххх

Plot area xxx m2

Compiled by ________________ Ivanov D. A.
Checked by ________________ Petrov I. G.

Fig. 6.106

Step 15. Export the turning points of the boundary of the land plot No. 
168 to separate shape-files  To do this, open the attribute table of the “Lots1” 
layer and select only the turning points of the boundaries of the land plot 
No. 168 (fig  6.107).

Close the attribute table. Export the features of layer “Lots1” (right click 
on layer Lots1 → Data → Export data) to a shape-file named Point_168 in your 
folder. Agree to add the new shape-file to the proje t.

Fig. 6.107
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Set the display option in the “Table of Contents” to  List By selection. 

Make only Lots2 layer available for selection. Using the  Select Features 
tool, select all line fragments of the boundary of the land plot No. 168 
(fig  6.108).

Fig. 6.108

Export the features of the “Lots2” layer (right click on the “Lots2” layer → 
→ Data → Export Data) to a shape-file named Lines_168 in your folder. Agree 
to add the new shape-file to the proje t.

Step 16. In the table of contents, leave the following layers in the 
visualization: Points_168, Lines_168, Gardens and Lots3. Right-click on 
the Points_168 layer, open layer Properties. Select the Symbology tab and 
set the layer’s display option to “Features: Single Symbol”. Click on the 
icon of the symbol and select the Circle 2 category for it, color – black,  
size – 5.

Symbolize the rest of the layers (“Lines_168”, “Gardens” and “Lots3”) 
using the Single symbol display method. For the Lines_168 layer, set the 
color to black and the width to 0.2. Symbolize the Gardens layer as follows: 
fill color – none, outline width – 0.5, outline color – black. For the Lots3 
layer, set the fill color to none, the outline width to 0.2, and the outline 
color to black.

Step 17. Label the features in layers. In the layer properties go to the 
Lebels tab. Lebel the features of the Points_168 layer by the field Number_, 
font Arial, color – black, size – 14; Lines_168 layer – by the SHAPE_Length fiel  
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(preliminarily, in the Fields tab for the SHAPE_Length field  set the rounding 
“Number of decimal places – 2”, “Pad with zeros”), font – Arial, color – black, 
size – 16. Label the features of the Lots3 layer according to the expression 
[Parsel_N]&VBnewline&[SHAPE_Area]. The inscription font is Arial, bold, 
color is black, size is 18.

Step 18. On the View menu (View → Data Frame Properties), on the Data 
Frame tab, set the Extent as Fixed Scale, equal to 1:500.

Convert labels from Points_168, Lines_168, Lots3 layers to annotations 
(right click on the layers name → Convert Labels to Annotation, use option 
In the map). Annotation is one of the ArcGIS options for storing text 
that appears on maps. The annotation simultaneously stores the text 
string itself, its location, and display properties. In contrast, a label ‘s text 
and location are dynamically generated according to a set of placement  
rules.

After converting the labels to annotations, place them as shown in 
fig  6.109 using the  Select Elements tool located on the Tools or Drawing 
toolbar.

Fig. 6.109

Use the   Text tool on the Drawing toolbar to create annotations for 
adjacent land users (fig  6.110), and then place them using the Select Elements 
and Rotate tools on the same toolbar.

You can select the font of annotations by right-clicking on it with the 
Select Elements tool and choosing Properties.



Fig. 6.110

Step 19. Layout the plan. To do this, go to “Layout View” (View → Layout 
View). On the File menu (File → Page and Print Setup) set an A4 sheet, portrait 
orientation.

Using the  Select elements tool, place the data frame in the center of 
the page. Using the  Move tool, place land plot No.168 in the center of 
the sheet.

Insert at the bottom of the map sheet in the center the Scale Text (Insert → 
→ Scale text). Use font – Arial, size – 22, color – black).

Using the  Text tool, create the text PLAN of the boundaries of the land 
plot No. 168, provided for private ownership by citizen Nadezhda Ivanova in the 
gardening community “Zarya” (based on digitization materials) (font – Arial, 
size – 22, color – black). Similarly – the text The plan of the boundaries of the 
land plot compiled by Ivanov I.V.

Place the plan layout elements as shown in fig  6.110.

Questions
1. In the GIS ArcGIS, what is a label and what is an annotation? Are there any 

differences between them?
2. What is the difference between topological editing of vector features in the GIS 

ArcGIS and non-topological?
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